
BROWSER

This software allows you to access and view a Web page.

AceExpert has an internal browser which allows you to view your Web pages quickly.

You can also use an external browser.    Among the most commonly used browsers are those developed by Netscape (Navigator 
and Communicator ) and the one developed by Microsoft ( MS Internet Explorer

).



TAGS

This is the name given to HTML commands.    They must begin with the "<" character and finish with the ">" character.    They are 
labels which are incorporated into the text and that tell the browser how to interpret the command.



TITLE BAR

All Windows 95 software packages have a title bar.    This is the bar found at the top of the screen which indicates the name of 
the software as well as the name of the current document.    This is Netscape's title bar:



EDIT SCREEN

This is AceExpert's main editing screen where you can enter text and HTML commands manually.



CONTROL PANEL

This panel allows you to start or stop playing an audio or video file.    This panel also allows you to control the volume.    Following 
is an example of the control panel:



USING THE INTERNAL BROWSER

AceExpert has an internal browser to view HTML documents, and therefore it isn't necessary to run external browsers such as 
Netscape or Microsoft Internet Explorer.

By default, AceExpert's internal browser is installed.    The browser supports HTML 3.0 code and part of the HTML 3.2 code.

With AceExpert you can choose Microsoft Internet Explorer to replace the internal browser.    In any case, to ensure good 
performance, it is necessary to have installed Microsoft Internet Explorer 4.0 previously in your system

To change the internal browser:

Click the Options menu, select General Preferences and then the Environment tab.

To download Microsoft Internet Explorer:

Go to http://www.microsoft.com/



EXTERNAL BROWSERS USED

AceExpert has the advantage of being able to communicate with the most popular browsers in the World Wide Web.    You can 
use the following browsers:

 Netscape Browser

Right now this is the most popular browser.    It was developed by Netscape Communications.    You can visit Netscape's 
Web site at the following address:

http://www.netscape.com

 Microsoft Internet Explorer

This is the browser developed by Microsoft.    It is included with Windows 95.    You can visit the Microsoft Web site at the 
following address:

http://www.microsoft.com/
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HOW TO REGISTER

You can register directly from the demo version.    Upon receipt of your payment, we will e-mail you a registration number which 
will withdraw the demo version message and will confirm your registration.

To find out different ways to register, click on the Register menu and then on the option How to order.



REGISTRATION NAME

The registration name is found in AceExpert Help menu, under the option About.



INTRODUCTION TO ACEEXPERT

AceExpert v3 is the HTML editor of choice for cybernauts who wish to create and post pages on the World Wide Web.    
AceExpert v3 has a user friendly interface with a graphic toolbars which allows the user to create pages easily and in a short 
time.    Moreover, there is a set of tabs which organizes the tools by category to make it easy for the user to find his way through 
this impressive array of tools.

These are the new features found in version 3.0

· 20    templates of Web sites including graphics 

· Code Explorer 

· HTML syntax checking 

· Spell checker 

· Save files automatically on the server 

· Open files in the server 

· New and easier interface 

· 50 predefined Java Applets 

· 12 predefined Javascripts 

· DHTML & Javascript Tutorial 

· 5 DHTML Scripts 

· 2 CGI programs (Counter and Form) 

· 2 500 images for your Web pages (animated gifs, backgrounds, etc.) 

· Easy integration of style sheets 

· Search & Replace on multiple files 

· Improved color    marking of HTML tags 

· Custom toolbars 

· Quick view of    all images in a folder 

· New visual tables 

· Quick tables 

Throughout your tour of AceExpert Help you will find the following icons:

:    for Netscape;

and

:    for Microsoft Internet Explorer.

When these icons are placed next to HTML commands they indicate that the commands are Netscape or Microsoft Internet 
Explorer extensions.
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ICON LIBRARY

AceExpert supplies a free    Icon Library that you can download    from our site 

http://www.visic.com/aceexpert/iconbank.html

or from the resources page:

http://www.visic.com/aceexpert/resources.html

  

The icons are contained in an executable file.    Once you run the file, the program will install the icons in the directory 
you specify.

To insert an icon in you document:

1. From the menu Open a graphic file press on the small button to the right of the text box Open a file.

The menu Open a graphic file is available from all the menus that allow inserting an image, such as the menu Insert 
an image,    Insert Image Map,    Body, etc.

2. Select the desired icon and press the OK button.



HOW TO CREATE A WEB PAGE IN 10 STEPS USING ACEEXPERT

The purpose of this tutorial is to show you, step-by-step, how to create a Web page using the AceExpert HTML Editor. 

This tutorial is primarily intended for new Web page creators and users who are not familiar    with HTML editors such as 
AceExpert.

AceExpert is great, easy to use tool    and very user-friendly for creating their Web pages.

We also advise new Web page developers to visit    excellent Web sites that    offer help on creating HTML pages.    These sites 
offer    detailed information on HTML language and an overview of    the Internet.

Step 1: Creating and saving a new HTML document. 

Step 2: Entering text in your HTML document.

Step 3: Displaying results in the browser.

Step 4: Inserting an image in your document.

Step 5: Inserting a hyperlink in your document.

Step 6: Adding a background image or changing the background color of your Web page. 

Step 7: Inserting a table in your document.

Step 8: Inserting a predefined Java applet in your document.

Step 9: Inserting a predefined Javascript or    DHTML script in your document.

Step 10: Transferring your Web page to your server with AceFTP.



Step 1: Creating and saving a new HTML document

To create a new HTML document (or a new Web page), you must go to the File menu and choose the New option.    You can also 
access this option by clicking on the New file icon in the standard toolbar.

A window called New Project will open that allows you, via the menus, to create several style sheets and an HTML document 
based on a personal template, a business template or a template that you can customize.

Create a new document

To create a new document,    click twice on the HTML document icon.      Once you have entered a title and a description for your 
document, the following HTML code is inserted on the edit window: 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 TRANSITIONAL//EN">
<!-- DATE DE CREATION: 19/10/98 -->
<HTML>
<HEAD>
<TITLE></TITLE>
<META NAME="Description" CONTENT="">
<META NAME="Keywords" CONTENT="">
<META NAME="Author" CONTENT="Visicom Média">
<META NAME="Generator" CONTENT="AceExpert">
</HEAD>
<BODY>

Content of the document

</BODY>
</HTML>

The text found between the "<!--" and " -->" tags represents comments and will not appear in your Web page.

At this point, you can save your document in order to create an HTML file.    To save your document, go to the File menu and 
select the Save option.    You can also save your document by clicking on the Save File icon found in the standard toolbar.    Name 
your document in the File Name dialog box.

Once you have saved your document, the file name will appear in the tab at the top of the edit screen.    Don't forget to save your 
document regularly so you don't lose new information.

Personal, Business-Frames, Business and Custom Templates

These templates of    Web pages serve as guides to create pages where you can then insert your own text and images.    You can 
also modify the information contained in them.
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Step 2: Entering text in your HTML document

In order to enter text to be displayed by the browser, you must type the text between the <BODY> and </BODY> tags.    In fact, all 
the contents of your Web page must be placed between these tags.    All other information entered before the <BODY> tag will be 
used to describe your document to the browser and to the server.

If you want to make text bold, first selected the text and then click on the Bold icon found in the Common toolbar.      In the edit 
window you will find that the tags <B> and </B> are inserted which indicate that the selected text is in BOLD letters.

<HTML>
<HEAD>
<TITLE></TITLE>
<META NAME="Description" CONTENT="">
<META NAME="Keywords" CONTENT="">
<META NAME="Author" CONTENT="Visicom Média">
<META NAME="Generator" CONTENT="AceExpert">
</HEAD>
<BODY>

<B>Creating a document with AceExpert</B>

</BODY>
</HTML>

If you want to display text in italics, first selected the text and then click on the    Italic icon found in the Common toolbar.    In the 
edit window you will find that the tags <I> and </I> are inserted which indicate that the selected text is in ITALICS.

<HTML>
<HEAD>
<TITLE></TITLE>
<META NAME="Description" CONTENT="">
<META NAME="Keywords" CONTENT="">
<META NAME="Author" CONTENT="Visicom Média">
<META NAME="Generator" CONTENT="AceExpert">
</HEAD>
<BODY>

<I>Creating a document with AceExpert</I>

</BODY>
</HTML>

You can add or modify text attributes such as size, color, and font.    To do so, select the text to be modified and then click on the 
Font icon found in the Common toolbar. 

CENTERING TEXT

You can center text by selecting the desired text and then clicking on the Center icon found in the Common toolbar.    The text 
which you had selected will be placed between the <DIV ALIGN="center"> and </DIV> tags.

<HTML>
<HEAD>
<TITLE></TITLE>
<META NAME="Description" CONTENT="">
<META NAME="Keywords" CONTENT="">
<META NAME="Author" CONTENT="Visicom Média">
<META NAME="Generator" CONTENT="AceExpert">
</HEAD>
<BODY>



<DIV ALIGN=center>Centering Text</DIV>

</BODY>
</HTML>

INSERTING A    LINE BREAK

To insert a line break in your document, click on the Line Break icon found in the Common toolbar.    This command will add the 
<BR> tag to your document.

To insert a paragraph in your document, click on the Paragraph icon found in the Common toolbar.    This command will add the 
<P> tag to your document.
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Step 3: Displaying results in the browser

To display the results of your HTML document, you can use the internal browser included with AceExpert.    By default, the internal 
browser appears at the bottom of the edit screen.    To view the results of your HTML document, click on the Start Internal Browser 
icon on the standard toolbar.    Click on the Refresh  icon to update your browser window.    You can close the internal browser by 
pressing F4.    Press F4 again to open it.

Please note that the internal browser is not as complete as the external browser.    Therefore, it is suggested that you use the 
external browser to display the final results of your HTML document.

To use the external browser, you must click on the Start External Browser icon found in the standard toolbar.    This command will 
call Netscape's (Navigator or Communicator) or Microsoft's (MS Internet Explorer) external browser and it will load the HTML 
document automatically.

If you have not specified a browser, the Start External Browser command will call the General Preferences» menu, where you 
will be able to specify the directory in your hard disk which contains the browser you want to use to display your HTML document. 
If you don’t know exactly in which directory you have your browser, select the desired browser, Netscape or Microsoft Explorer. 
Click on the Search button.    Once AceExpert finds the desired browser, the complete directory path appears on the text box in 
the lower part of the General Preferences window.    Just click twice on the path and then click on OK.
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REFRESH icon 



Step 4: Inserting an image in your document

To insert an image in your document:

Place the cursor in the desired position and    click on the Image icon found in the Specialized toolbar. 

In the text box Source, search for the desired image by clicking the Open found on the right of the text box.    The Open a graphic 
file window opens.

For example, you can find images in AceExpert’s folder in the following directory

C:\Program Files\AceExpert3\pub\pub3.gif

The preview window displays the chosen image.    The image must be in    GIF or JPG format.    The text boxes Alternative Text 
and Name are optional.

Click on the OK button. 

The following command is entered in your document:

<IMG SRC="path to image file" BORDER=0 WIDTH=value HEIGHT=value>

In order to minimize the risk of errors, it is recommended that you store all your images in the same directory as your HTML 
document.    This way the directories for your image files will not be written in your HTML document's code.

Return to Menu Next Step



Step 5: Inserting a hyperlink in your document

A hyperlink represents a link which makes reference to an HTML document or to an image.    In general, hyperlinks are underlined 
in a Web page.    An image can also be a hyperlink.

There are two types of hyperlinks, external and internal.    External links make reference to another HTML document, while internal 
links make reference to a destination within the HTML document.

To insert an EXTERNAL LINK in your document:

Create a second HTML document that will serve as the destination for the external link.    In your first HTML document, select the 
text or image that you will use as a hyperlink.    On the Specialized toolbar, click on the External link button.    In the text box 
Reference to an external link, search for the file using the Open button.

Note:  The destination filename must not contain any special characters (for example, é,    or ç) or spaces.    Certain browsers 
do not display filenames of this type.

In the    Link Content window, you can view the contents of the referenced link.

Click on the OK button.

The following command will be added to the document :

<A HREF="Path/Filename"> Text or image acting as the hyperlink </A>

To insert an INTERNAL LINK to your document:

Select the text or image that will act as the hyperlink.    In the Specialized toolbar, select    Internal Link button.

If the destination for the hyperlink was not previously identified:

In the text box Name of the new link, enter a name for the internal link.    In the Choose the destination line of the link window 
you can view the contents of the document.    Select a line in the document from the window that will serve as the destination line.

If the destination for the hyperlink was already identified:

Select the Existing Destination tab.    From the Existing Destination window, choose the desired destination for the link.

The following commands are inserted in the document :

<A HREF="#AnchorName"> Text or image acting as the hyperlink </A> 

(location of hyperlink in your document).
Note: the    #    symbol indicates the link is internal.

<A NAME="AnchorName"> Text or image acting as the hyperlink </A> (location of 
hyperlink in your document).
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Step 6: Adding a background image or changing the background color of your 
Web page

When you want to add a background image, change the background color, or change the color of the text and of the hyperlinks in 
your Web page, you must click on the Document Body icon found on the Specialized toolbar.    The BODY command affects the 
complete body of the document.    When you click on this icon, the program will call the Document Body menu.

It is important to note that there is only one BODY command in an HTML document.    It is not possible to have two BODY 
commands in the same document.

If you want to add a background image, click on the BODY button and then search for the desired file by clicking on the Open 
button to the right of the text box Background image.    You can view the image you choose on the Preview window.    The image 
must be in GIF or JPG format.

In the Color options window select the desired color by pressing the Color button.    The color chosen appears on the button.

 

Whenever you want to make changes to your Web page, click once more on the Body button.    The parameters will be 
automatically modified according to the changes you choose.

The background image must be in GIF or JPG format.    It is important that its size in Kilobytes (Kb) not be very large, otherwise it 
will take very long to download.    Ideally, a background image should not be larger that 5 Kb.    You must also make sure you do 
not select an image which will make reading text difficult.    It is recommended that you do not use background images that prevent 
visitors from reading the contents.
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Step 7: Inserting a table in your document

Tables are generally used to compare data or to format a page (column or row alignment). 

To insert a table in your document:

Position the cursor the location where you want to insert a table.    Click on the Insert Table icon found in the Tables, Frames and 
Lists toolbar. 

You must select the number of columns and rows for the table.    Once you have made this selection, the Table window    will be 
displayed.    Here you can indicate the different properties for the table (length and height of cells, colors, borders, etc.).    You can 
also enter text directly in each of the cells.

If you want to modify the contents of cells or change certain properties of the table, place your cursor inside the <TABLE> tag in 
the edit window, press the right mouse button and select the first option Edit Table.

Following is an example of a table:

Following is the HTML code for this table:

<TABLE WIDTH="40%">
  <COL SPAN="2">
    <TR>
      <TH BGCOLOR="#FF8080" COLSPAN="2">Header cell &nbsp;</TH>
    </TR>
    <TR>
      <TD BGCOLOR="#FFFF80">C1&nbsp;</TD>
      <TD BGCOLOR="#C0C0C0" ALIGN="CENTER">C3&nbsp;</TD>
    </TR>
    <TR>
      <TD BGCOLOR="#FFFF80" ROWSPAN="2">C2&nbsp;</TD>
      <TD BGCOLOR="#C0C0C0" ALIGN="CENTER">C4&nbsp;</TD>
    </TR>
    <TR>
      <TD BGCOLOR="#C0C0C0" ALIGN="CENTER">C5&nbsp;</TD>
    </TR>
</TABLE>
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Step 8: inserting a predefined Java applet in your document

A Java applet is an application that runs directly from your Web page and displayed on the browser.    With an applet you can 
insert a banner, text with special effects or a drop-down menu.    Java applets are compatible with all platforms (widows, Mac and 
Unix).

AceExpert comes with 50 predefined Java applets.

To insert a PREDEFINED Java applet in your document:

First you must save your HTML document.    From the Java tab, you can choose from several categories applets.

These categories are: banners, tools, special effects and menus.

From the Java tab, select an applet from the different categories of banners, tools, special effects or    menus.

When you click on the icon of any of these categories, a window opens and you can choose an applet from the list displayed.

The Help button found in all the windows of the different categories brings up a description of the parameters and displays 
examples of how to use them.

If you want to modify some of the applet’s parameters, click on the Parameters tab.    Click on the Show Preview     button found at 
the bottom of the window, in order to preview the applet.

Click the    OK button.

A brief explanation of the text boxes found in the menu follows:

In the text box Code the file necessary to run the application is inserted.    This file contains the extension .class and must have a 
relative address.    The address cannot be an absolute address.

In the text box    Code Base URL you can enter the URL address that contains the Java applet.    If this attribute is not entered, the 
current URL of the current document is used.    This attribute is optional.

In the text box    Alternative text you can enter a message that is displayed while the application is loaded.    It is specially useful 
to display a message in browsers that cannot run Java applets.    This attribute is optional.

In the text box    Name you can write a name for the applet.    This is used as a reference for other applets found on the same 
page.    This attribute is optional.

In the text box    Alignment you can indicate the alignment for the applet.    This option is mandatory.    The default value is 
centered.

The JavaScript Access allows access to the Java parameters using Javascript functions.

In the text boxes Width and Height,    you can enter the size of the window where the applet will run.    These values are 
mandatory.

In the text boxes Vertical space and Horizontal space you can enter space expressed in pixels for the top/bottom and left /right 
for the applet.    These values are optional.

By selecting the Parameters tab, you can make changes to the applet’s parameters.    To do so, you have to insert a name and a 
value for the applet and press the Add button.    You can also edit and erase an existing parameter by pressing the corresponding 
buttons.    Click on the Show Preview to view the applet.    Click on the OK button.

EXAMPLE:



<APPLET CODE="http://www.asite.com/acode.class" WIDTH=value HEIGHT=value > 
  <PARAM NAME="applicationAttribute1" VALUE="value">
  <PARAM NAME="applicationAttribute2" VALUE="value">
  <PARAM NAME="applicationAttribute3" VALUE="value">
  <PARAM NAME="applicationAttribute4" VALUE="value">
</APPLET>

To modify the HTML code of an existing applet:

In the edit window, find the applet you want to modify and place the cursor inside the <APPLET…>    tag, then click with the right 
mouse button and select the first option, Edit APPLET.
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Step 9: Inserting a predefine Javascript or DHTML script in your document

For more informations about JavaScript & DHTML, you can consult    the DHTML & Javascript Tutorials in the Help menu. It 
brings up a clear and detailed description of how to use Javascript in Web pages.

The following two buttons in the Javascript toolbar are used to insert a new Javascript function in your document and to obtain a 
list of objects, properties, methods and events found in the Javascript language.

The remaining buttons (12) are used to insert predefined Javascripts in your document.

Description of the predefined JavaScripts included with AceExpert:

Banner
Inserts a banner with text that scrolls from right to left inside a scroll box.

Time/date
Inserts a text box in your document that displays the time or date.

Scrolling list of URL’s
Inserts a box with    a scrolling list where each item makes reference to a URL.    When the user clicks in the scrolling list, 
he is presented with a list of addresses.    The user can then select a specific address and the browser displays the URL.

Text gradation
Inserts in your document a message with text gradation that reflects the color of your choices (red, green or blue.    The 
line of text starts with the color chosen and ends with the color white.

Select    Images
Inserts in the document a list box or a drop-down box.    Each option in the menu is associated with an image that is 
displayed to the left of the box when the user selects an option.

Alternatives links images
Inserts an image that acts as a hyperlink and a second alternative image that is displayed after the first image, when the 
user moves the mouse over the hyperlink.

Rotating images
Inserts in the document a series of images that are displayed one after the other.    These images are usually publicity ads.

Explanation window 
Inserts a hyperlink in your document.    When the user clicks on the link, an explanation window is displayed.    You can 
enter the text that will appear on the window, the font, size and color.

News box
Inserts a box with multiple lines in your document where you can insert one or several information messages.

Screen flash
This Javascript creates a screen flash when the document is loaded.    You can indicate    the starting color, the ending 
color and the number of gradations.



Password
Inserts a box for a password (minimum security) in your HTML document.    The password corresponds to the name of a 
file without the extension.    The referred document must be placed in the same directory as the file that makes reference 
to it since the password includes the path and filename of said referred file.

Window

This script inserts a new browser window when your page is opened.

To insert a PREDEFINED DHTML script:

When you click on the DHTML toolbar    you will notice that it is very similar to the Javascript toolbar.    As in the Javascript 
toolbar, the first button in the DHTML toolbar is the DHTML Tutorial button.    Here you will find all the necessary information on 
how to use DHTML scripts.    The other buttons, Style Effects, Special Effects, Menu, Text Transition and Image Transition are 
used to insert predefine DHTML scripts in your Web page.

Description of the predefined DHTML scripts included with AceExpert:

Style Effects
This DHTML script changes the font, color or style of a line of text when the mouse is moved over it.

Special Effects
This DHTML script makes text move from right to left of from left to write inside the HTML document.

Menu
This    DHTML script displays a submenu when you move the mouse over an item in the menu.

Text Transition 
This DHTML script displays text in a transition with special effects.

Image Transition 
This DHTML script    creates a special transition effect between two selected images.
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Step 10: Transferring your Web page to your server with AceFTP

Introduction to AceFTP

AceFTP Expert is a fully functional program that allows users to transfer files between their computers and the Internet server.    
The program can connect to all types of servers.    Download AceFTP from the following address:

http://www.visic.com/aceftp/

How to use AceFTP in four easy steps:

First Step:

To start an AceFTP session double click on the AceFTP icon and the following dialog window is displayed:

You then have to supply the following information:

· Name of site, 
· Host address, 
· User ID, 
· Password. 

Click on the OK button.

To enter parameters for a new connection, click on the New button.    To remove a site, click on the Delete button.    To apply 
changes to an existing site, click the Apply button.

Select the Additional tab if you want to specify default directories to be opened when you start a connection.    It isn’t mandatory 
to enter the fields found in the Additional tab.

Second step:

Hot to upload files to the server

To transfer files to the server, you must start AceFTP and have the main window open.    From this window there are two methods 
you can use to upload files:

· Method 1  : Use the arrow button 

· Method 2 : Use Drag & Drop.

METHOD 1  : use the arrow button

You must have established a connection with the server and have the main window open:

To upload your files:

· Be sure you have displayed the correct directories that contain the files you want to transfer. 



· Select the    file or files. 

· Click the Upload arrow.

METHOD 2  : DRAG & DROP

You must have established a connection with the server and have the main window open:

To upload your files:

· Be sure you have displayed the correct directories that contain the files you want to transfer.

· With the house, click on the files you want to upload. 

· Drag and drop the selected files to the host window.

Third Step

To download your files from the server you must have the main window displayed.    There are two methods to download files:

· Method 1  : Use the arrow button 

· Method 2 : Use Drag & Drop.

Fourth Step:

AceFTP integrates perfectly with AceExpert HTML editor.    Therefore, you can use the combination of both programs to create 
your Web pages.

While you are on AceFTP’s main window, you can edit a file found in your computer or on the server.    To edit a file with 
AceExpert working from AceFTP, simply select the desired HTML document and then click the Edit with button.    Next select 
AceExpert.

Download AceFTP’s electronic manual at the following address:

http://www.visic.com/aceexpert/resources.html
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ATTRIBUTE

A parameter that affects the characteristics of an HTML tag and modifies the results of the command.

BROWSER



Browsers are programs capable of accessing and displaying Web pages.    The most popular browsers are those 
developed by Netscape (Navigator and Communicator) and the one developed by Microsoft (MS Internet Explorer).

CGI

Abbreviation for Common Gateway Interface.    This feature allows a program on the server to decode the form data and 
other input from the user.

CSS

Client Style Sheets

CYBERNAUT

Name given to Internet users, also called Web or Net Surfers.

FILES

The local files (i.e. located in your system)

FORMS

A data entry form in a Web page allows the user to enter information.    For example, the user can enter a command or 
his coordinates.    Forms are used to work with CGI programs.

FTP

File Transfer Protocol.

GIF

A graphics file format compressed to reduce its size in kilobytes, customarily used for images with 256 colors.

GOPHER

Gopher protocol.

HOME PAGE

This is the first page on any Web site.    Consequently, it is the introduction to any site.

HTML

Abbreviation for    Hypertext Markup Language.    This is the language used in Web pages.    The language is made up of 
a series of instructions called "tags".    HTML language is built on HTML 1.0, 2.0,    3.x and 4.0 standards.

HTTP

Protocol for transferring hypertext.    Abbreviation for Hypertext Transfer Protocol.    This is the protocol which allows the 



transfer of Web pages between a browser and a Web server.

HTTP SERVER

Synonym of Web Server.

HYPERTEXT

Hypertext in a document is text that is displayed as underlined.    When the user clicks on one of the underlined words, 
the linked text or page is immediately displayed on the screen.    This makes it possible to browse through long 
documents by going directly to desired sections.

IMAGE MAPS

An image map is an interactive graphic image divided into several sections or zones.    Each section refers to a specific 
Web page that the user can access simply by clicking on a particular section on the graphic.

INTERNET

The world wide matrix for connecting computers using a common protocol, which now constitutes the largest network in 
the world.

JPEG

Abbreviation for Joint Photographic Experts Group.    A graphics file format compressed to reduce its size in kilobytes, 
customarily used for images containing more than 256 colors.

MAILTO

An address destination.

MARKINGS

Synonym for tags.

MICROSOFT INTERNET EXPLORER

This is the browser developed by Microsoft.    AceExpert includes the new HTML enhancements found in MS Explorer.    
These are referred to as Microsoft Internet Explorer extensions.

NETSCAPE

Browser developed by Netscape Communications.    AceExpert includes the new HTML enhancements    found in 
Netscape.    These are referred to as Netscape extensions.

NEWS

Usenet News.



NNTP

Net News Transfer Protocols, the standard for the exchange of news.

PIXEL

The smallest point that can be displayed on the screen.    An image on a screen is made up of pixels of different colors.    
The number of pixels that can be displayed depends on the video resolution.

PNG

Abbreviation for Portable Network Graphics.    Graphic file format chosen to replace the GIF and TIFF formats.    In most 
cases, the PNG format has a better compression rate than the    GIF format (5 to 25% improvement).

SGML

Abbreviation for Standard Generalized Markup Language. HTML language was developed from SGML.

TAG

Commands in HTML are carried out by "tags".    A tag consists of a left angle bracket "<" , followed by some text, and 
ends with a right angle bracket ">".    The text within the brackets instructs the browser how to carry out the command.

TELNET

Protocol that uses Telnet.

URL

Abbreviation for Uniform Resource Locator.    It's the address system that allows accessing the different Web sites.

VRML

Abbreviation for Virtual Reality Markup Language.    It is a programming language used to create Web pages that allow 
users to view three-dimensional pages.

WAIS

Protocol that allows searching databases across large areas.    (Wide Area Information Server Protocol).

WAV

A Windows format for sound files.

WEB PAGES

The World Wide Web was developed using the hypertext principle, and each screen displayed represents a Web page.



WEB SERVER

The server or provider is a computer connected to the Internet that allows its users to reach Web pages through the use 
of browsers.

WEB SITE

A Web site is the group of pages that are linked by hypertext and located in the same Internet site, usually created by an 
individual or an organization and referring to a specific subject.

WORLD WIDE WEB

The World Wide Web or simply the Web is the name given to the group of networks that use hypertext to link and 
access data.    A. browser is required to surf the World Wide Web and access Web pages.

WYSIWYG

Abbreviation for What You See Is What You Get.    Elements created keep their original appearance when displayed.

XML

Abbreviation for Extensible Markup Language.    This language describes a class of data objects contained in XML 
documents which are placed in computers at partially describe the behavior of programs that use these objects.

Copyright ©1998 Visicom Media Inc.    All rights reserved.
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LICENSE TO USE THE PRODUCT

PLEASE READ THE FOLLOWING ACEEXPERT V3. END-USER LICENSE AGREEMENT CAREFULLY

YOU ARE GRANTED THE FOLLOWING LIMITED RIGHTS:

a. A non exclusive, non transferable right to use the shareware version of the AceExpert HTML Editor for evaluation purposes.    
This trial period allows you to run the software 25 times, representing an evaluation period of approximately 30 days.    (The trial 
period does not apply if you have registered the software).

b. The right to distribute the software in its shareware form to third parties provided the latter agree to accept the terms of this 
Agreement.

IT IS STRICTLY PROHIBITED TO:

a. Modify the software in part or in its entirety.

b. Decompile or reverse engineer the software.

c. Provide your registration number to third parties if you are a registered user.

SHOULD YOU FAIL TO COMPLY WITH ANY OF THE ABOVE, YOUR USER RIGHTS ARE AUTOMATICALLY TERMINATED.    
THIS TERMINATION WILL BE IN ADDITION TO ANY CRIMINAL, CIVIL OR OTHER REMEDIES WHICH VISICOM MEDIA INC. 
MAY SEEK.

LIMITED WARRANTY:

LIMITATION OF LIABILITY FOR INDIRECT DAMAGES: Visicom Media Inc. cannot be held responsible under any circumstances 
for damages of any character (including, but not limited to, direct or indirect damages resulting from the loss of business profits, 
business interruption, loss of business information, or other pecuniary loss) arising out of the use or inability to use this product.

This software is provided under license on an "AS IS" basis, without warranty of any kind, expressed or implied, including without 
limitation, implied warranties of merchantibility and fitness for a particular purpose. In no event shall Visicom Media Inc., or any 
third party involved in the creation, production, or delivery of the software be liable for any direct or indirect damages including, but 
not limited to, damages for loss of business profits, business interruption, incurred by the user even if Visicom Media Inc. has been 
advised of such damages.

The entire risk as to the results and performance of the software is borne by the user. Visicom Media Inc. may, at any time, revoke 
this license by notifying the user of the software.    The user may cancel his license to use the product by destroying or erasing all 
copies of the software.

This limited warranty will be governed and interpreted according to Canadian law.

PROPERTY:

The AceExpert trademark is a registered trademark and is protected by the Canadian Laws on Trademarks and Intellectual 
Property.    Use of the product's name is strictly forbidden unless it is used with the express written permission of Visicom Media 
Inc.

This software, including its code, documentation, appearance, structure, and organization is an exclusive product of Visicom 
Media Inc., who retains the property rights to the software, its copies, modifications, or merged parts.



FREQUENTLY ASKED QUESTIONS (FAQ)

Q1. I use a microsoft Intellimouse. Every time I open a file, 
AceExpert keeps displaying error messages (Access Violation 
in module point32.dll).    What is the reason for this?

Q2. Why is it important to maintain the same directory structure on 
my hard disk as in my Web site?

Q3. I have inserted images, but they do not appear when I display 
the document.    What is the reason for this?

Q4. Is there an AceExpert version for Windows 3.1 and 
MacIntosh?

Q5. How can I obtain AceExpert updates?

Q6. Why should I convert accentuated characters?

Q7. How can I include a counter in my HTML page?

Q8. What is the function of the AceExpert project manager?

Q9. How can I insert a link in my Web page to my e-mail address 
so that visitors can send me e-mail?

Q10. How can I make a document appear in a specific frame using 
an external link?

Q11. How can I create an external link to a window without    
frames?

Q12. How can I insert a left margin in my document?

Q13. How can I insert a background color to text background 
without changing the document’s background color?

Q14. How can I upload my HTML documents to my Internet site?

Q15. How can I insert a sound file in an HTML document so that it 
works with both the Netscape and Microsoft Internet Explorer 
browsers?

Q16. How can I receive the data submitted in a form sheet?

Q17. How can I insert an internal link in the Javascript Scrolling 
List of URL’s ?

Q18. What can I do if the message "Corrupt installation detected" 
is displayed on the screen during the installation of the 
program?



2. Why is it important to maintain the same directory structure on my hard disk as in my Web site?

When you insert external links and images in an HTML document, the directories for the (html, gif, jpg) files are saved in 
the document's HTML code.    If the directory structure in your hard disk is different from that in your Internet site, then 
there will be errors in your document's HTML code.    That is why you must always respect the same directory structure.

We recommend that new Web page developers keep all HTML and image files in the same directory.    This way, there 
will be no directories included in the HTML code.    If, at a given time, your directory holds too many files, you can create 
sub-directories within the main directory.    It is important that this directory structure remains simple and easy to 
manage.

A possible alternative is to enable the Automatic copy of referred files in the current directory option found under 
the Environment tab in the Options menu,    General Preferences when you begin working on your page.    This option 
will automatically copy all the referred files in the same directory where the current HTML document is found.

Return to Menu



3. I have inserted images, but they do not appear when I display the document.    What is the reason for this?

Most of the time this happens because your image files are not located in the same directory where your HTML 
document is found.    The browser tries to read the files in the current directory while your images are in a different 
directory.    To avoid this problem, place your graphic files in the same directory where your HTML document is saved.    If 
you do so, everything should work properly.

Return to Menu



4. Is there an AceExpert version for Windows 3.1 and MacIntosh?

The team that developed AceExpert had to choose a single platform.    They chose the Windows 95 platform because it 
had the most advantages.    There will not be a version for Windows 3.1.    A version for MacIntosh is not planned in the 
short term.    Although we understand the needs of MacIntosh and Win 3.1 users, the unbridled evolution of HTML 
editors force us to concentrate our efforts in the latest developments in Web page creation.

Return to Menu



5. How can I obtain AceExpert updates?

All AceExpert v3 registered users can obtain the updates for free by downloading the demo version available in 
AceExpert's Web site.    When you install this version, the software will automatically detect your registration.    To find 
out which is the latest available version, visit the What's New section in AceExpert's Web site.    To be notified by e-mail 
when a new version is released, register your name in our mailing list by filling in the form found at the following 
address: http://www.visic.com/AceExpert/FormulaireMAJ.html

Return to Menu



6. Why should I convert accentuated characters?

It is important to note that you can enter accentuated characters directly in AceExpert's edit screen.    Once your page is 
ready to be sent to the server you only have to select the Convert Characters option in the Edit menu.    This option will 
convert all accentuated characters into their equivalent HTML code.    The reason why you should convert accentuated 
characters is that there are still many browsers which do not recognize them in their original form.

Return to Menu



7. How can I include a counter in my HTML page?

Many new page creators ask themselves how to insert counters in an HTML page.

To place a counter on your page, you have three alternatives: 

1. Use the counter supplied by AceExpert

2. Use the counter supplied by your service provider.

3. Use a counter provided by several sites.

4. Use your own counter.

Use the counter supplied by AceExpert

 

If you have a registered version of AceExpert 3, you can use the Hit Counter CGI program included with the editor.    
This counter can work only under WindowsNT server. For more information on how to use the CGI Hit Counter, go to 
the Help menu and select Predefined CGI Help.

Use the counter supplied by your service provider 

Some users cannot have a counter on their pages because their account does not include access to CGI.    In this case 
you should call your service provider who can generally indicate how to place a counter in your page.    However, the 
process is different depending on the features supported by your provider.

Usually this is the simplest way to place a counter on your page.    However, if you cannot obtain this service from your 
provider, then you can resort to available counter services.

Use a counter provided by several sites

You can also get a counter from a counter service other than your service provider.

Use your own counter

If you have an account that allows you to use CGI programs, then you can use your own counter.    You can look for 
counters by conducting a search in the Internet. 

Return to Menu



8. What is the function of the AceExpert project manager ?

A project serves to manage a set of HTML files.    This is achieved by giving the files a common file name.    This file will 
have the .proj extension.    The project also allows you to execute certain operations more easily or more quickly on all 
the HTML files at the same time.    For example, when you save the project all the HTML files belonging to it are 
automatically saved at the same time so that you do not have to save each file individually.    Likewise, when you open a 
project, all the files belonging to it are opened at the same time.    The project is also useful when you work with frames. 
In the Project box (F12), you can select the file which contains the code for the frames as the master file.    That way, no 
matter which document is opened. the master file will always be displayed.

Return to Menu



9. How can I insert a link in my Web page to my e-mail address so that visitors can send me e-mail?

Doing this is very simple with AceExpert.    Select the desired text and/or image in your document.    Next, click on the 
External Link icon found on the Specialized toolbar.    Click on the radio button titled mailto.    Next, in the External 
Link Reference, write your e-mail address next to mailto.    Click OK.    AceExpert will automatically write the code in 
your document.    The code will be similar to this:

<A HREF="mailto:visicom@visic.com">
<IMG SRC="Image.gif"> Text </A>

Return to Menu



10. How can I make a document appear in a specific frame using an external link?

All frames have a name.    This name is indicated by the NAME attribute in each <FRAME> tag.    Thus, when you want 
an HTML document to appear in a specific frame, you only have to add the following attribute to your external link: 
TARGET="FrameName".

Example:

Following is an example of the code for and external link that makes the document "Price.html" appear in the 
"MainPage" frame:

<A HREF="Price.html" TARGET="MainPage"> View price list </A>

Following is the code for a document which has two frames.    The first frame is called "menu" and contains the 
"doc1.html" document.    The second frame is called "MainPage" and contains the "doc2.html" document.    In this 
example, the code for the external link must be found inside the "doc1.html" document.

<FRAMESET COLS="20%,*">
   <FRAME SRC="doc1.html" NAME="menu">
   <FRAME SRC="doc2.html" NAME="MainPage">
</FRAMESET>

Return to Menu



11. How can I create an external link to a window without frames?

If you have a window with many frames and you would want to link a document to a window without frames when you 
click on an external link, you must add the following attribute to your external link: TARGET="_top".

Example:

Following is the code for an external link which makes the "doc1.html" document appear in a window without frames.

<A HREF="doc1.html" TARGET="_top"> This is Document #1 </A>

Return to Menu



12. How can I insert a left margin in my document?

If you want your document's text to have a left margin, you must use a two column table.    The first column in your table 
must be empty.    Its width is the left margin.      In the second column you place the text and images.    The table's border 
must be zero.    Enter BORDER=0 in the <TABLE> command.

Return to Menu



13. How can I add a color to a text background without changing the document's background color?

You can do this by using a table.    You only have to modify the background color for the table's cells.    Use the Insert 
Table command found in AceExpert's Tables, Frames and Lists toolbar.    It is important to note that this option is only 
available with the Netscape 3.0 and Microsoft Internet Explorer 3.0 or higher browsers.    Finally, the table's border must 
be zero; you must include the BORDER=0 attribute to the <TABLE> command.

You can also use style sheets.    However only browsers version 4 are capable for displaying documents that employ 
style sheets.

Return to Menu



14. How can    I upload my HTML documents to my Internet site?

To send your HTML documents, images and other files from your computer to your Internet server, you must use an FTP 
(File Transfer Protocol) program.    This type of program allows you to transfer files from your hard disk to your Internet 
server (upload) and vice-versa (download).    AceFTP makes transferring files very easy and can be integrated in 
AceExpert.    You can download AceFTP at the following address:

http://www.visic.com/aceftp/

Return to Menu



15. How can I insert a sound file in an HTML document so that it works with the Netscape and    Microsoft Internet 
Explorer browsers?

To insert a (mid ou wav) sound file, you can use the <EMBED> command which is now supported by most browsers.    
This command will run the sound file as soon as the user enters the Web page or when he presses a button on the 
control panel.    To insert this command with AceExpert you must choose the Embedded Module option in the 
Specialized toolbar.

Return to Menu



16. How can I receive the data submitted in a form sheet?

The data entered in a form will reach you in text form by e-mail.    It is usually better to use a CGI program to process the 
data before it is sent to you.    The CGI program can, for example, convert accents or include the questions with the 
responses.    To obtain a CGI program, you must contact your service provider who will explain the procedure you must 
follow in order to process the data from your form.    CGI programs are found usually in the /cgi-bin/ directory of your 
service provider's server or in your FTP site.

Example:

Following is an example of the HTML code for a form that uses the mailto.exe CGI program.

<FORM ACTION="/cgi-shl/mailto.exe" METHOD=POST>
  <INPUT TYPE="hidden" NAME="sendto" VALUE="usager@visic.com">
  <INPUT TYPE="hidden" NAME="server" VALUE="mail.visic.com">
  <INPUT TYPE="hidden" NAME="subject" VALUE="Example of how to use CGI">
  <INPUT TYPE="hidden" NAME="resulturl" 
VALUE="http://www.visic.com/thankyou.html">

Enter your information:
Name: <INPUT TYPE="text" NAME="uname" SIZE=30 MAXLENGTH=30>
Title: <INPUT TYPE="text" NAME="titre" SIZE=30 MAXLENGTH=30>
Company: <INPUT TYPE="text" NAME="company" SIZE=40 MAXLENGTH=40>
E-mail: <INPUT TYPE="text" NAME="email" SIZE=30 MAXLENGTH=30>

  <INPUT TYPE="submit" VALUE="Submit">
  <INPUT TYPE="reset" VALUE="Reset">
</FORM>

For more information on how to use the Mailto program, go to the Help Menu and select the option Predefined CGI 
Help.

You can also use the "mailto" command.    In either case, this command only works with the Netscape browser (not with 
Explorer). Thus, it is recommended that you use a CGI program.

Example:

<FORM ACTION="mailto:anaddress@visic.com" METHOD="post">
  ...
</FORM>

Return to Menu

17. how can I insert an internal link in the Javascript Scrolling list of URL’s?

To insert an internal link, replace the name of the internal link with the name of the internal link and adding the symbol # 
before the name of the internal link.

Example:

 
<BODY>
<FORM>
<SELECT NAME="list1" SIZE=1>
<OPTION SELECTED VALUE="">-------- MENU --------
<OPTION VALUE="#bottompage">Go to the bottom of the page
</SELECT>
<INPUT TYPE="button" VALUE="OK" onClick="if (form.liste1.selectedIndex !=
0) location = form.liste1.options[form.liste1.selectedIndex].value; else
alert('Choose an item in the menu.')"> 



</FORM>

... 

<!-internal link for bottom of page -->
<A NAME="bottompage">Bottom of page</A>
</BODY>

If you want to address an internal link within an external link, insert the external link before the # symbol :

Example: 

<OPTION VALUE="page1.html#bottompage">bottom of page of the page1.html 
document

Return to menu

18. What can I do if the message "Corrupt installation detected" is displayed on the screen during the installation 
of the program?

This message is displayed when the download of the executable file was not completed successfully (that is, the 
program was not fully downloaded).    To solve the problem, download the program again and re-install it.

Return to menu

1. I use a Microsoft Intellimouse. Every time I open a file, AceExpert keeps displaying error messages (Access 
Violation in module point32.dll).    What is the reason for this?

Everyone who uses a Microsoft Intellimouse must download the most recent driver 2.20 from Microsoft.    If you are not 
using this driver version, AceExpert will continuously display error messages.

To solve the problem, download the driver from the following address :

http://www.microsoft.com/products/hardware/mouse/driver/intellir.htm

Return to menu



LIST OF SHORTCUTS

In AceExpert:

Insert Comment <!-- --> ALT+CTRL+M

Insert Paragraph <P> CTRL+P

Insert Line Break <BR> CTRL+R

Create New Document CTRL+N

Open Document CTRL+O

Close Document CTRL+W

Save Document CTRL+S

Quit AceExpert ALT+F4

Open Project SHIFT+CTRL+O

Close Project SHIFT+CTRL+W

Save Project SHIFT+CTRL+S

Search Text for Special Elements CTRL+F

Repeat Search or Replace F3

Replace Text and certain Special Elements CTRL+H

Select Microsoft Internet Explorer browser SHIFT+CTRL+E

Select Netscape browser SHIFT+CTRL+N

Repeat last command CTRL+Y

Cut selected text CTRL+X

Copy selected text CTRL+C

Paste text at the insertion point CTRL+V

Erase selected text CTRL+DEL

Select all text CTRL+A

Cancel an instruction CTRL+Z

Repeat an instruction SHIFT+CTRL+Z

Apply bold attribute CTRL+B

Apply underline attribute CTRL+U

Apply italics attribute CTRL+I

Change case SHIFT+F3

Change font CTRL+D

Insert a hyperlink CTRL+K

Erase character to the left BACKSPACE

Erase word to the left CTRL+ BACKSPACE

Erase character to the right DEL

Erase word to the right CTRL+DEL

Apply Heading Style 1 CTRL+SHIFT+1

Apply Heading Style 2 CTRL+SHIFT+2

Apply Heading Style 3 CTRL+SHIFT+3

Apply Heading Style 4 CTRL+SHIFT+4

Apply Heading Style 5 CTRL+SHIFT+5

Apply Heading Style 6 CTRL+SHIFT+6

Center text CTRL+E

Left-align text CTRL+SHIFT+G



Right-align text CTRL+SHIFT+D

Convert special characters CTRL+M

Return to regular characters SHIFT+CTRL+M

Insert a quick Image CTRL+G

Insert a quick external link SHIFT+CTRL+G

Add new shortcuts for Custom buttons CTRL+1…10

Help contents or help on a specific command F1

View/Hide internal browser F4

Start or refresh internal browser F10

Start or refresh external browser SHIFT+F10

Special characters dialog box F7

HTML tags summary dialog box F8

JavaScript commands summary dialog box F9

View/Hide Project Manager window F12

Change text color SHIFT+F12

In other Windows and Dialog Boxes:

Switch to next program ALT+TAB

Switch to previous program ALT+SHIFT+TAB

Display Windows Start Up Menu CTRL+ESC

Switch to next document window CTRL+F6

Switch to previous document window CTRL+SHIFT+F6

Switch to next tab in a dialog box CTRL+TAB

Switch to previous tab in a dialog box CTRL+SHIFT+TAB

Advance to next option or group of options TAB

Return to previous option or group of options SHIFT+TAB

Select option or enable/disable checkbox using 
underlined letter in the option name

ALT+letter

Open a scrolling list area

(when the scrolling list is selected)

ALT+DOWN

Execute action indicated by the default

button in a dialog box

ENTER

Cancel the command and close the dialog box ESC

Inside a text area:

Move one character to the left LEFT

Move one character to the right RIGHT

Move one word to the left CTRL+LEFT

Move one word to the right CTRL+RIGHT

Move one paragraph up CTRL+UP

Move one paragraph down CTRL+DOWN

Move one line up UP

Move one line down DOWN

Move to the end of a line END

Move to the beginning of a line HOME

Move to the top of a screen ALT+CTRL+PAGE UP

Move to the bottom of a screen ALT+CTRL+PAGE DOWN



Move to the top of the screen (scroll) PAGE UP

Move to the bottom of a screen (scroll) PAGE DOWN

Move to the end of a document CTRL+END

Move to the beginning of a document CTRL+HOME

Print a document SHIFT+CTRL+P

Move to the beginning of an entry HOME

Move to the end of an entry END

Move a character to the left or to the right LEFT/RIGHT

Move the cursor one word to the left or to the right CTRL+LEFT/RIGHT

Select everything between the insertion

point and the beginning of the entry

SHIFT+HOME

Select everything between the insertion 

point and the end of the entry

SHIFT+END

Select/deselect a character to the left SHIFT+LEFT

Select/deselect a character to the right SHIFT+RIGHT

Select/deselect a word to the left CTRL+SHIFT+LEFT

Select/deselect a word to the right CTRL+SHIFT+RIGHT



THE STANDARD TOOLBAR

New File

Open File

Save File

Close File

FTP Manager

Show Project Manager

Print

Search

Extended Replace 

Cut

Copy

Paste

Undo

Redo

Right Indent 

Start the internal browser

Start the external browser

Start the spell checker 

Start the HTML syntax checking 



Image browse 

File Manager



ACEEXPERT MENU BAR

Menus:

File

Edit

Project

Syntax

Options

Tabs

Document

Help

Register

Copyright ©1998 Visicom Media Inc.    All rights reserved



REGISTER MENU 

This menu is displayed when the user has not registered the program.    Once the user registers, the menu disappears from the 
menu bar.

HOW TO ORDER

This sub-menu offers different ways and details on how to order the program.

ORDER FORM

This sub-menu bring up an order form for AceExpert.    To place your order, print the form and fax it or send it by mail. 

ORDER FORM FOR AN UPDATE

This sub-menu brings up an order form to order an update of AceExpert.    To make your order, print the form and fax it or send it 
by mail.

REGISTER ACEEXPERT

With this option you can enter your registration information by indicating your user name and registration number.



FILE MENU

New

Open

Open file from FTP 

Close

Close all

Import File

Save

Save as

Save to FTP 

Save all

Last files

Print

File Manager 

Image browse 

Exit 



CREATE NEW DOCUMENT
See also Menus

You can create a new document (new Web page), a new style sheet document or a new Javascript document.

To create a new document:

1. From the File menu, choose New File.

Or 

From the Standard toolbar, click on the New File icon. You can also use a shortcut by pressing CTRL + N 
simultaneously.    (Refer to List of shortcuts).

2. The HTML document    is selected by default..

3. Click on the OK button

To create a new Javascript document:

1. From the File menu, choose New.

Or 

From the Standard toolbar, click on the New file button. You can also use a shortcut by pressing CTRL + N 
simultaneously.    (Refer to List of shortcuts).

2. Select Javascript Document.

3. Click on the OK button.

To create a new style sheet document:

1. From the File menu, choose New.

Or 

From the Standard toolbar, click on the New file button. You can also use a shortcut by pressing CTRL + N 
simultaneously.    (Refer to List of shortcuts).

2. Select CSS Document.

3. Click on the OK button.

You can also insert predefined templates that are included with AceExpert.    When you select a template, a New Project Wizard 
helps you through the process.

These templates are found in three categories: Personal, Business-Frames and Business.

The Personal tab helps you to customize a Web site template.

To insert one of AceExpert’s    predefined Web site template:



1. In the    Standard toolbar, click on the button    New File.

2. The New Project window opens.

3. Click on one of the following tabs: Personal, Business-Frames, Business.

4. The left side of the New Project window displays icons representing the different templates included for the chosen 
category..

5. Click    on one of the icons and a preview of the template is displayed on the right side of the window..

For detailed information on how to insert the site templates, click on 20 Web site templates .

To add a custom Web site template:

1. In the Standard toolbar, click on the button New File.

2. The dialog window New Project opens.

3. Click on the Custom tab..

4. Click on the New button.

5. Enter a name for your new project in the text box Template name.    The project will be inserted in the folder: C:
\Program files\ACEEXPERT3\Templates\Custom\

6. Press the Next button to move to the following step or press Previous to move to the previous step of the process.

7. Press the Add Files button to insert the templates files, or press Add Folder to add a folder to the template.

8. Press the Open button to open the file(s) or folder.

9. Click on the Next button.

10. Select a Main file that displays a preview in the window.

11. Press the Finish button.



NEW FILE icon 



SEE ALSO
Open Document

Close Document

Save Document

Save As Document

Save All Open Documents

Print Document

Exit AceExpert



OPEN DOCUMENT
See also Menus

The Open command allows you to open a document saved on disk.    The document will be displayed in its own window and its 
name will be displayed in a tab.

To open an existing document:

1. From the File menu, choose Open

Or

From the Standard toolbar, click on the Open File icon.    You can also use a shortcut by pressing CTRL + O 
simultaneously.    (Refer to List of shortcuts).

2. Select the file you wish to open: *From the Look in drop-down list box, select the appropriate drive. *From the 
Directories list box, select the appropriate directory. *From the Files of Type drop-down list box, select the appropriate 
file type. *From the File Name text box, select the desired file.

3. Furthermore, there are a series of options which allow you to manage your files within AceExpert itself.    Following is a 
brief description:

The Up One Level icon allows you to move one level up in the file structure.

The New Folder icon allows you to create a new folder.

 

 

 

    The Large Icons, Small Icons, List, Details icons allow you to choose the file display type.

The Preview icon allows you to display images.

The Files icon displays the file structure, as in Windows File Manager.

The Text or Property area lets you specify the object of a search.    If the object of your search consists of more than 
one word, place the words between quotation marks.    For example, you can search only those files which include the 
words AceExpert HTML Editor by typing these words in that area.

The Last Modified area, allows you search only those files that have been filed in the specified time frame.

The Search button allows you to search for a file which meets the criteria which you indicated previously in the Text or 
Property area.    The New Search button allows you to reset the criteria of the previous search and use the default 
values for the new search.

The Icon Library icon, found to the right of the manager, gives you direct access to AceExpert's Icon Library directory 
when you insert an image in    a document.    It does not appear when you open a document, it appears only when you insert a 
graphics file.

4. Click on the Open icon.



You can also open a document from the Windows File Manager (Windows Explorer).    To do so, you only have to select the 
document from the Windows File Manager and drag it to the AceExpert edit window or to the AceExpert icon.

It is also possible to open a document which you have recently closed.    In the Last Files sub-menu, AceExpert displays a list of 
the last eight documents you have opened.    To open one of these documents, simply select the desired document.



OPEN FILE icon  



SEE ALSO
Create New Document

Close Document

Save Document

Save As Document

Save All Open Documents

Print Document

Exit AceExpert



CLOSE DOCUMENT
See also Menus

You can close the current document without exiting AceExpert.    If the document has not been saved, or if it has been modified 
since the last time it was saved, AceExpert will ask you to save it before you exit the program.    The small button on the left of the 
file name tab will appear red if the document has been modified, and the word Modified will appear on the status bar at the bottom 
of the edit screen.

To close a document:

From the File menu, select Close,

Or

From the Standard toolbar, click on the Close File icon.



CLOSE FILE icon  



SEE ALSO
Create New Document

Open Document

Save Document

Save As Document

Save All Open Documents

Print Document

Exit AceExpert



CLOSE ALL
See also    Menus

You can close all open documents at once.    If one of the open documents is not saved, or has been modified since the last time it 
was saved, AceExpert will ask you to save it before you exit the program.

To close all open documents:

From the File menu, select Close All.



See also
Close Document



IMPORT FILE
Menus

This command allows you to import a text file (.txt) into your working document.    The advantage is that the imported file will be 
inserted at the exact location you want inside the document you are working on.



SAVE DOCUMENT
See also Menus

The Save command allows you to save the current document to disk.    If the document has not been saved before, this option will 
have the same effect as the    Save As...      command.

To save the current document:

From the File menu, select Save

or

From the Standard toolbar, click on the Save File icon.    You can also use a shortcut by pressing CTRL + S 
simultaneously.    (Refer to List of shortcuts).

If you wish to save an existing document under another name or in another location, use the  Save As...      command.



SAVE FILE icon  



SEE ALSO
Create New Document

Open Document

Close Document

Save As Document

Save All Open Documents

Print Document

Exit AceExpert



SAVE AS
See also Menus

The Save As… command allows you to save a new document to disk.    This command is also used to save an existing document 
under another name.

To save a new document to disk or to save a document under another name:

1. From the File menu, select Save As...

2. Choose a file name for the document:

From the Look in drop-down list box, select the appropriate drive.

From the Directories list box, select the appropriate directory.

From the File Type drop-down list box, select the appropriate file type.

In the File Name text box, type the new name for the file or select an existing file.

When you are finished, click on the Save button.

3. Furthermore, there are a series of options which allow you to manage your files within AceExpert itself.    Following is a brief 
description:

The Up One Level icon allows you to move one level up in the file structure.

The New File icon allows you to create a new file.

 

 

 

    The Large Icons, Small Icons, List, Details icons allow you to choose the file display type.

The Preview icon allows you to display images.

The Files icon displays the file structure, as in Windows File Manager.

The Text or Property area lets you specify the object of a search.    If the object of your search consists of more than 
one word, place the words between quotation marks.    For example, you can search only those files which include the 
words AceExpert HTML Editor by typing these words in that area.

The Last Modified area, allows you search only those files that have been saved in the specified time frame.

The Search button allows you to search for a file which meets the criteria which you have indicated previously in the 
Text or Property area.    The New Search button allows you to reset the criteria of the previous search and use the 
default values for the new search.

The Icon Library icon, found to the right of the manager, gives you direct access to AceExpert's Icon Library directory 
when you insert an image in a document.    It does not appear when you open a document, it appears only when you insert a 
graphics file.



SEE ALSO
Create New Document

Open Document

Close Document

Save Document

Save All Open Documents

Print Document

Exit AceExpert



SAVE ALL OPEN DOCUMENTS
See also Menus

The Save All command allows you to save all open documents to disk.    This command is useful when you are working on many 
files at the same time.

To save all open documents:

From the File menu, select    Save All.

If one or more of the open documents has never been saved, this command will have the same effect as the  Save As...      option, 
otherwise, it will have the same effect as the Save option on files which have been saved before being modified.



SEE ALSO
Create a New Document

Open a Document

Close Document

Save Document

Save As Document

Print Document

Exit AceExpert



LAST FILES
Menus

It is also possible to open a document which you have recently closed.    In the Last Files sub-menu, AceExpert displays a list of 
the last eight documents you opened.    To open one of these documents, simply select the desired document.



PRINT DOCUMENT
See also Menus

This command allows you to print a document on the default printer.

To print a document:

From the File menu, select the Print Item.

You can also use a shortcut by pressing SHIFT+CTRL+P simultaneously.    (Refer to List of shortcuts).



PRINT icon  



SEE ALSO
Create New Document

Open Document

Close Document

Save Document

Save As Document

Save All Open Documents

Exit AceExpert



COMPRESS TAGS
Menus

This command is used to remove all empty spaces from your document to render it unreadable.    This command is useful if you 
wish to protect your HTML document from being plagiarized on the Internet.

Following is the procedure to protect your HTML documents from being plagiarized on the Internet:

1. Before sending your documents to the server, use the Compress Tags command.

2. Save your documents under another name.

3. Send your documents to the server.

This way, when a visitor uses the View Source function on his browser, he will not be able to understand how you have formatted 
your HTML document.



EXIT ACEEXPERT
See also Menus

The Exit command closes AceExpert and all the open documents.    If there are one or more documents which have not been 
saved since they were last modified, AceExpert will ask you to save them before exiting the program.

To exit AceExpert:

1. From the File menu, select    Exit

or

You can also use exit AceExpert by clicking on the Exit button at the top of the screen.

You can also use a shortcut by pressing ALT+F4 simultaneously.    (Refer to List of shortcuts).



EXIT icon    



SEE ALSO

Create New Document

Open Document

Close Document

Save Document

Save As Document

Save All Open Documents

Print Document



EDIT MENU 

Undo

Redo

Repeat Last Command

Cut

Copy

Paste

Clear

Select All

Right Indent 

Find

Replace

Find Next

Replace by 

Convert Special Characters

Return to Characters

Compress Tags

Clear Tags 

Go to line number 



UNDO
Menus

This command allows you to reverse the last action.    The first time you select this option, the program will reverse the last change 
you made.    If you select this option again, the program will reverse the action before that, and so forth.

To undo the last action:

From the Edit menu, select Undo

Or

From the Standard toolbar, click on the Undo icon.

You can also use a shortcut by pressing CTRL+Z simultaneously.    (Refer to List of shortcuts).



UNDO icon     



REDO
Menus

This command allows you to redo the last actions you had undone.    The first time you select this option, the program will redo the 
last action you have undone.    If you select this option again, the program will redo the next to last option you had undone, and so 
forth.

To redo the last action you had undone:

From the Edit menu, select    Redo

Or

From the Standard toolbar, click on the Redo icon.

You can also use a shortcut by pressing SHIFT+CTRL+Z simultaneously.    (Refer to List of shortcuts).



REDO icon  



REPEAT LAST COMMAND
Menus

This command allows you to repeat the last command you have performed:

To repeat the last command:

From the Edit menu, select Repeat Last Command.

You can also use a shortcut by pressing CTRL + Y simultaneously.    (Refer to List of shortcuts).



CUT
See also  Menus

This command is used to remove the selected text or graphics and put them on the Clipboard.    Afterwards, the text or the 
graphics can be reinserted to another location by means of the Paste command.

To cut text or graphics from a document:

1. Select the text or graphics you wish to remove.

2. From the Edit menu, select Cut

Or 

From the Standard toolbar, click on the Cut icon.

You can also use a shortcut by pressing CTRL + X simultaneously.    (Refer to List of shortcuts).



CUT icon     



SEE ALSO
Copy

Paste

Clear

Select All



COPY
See also  Menus

This command is used to copy text or graphics from the document and puts them on the Clipboard.    Afterwards, the text or the 
graphics can be reinserted at another location by means of the Paste command

To copy text or graphics from a document:

1. Select the text or graphics you wish to copy.

2. From the Edit menu, select Copy

Or

From the Standard toolbar, click on the Copy icon.

You can also use a shortcut by pressing CTRL + C simultaneously.    (Refer to List of shortcuts).



COPY icon     



SEE ALSO
Cut

Paste

Clear

Select All



PASTE
See also  Menus

This command is used to insert the contents of the Clipboard into the current document.

Since the information remains in the Clipboard's memory, you can reuse the Paste command many times.

To PASTE text or graphics onto a document:

From the Edit menu, select Paste

Or 

From the Standard toolbar, click on the Paste icon.

You can also use a shortcut by pressing CTRL + V simultaneously.    (Refer to List of shortcuts).



PASTE icon  



SEE ALSO
Cut

Copy

Clear

Select All



CLEAR
See also Menus

This command is used to erase text or graphics from a document.    It is similar to the Cut command, except that it does not place 
the contents in the Clipboard.

To erase text or graphics form a document:

1. Select the text or graphics to be erased.

2. From the Edit menu, select Clear.

You can also use a shortcut by pressing CTRL + DEL simultaneously.    (Refer to List of shortcuts).



SEE ALSO
Cut

Copy

Paste

Select All



SELECT ALL
See also Menus

This command is used to select the entire contents of the current document.

To select the entire contents of a document:

From the Edit menu, select Select All.

You can also use a shortcut by pressing CTRL + A simultaneously.    (Refer to List of shortcuts).



SEE ALSO
Cut

Copy

Paste

Clear



FIND
See also Menus

This command is used to search for specified text inside a document.    You can enter one or more words in the Text to find box 
and the program will show you where the first match of characters is found in the document.

To find a sequence of characters inside a document:

1. From the Edit menu, select Find

Or

From the Standard toolbar, click on the Find button.    You can also use a shortcut by pressing CTRL + F simultaneously. 
(Refer to List of shortcuts).

2. Enter the text you are searching for in the Text to find dialog box and click on the Find button.

The FIND dialog box has the following options:

REPLACE

This button allows you to replace the text found in the document with the character string you indicate in the Text to Replace text 
box.

REPLACE ALL

This button allows you to replace all occurrences of the text found in the document with the character string you indicate in the 
Replace with box.

FORWARD

This option indicates that the search will begin from the cursor's position to the end of the document.    This is the default option for 
the FIND command.

GLOBALLY

This option indicates that the search will be performed throughout the entire document.

GLOBAL

This option indicates that the search will be performed throughout the entire document.

SELECTION

This option indicates that the search will be performed into the text selected only.

WHOLE WORD ONLY

This option indicates that the search will find whole words only, and not part of a larger word.    As an example, if you search for the 
word editor using this option, the program will find all occurrences of the word editor in the document, but it will not find the word 
editorial, since it is not identical to the word being searched.

CASE SENSITIVE

This option indicates that the search will find only those occurrences which exactly match the combination of uppercase and 
lowercase letters of the word being searched.    For example, if you search for the word editor using this option, the program will 
find all occurrences of the word editor, but it will not find the word Editor.



FIND icon  



SEE ALSO
Replace

Find Next



REPLACE
See also Menus

This command is used to search for text in a document and replace it with another character string.    You can enter one or more 
words in the Text to find box and the program will show you where the first match of characters is found in the document.    You 
can then replace them with another string.

To replace a character string in a document:

1. From the edit menu, select Replace. You can also use a shortcut by pressing CTRL + H simultaneously.    (Refer to List 
of shortcuts).

2. Enter the text you are searching for in the Text to Find box.

3. Enter the text that is going to replace the text you are searching for in the Text to Replace box.

4. Click on the Replace button.

The REPLACE dialog box has the following options:

REPLACE ALL

This button allows you to replace all occurrences of the text found in the document with the character string you indicated in the 
Replace with box.

FORWARD

This option indicates that the search will begin from the cursor's position to the end of the document.    This is the default option for 
the FIND command.

GLOBALLY

This option indicates that the search will be performed throughout the entire document.

WHOLE WORD ONLY

This option indicates that the search will find whole words only, and not part of a larger word.    As an example, if you search for the 
word editor using this option, the program will find all occurrences of the word editor in the document, but it will not find the word 
editorial since it is not identical to the word being searched.

MATCH CASE

This option indicates that the search will find only those occurrences which exactly match the combination of uppercase and 
lowercase letters of the word being searched.    For example, if you search for the word editor using this option, the program will 
find all occurrences of the word editor in the document, but it will not find the word Editor.



SEE ALSO
Find

Find Next



FIND NEXT
See also Menus

This option allows you to repeat automatically the last search performed.    This option allows you to find quickly in your text the 
word you are searching for.

To find next:

From the Edit menu, select Find Next.

You can also use a shortcut by pressing the F3 key.    (Refer to List of shortcuts).



SEE ALSO
Search

Replace



CONVERT CHARACTERS
Menus

This option is used to convert special characters (é, à, î, etc.) in your document into HTML code.    This way, you are assured that 
all browsers will be able to read these characters.    Any text entered as comments will be ignored by the conversion.

To convert special characters in your document:

· From the Edit menu, select Convert Characters

· Convert characters dialog box will appear

· In Display at, specify one of these options: Current File, specified Files, All Project Files or In the specified directory

· Press the Add button if you chose the option Specified Files and select the files where you want to run the conversion

Or

Press the Browse button if you chose the Conversion in directories and select the directory

· Click on Start button to start the conversion. The program will replace all special characters with their corresponding HTML 
code.

Example:

é=&eacute;

à=&agrave;

î=&icirc;

To stop the conversion, press Stop button.



RETURN TO CHARACTERS
Menus

This option is used to convert those characters in HTML code in your document to special characters.    In other words, this 
command performs the opposite function of the Convert Characters command.

To convert characters in HTML code into special characters:

· From the Edit menu, select Return to Characters

· Convert characters dialog box will appear

· In Display at, specify one of these options: Current File, specified Files, All Project Files or In the specified directory

· Press the Add button if you chose the option Specified Files and select the files where you want to run the conversion

Or

Press the Browse button if you chose the Conversion in directories and select the directory

Click on Start button to start the conversion. The program will convert the characters in HTML code into special characters.

Example:

&eacute;= é

&agrave;= à

&icirc;= î

To stop the conversion, press Stop button.



PROJECT MENU

This menu allows you to manage a group of HTML files that are part of the same project.

Add File To Project

Remove File From Project

New Project

Open Project

Close Project

Save Project

Save Project As

Open All Project Files

Last Projects

Show/Hide Project Manager



SHOW PROJECT MANAGER

To create several HTML documents all part of the same project, it is recommended that you create a project.    The Show 
Project Manager command opens the Project Manager window over the edit window.    The window contains five buttons:

The following are the buttons contained in the project's toolbar and the possible options:

Create a new project 

Open project 

Save project 

Close project 

Show Project Manager 

To close the project window, click on the X button found on the upper right corner of the Project bar.



ADD FILE TO PROJECT
Menus

This option used to add an HTML file to a project.    From the menu Project select Add File to Project, or select Show/Hide 

Project Manager and click on the  icon.

You can also add a file to a project by using Windows File Manager (Windows Explorer).    Simply click    the file in the Explorer 
window and drag and drop it in AceExpert's Project Manager window.



REMOVE FILE FROM PROJECT
Menus

With this option you can remove an HTML file from a project.    From the Project menu, select Remove File From Project or from 

Project Manager highlight the file you want to remove and then click on the  icon.



NEW PROJECT
Menus

This option allows you to create a new project.

To create a new project:

From the PROJECT menu, choose New Project,

Or

From the standard toolbar, click on the    New Project icon.

The Project Manager window will appear on the screen.    These are the options available on this window:

Main file: specifies the project's main file that will be displayed when you launch the browser.    The main file is usually    
linked to the other HTML files in the project    and    refers to them.    It is usually the file containing all the frames.

Remove File(s)    from the Project:    used to remove one or more HTML    files from the project.

Open File(s):    used to open one or more project files.

Add File(s) to the Project: used to add more HTML files to the project.

Open All Project Files:    used to open all the project files at the same time. 

    used to view the project files and their names in different ways.

used to view certain details of the project files.



NEW PROJECT icon 



OPEN PROJECT
Menus

This command allows you to open a project saved to disk.    When you select it, the Project Manager window will appear on the 
screen.    On the window you will view all the HTML files that belong to the open project.

To open an existing project:

1. From the Project Menu, select Open Project,

or

From the standard toolbar, click on the    Open Project icon.

2. Select the project you want to open.    Project files have the extension    .proj.

3. Press the OPEN button.

The Project Manager window will appear on the screen.    You will    see in this window all the files that belong to the open project. 
These are the options available:

Main file: specifies the project's main file that will be displayed when you launch the browser.    The main file is usually    
linked to the other HTML files in the project and refers to them.    It is usually the file containing all the frames.

Add File(s) To The Project: used to add more HTML files to the project.
 

Remove File(s)    From The Project:    used to remove one or more HTML    files from the project.

Open File(s):    used to open one more HTML files and edit them.    You can also open an HTML file simply by dragging 
and dropping it on the edit screen.

used to view the project files and their names in different ways.

used to view certain details of the project files.



OPEN PROJECT icon  



OPEN ALL PROJECT FILES
Menus

This command allows opening all the HTML files that belong to the same project. 

To open all the HTML files of an existing project:

1. From the Project Menu, select Open All Project Files.

2. Select the project you want to open.    Project files have the extension    .proj.

3. Press the OPEN button.



LAST PROJECTS

This option allows opening a project that was recently used.    AceExpert keeps a list of the last four projects used under the 
menu option Last Projects.    To open one of these projects, simply select it from the list.



SAVE PROJECT
Menus

This command allows you to save your project as well as the HTML files.    If the project had not been saved previously, this option 
works the same as the Save Project As option.

To save your project:

From the Project menu, select Save Project, 

Or

From the standard toolbar, click on the Select the Save Project icon.

If you wish to save an existing project under a different name or to save it to a different location, use the option Save The Project 
As.



SAVE PROJECT icon 



SAVE PROJECT AS
Menus

The Save Project As command allows you to save to disk a project for the first time.    It is also used to save an existing project 
under a different name. 

To save a new project or save it under a different project name:

1. From the Project menu, select the option Save Project As.

2. Specify a name for the project.



CLOSE PROJECT
Menus

This command allows you to close the Project Manager without exiting AceExpert.    If the project has not been saved or if it has 
been modified since the last time it was saved, AceExpert will remind you to save it before you close it.

To close a project:

From the Project menu, select the option Close Project

Or

From the standard toolbar, click on the Close Project icon.



CLOSE PROJECT icon 



SHOW/HIDE PROJECT MANAGER
Menus

This commands allows opening or hiding the Project Manager window.    You can also use a shortcut by pressing F12 (Refer to 
List of shortcuts).



HELP
Menus

This commands brings up the Table of Contents of the general help file.

To bring up the general help file:

You can use a shortcut by pressing F1 (Refer to List of shortcuts).    If you want details on a specific HTML command, place 
the pointer on the HTML tag and press CTRL+F1.



OPTIONS MENU

General Preferences

Editor Preferences 

Configure Standard Toolbars 

Configure Tabs Toolbars 

Display Code Explorer

Display Status Bar

Display Tools Bar

Display Margins Bar 

Display Word Wrap 

Display Special Characters Bar 

Display Internal Browser

Netscape

Microsoft Explorer

Start External Browser

Start Internal Browser

Start Ace FTP 

Start Spell Checking 



GENERAL PREFERENCES
Menus

The General Preferences option has five tabs.    The first is General and it allows specifying the directory for the default external 
browser.    The second tab, Environment is used to specify different options within AceExpert, options such as displaying bars, the 
editing screen and files.    The third tab, Spelling offers different options to run a spell check.    The fourth tab, Syntax Checking    
has different options to check a document’s HTML syntax.    And lastly, the fifth tab Extensions allows you to specify the type of 
extensions for different documents.    The extensions can be specified for HTML documents, Javascript/Jscript files, CSS files 
(style sheets) and TXT files.    Files are displayed in different colors according to the type of extension.

The General tab (external browser):

In the Search on disk    text box, select the drive where your external browser is located.    By default this is drive C.

From the menu Automatic Browser Search, select the external browser you want to use to view your HTML 
documents.

You can also search for the browser on your hard disk. If you select Netscape, the program will look for the file 
netscape.exe.    On the other hand, if you select Microsoft Internet Explorer the program will look for the file 
explorer.exe. 

Once the search has begun, you will see a window appear in the bottom half of the screen.    The program displays in 
this window the browser it finds.    If you click twice on it, the program inserts the access path to said browser in the 
corresponding text box.

The Environment tab:

Bar Options:

The bars in the Edit menu can be displayed or hidden.    When you click on one of them and remove the checkmark, the 
bar automatically disappears from the screen.

Display Code Explorer

This window is displayed to the left of the edit window.    It displays the links, the image source and other sources, the 
Java code as well as the Javascripts and VBScripts contained in the HTML document.

Icon bar

This is the bar that contains commands and the separating tabs.

Display Status Bar

This is the bar that appears at the bottom of the screen.    It indicates the document status.

Display special characters bar

This bar is found on top of the edit window.    This bar displays the special characters.

Display Internal Browser

This is AceExpert's internal browser.    If you checkmark this option, it will be launched every time you open the program.

Editor options:

If you place a checkmark on the box Display tip of the day at startup, every time you start the program, you will get a 
message with a    tip.

If you place a checkmark on the box Display the prolog    identifier, every time you create a new document, the first 
line of the document identifying the HTML version used in the page will appear.

If you place a checkmark on the box Display the AceExpert header comments, every time you create a new 
document, the five lines below the Identifier prolog, identifying among all the creation date and the date of last 
modification of the page will appear.



Tags in uppercase

If checked, the tags are inserted in uppercase in the edit window.

ISO8859-1 characters conversion

Allows conversion of special characters as per the standard ISO8859-1.    Please note that this standard is not 
supported by Netscape 4 and higher.

Internal browser options:

If you select Internet Explorer Viewer, the internal browser used will be MS Internet Explorer version 4 or higher.    You 
can only select this option if you have one of these versions of MS Internet Explorer installed.

You can use AceExpert's internal browser by selecting the Internet Explorer Viewer option.    It is recommended that 
you use this option only if    you have installed version 4 or higher of Microsoft    Internet Explorer.

You can use AceExpert’s internal viewer by selecting the option AceExpert Viewer.    You should only use this option if 
you do not have a version of MS Internet Explorer.

The option Display graphic images indicate whether graphic images will be displayed in the internal browser.

Miscellaneous Options:

If you place a checkmark in the Maximize browser at startup box, then your browser will always be opened in full 
screen size when you launch it.

If you place a checkmark in the Keep last directory used box, then the last directory used in the dialog Open or Save 
will appear when you open or save a document.

File Options:

You can create a backup file with the extension .bak for each document you save.    To do this, place a checkmark on the 
box Create an HTML backup copy.

The checkbox Save the HTML file to see the changes in the browser is checked by default.    It instructs AceExpert to 
ask you when you launch your browser if you wish to save your document.    If you remove the checkmark, you can view 
the last changes    you have made to your document without having to save it first.

You can also checkmark the option Automatic copy of referred files directly in the current directory.    This last 
option copies the files referred to in links to the current directory of your document, thus preventing relative access 
paths.

The Spelling tab:

LANGUAGE

In the    text box Languages, indicate which language to use when running the spelling check on you HTML documents.

CUSTOM DICTIONARY

If checked, the program will activate the custom dictionary specified.

IGNORE ALL CAPS

If checked, the program does not distinguish between upper and lower case while running the spell check.

IGNORE ROMAN NUMERALS

If checked, the program ignores Roman numerals while running the spell check.

IGNORE MIXED DIGITS



If checked, the program ignores words with letters and numbers while running the spell check.

FIND EXTRA SPACES

If checked, the spell checking program will find words with extra spaces.

FIND UNCAPPED SENTENCES 

If checked, the spell checking program will find sentences that start with lower case.

FIND MISSING SPACES

If checked, the spell checking program will find missing spaces.

FIND REPEATED WORDS

If checked, the spell checking program will find repeated words in the document.

FIND SPACE BEFORE PUNCTUATION

If checked, the spell checking program will find spaces placed before punctuation marks

FIND SPACE AFTER PUNCTUATION

If checked, the spell checking program will find spaces placed    after punctuation marks.

The Syntax Checking tab :

Options on the warning messages:

MAXIMUM NUMBER OF WARNINGS 

Indicates the maximum number of warnings in the message window during the HTML verification.    When this number is 
reached, HTLM verification is halted.

ATTRIBUTES INTEGRITY

If this box is checked, the program will display a message on the attributes integrity if an error is detected..    By default 
this option is checked

OPTIONAL END TAG WITHOUT START TAG

A warning is displayed in the message window if, during verification, the program detects that an end tag was used 
without the start tag.    By default this option is checked.

UNKNOWN START TAG

A warning is displayed in the message window if, during verification, the program detects a start tag that is not found in 
the HTML reference file specified by the syntax editor.    By default this option is checked.

OPTIONAL END TAG NOT FOUND

If you use a tag without an end tag that is not mandatory, a warning is displayed.    For example, if this option is checked 
and you use the <P> tag and you don’t include the </P> end tag, a warning is displayed.    By default this option is not 
checked.

DEAD LINKS

If you use a link in a document that refers to a non-existing destination, a warning is displayed.    By default this option is 
checked.

UNKNOWN END TAG

If you use an end tag that is not found in the HTML reference file of the syntax editor, a warning is displayed.    By default 
this option is checked.

Options    on warning messages:



MAXIMUM NUMBER OF ERRORS

Indicates the maximum number of errors during the HTML verification.    Once this number is reached, the verification is 
halted.

TAGS NOT ALLOWED

A tag not allowed is one that does not follow the rules found in the HTML syntax editor.    For example,    a <META> tag 
inserted outside the <HEAD> tags.    By default this option is checked.

 

REQUIRED ATTRIBUTE ABSENT

If a tag’s mandatory attribute is absent, an error warning will be displayed.    For example, if the <HREF> attribute to a 
link is absent.    By default this option is checked.

 

END TAG WITHOUT START TAG

If the program detects that an end tag was used without the start stag, an error message will be displayed.    By default 
this option is checked.

 

REQUIRED END TAG NOT FOUND

If you do not insert a required end tag, an error message will be displayed.    By default this option is checked.

ILLEGAL SYMBOL WITHIN TAG

If you use an illegal symbol, such as "&" within a tag, an error message will be displayed because this symbol is not 
acceptable within tags.    By default this option is checked.

TAG BRACKET NOT FOUND

Tags are enclosed in brackets <    and    >.    If a bracket is missing, an error message will be displayed.    By default this 
option is checked.

ATTRIBUTES IN END TAG ARE NOT ALLOWED

Usually end tags do not contain attributes.    If you enter an attribute in an end tag, an error message will be displayed. 
By default this option is checked.

DUPLICATE INTERNAL LINK

If you sue two internal links with the same name, an error message will be displayed.    By default this option is checked.

The Extensions tab:

From the Type of document box    you can select the type of document.    The different types of document available are: 
html, Javascript/Jscript, css and txt.

The text box List of extensions contain the list of extensions of documents that will be assigned to the selected 
document.    For example, .html et .htm extensions are associated with the document type HTML.

In the text box New extension, enter a new extension and insert it for the type of document selected.

The Delete button erases the extension that you select from the box List of extensions.

The Add button adds a new extension in the List of extensions for the type of document selected.

In the text box Default visible extensions, specify the default extensions of files visible in the Open and Save dialogs.



START INTERNAL BROWSER
Menus

With this command you can launch the internal browser (the one included with AceExpert) and/or refresh the results of your HTML 
document.    If the internal browsers is already open, then the command simply refreshes the results of changes made to the 
HTML document.

 

By default, AceExpert's internal browser is installed.    The browser supports HTML 3.0 code and part of the HTML 3.2 code.

With AceExpert you can choose Microsoft Internet Explorer to replace the internal browser.    In any case, to ensure good 
performance, it is necessary to have installed previously Microsoft Internet Explorer 4 or higher in your system

To start the internal browser:

1. From the standard toolbar, click on Start Internal Browser icon.    You can also use a shortcut by pressing F10 (Refer to List 
of shortcuts).

If the internal browser is already opened, press the    Refresh button to refresh the results of your HTML document in the 
browser.



START INTERNAL BROWSER icon 



START EXTERNAL BROWSER
Menus

This command launches the external browser in order to view the results of your document in the Netscape or MS Explorer 
browser.

To start the external browser:

From the standard toolbar, click on the Start the External Browser.    You can also use a shortcut by pressing 
SHIFT+F10 (Refer to List of shortcuts).

If you have not saved your document, AceExpert will instruct you to save it before starting the browser.

If no browser is running in the background, AceExpert will ask you to start it.

If the access path to the browser has not been identified or is incorrect, the General Preferences window will be 
displayed.    You can now indicate the correct access path to the browser.

If you click on  button, placed on the right of Start the External Browser, you can select either Netscape or MS Explorer 
browser in order to view the results of your document.



START EXTERNAL BROWSER icon 



FILE MANAGER

AceExpert's File Manager allows you to work with your files in the same way Windows    Explorer file management system does. 
Besides, it has certain program-related functions that make file management easy.    The main characteristics of the File Manager 
are the following:

1. It displays your system's directory structure.

2. You can copy or move folders and/or documents with the help of the context menu or by dragging and dropping.

3. You can view directly in the program the contents of the selected file; this is particularly useful when dealing with HTML 

documents, images and sounds.

4. It displays information on the size of files and the date they were last modified.

5. You can conduct searches for files according to selected criteria.

6. You can view the files displayed either as small or large icons, a simple list or as a detailed list.

7. You can view the items on your desktop.

To open the File Manager:

Click on the File Manager icon located on the top right corner of AceExpert's Standard    toolbar,

or

Click on the File Menu and select Open    (CTRL+O).

There are several options that allow you to manage your files within AceExpert itself.    A brief description follows:

The Up One Level button    allows you to move one level up in the file structure.

The View Desktop button displays the different items found on the desktop.

The Create New Folder button allows you to create a new folder.

 

 

 

    The Large Icons, Small icons, List and Details buttons allow you to view the files in different ways.

The Preview button lets you preview images.

The Files button lets you view the file hierarchy, exactly as you would view them in Window's Explorer.



The box text or property allows you to specify an object you want to search for.    If the object is made up of more than 
one word, enter the words between quotation marks.    For example, you can type HTML AceExpert Editor and conduct 
your search only in those files that contain these words.

The box last modified allows searching for files created in the time frame specified.

The Search button searches for a file that meets the criteria you have specified in the "text or property" box.    The "New 
search" button clears the previous search criteria and uses the new default values to conduct the search.

The Browse Images button displays all the bmp, gif and jpg format images found in any directory in your hard disk.    
This command is very useful in order to verify if the images you are using in your Web pages are placed on the correct 
directory in your had disk.

With the Insert link button you can insert an external link in your document that makes reference to the selected 
document in the File Manager window.

With the Insert image button you can insert in your document an image selected in the File Manager window.

The Icon Library icon, found to the right of the manager, gives you direct access to AceExpert's Icon Library directory 
when you insert an image in    a document.    It does not appear when you open a document, it appears only when you insert a 
graphics file.

The Icon Library icon only appears on the File Manager window if you have installed the icon library containing 2500 images .    You 
can download the icon library from the following address:

http://www.visic.com/aceexpert/iconbank.html



FILE MANAGER icon 



DISPLAY
Menus

You can choose to display or not the different bars used in the edit screen.    If you remove the checkmark before a bar, the bar 
automatically disappears.

Display Code Explorer

This window is displayed to the left of the edit window.    It displays the links, the image source and other sources, the Java code 
as well as the Javascripts and VBScripts contained in the HTML document.

Status Bar

This is the bar that appears at the bottom of the screen.    This bar indicates the document status.

Tabs Toolbars

This bar contains several    tabs which in turn have different options.

Margins Bar

These are two vertical bars that create margins on both the right and left side of the edit window.    The left bar is fixed and can be 
adjusted selecting the Options tab in the Editor Preferences menu, by inserting a value.    The right bar can be adjusted by 
placing the    mouse pointer over the bar and while keeping the left mouse button pressed , moving the mouse to the desired 
position.

Word Wrap

This is a vertical bar that creates right margin in edit Window. The bar can be adjusted by placing the    mouse pointer over the bar 
and while keeping the left mouse button pressed , moving the mouse to the desired position.

Display special characters bar

This bar is found on top of the edit window.    This bar displays the special characters.

Internal Browser:

This is AceExpert's internal browser that allows you displaying your documents without using an external browser.



MICROSOFT EXPLORER
Menus

If you choose this option, this will be your default external browser.



NETSCAPE
Menus

If you choose this option, this will be your default external browser.



MAGNIFYING GLASS icon  



TABS MENU

The Tabs menu contains the different options found on the toolbars.

There are nine types of tabs on the toolbar:

Common

Specialized

Tables, Frames and Lists

Forms

Extensions

Java 

Javascript

DHTML 

Custom



HELP MENU

Help Contents

This option gives you access to the Table of Contents of AceExpert's Help Files.

HTML Reference

Allows you to access HTML references containing all the HTML 3.0 commands, the extensions in both Netscape and Microsoft 
Explorer as well as many examples.

Javascript Reference

Allows you to access to JavaScript references containing all the commands found in JavaScript 1.1 as well as many examples.

Predefined Applets Help

Allows you to access    information on the predefined applets included with AceExpert, including Form and Java Banner.

Predefined CGI Help

Allows you to access information on CGI programs, particularly the use and installation of the following two programs:

· Mailto : to handle form contents and

· Hit Counter : to insert a counter on an HTML page.

What is this?

When you click on this option, the pointer changes to a pointer with a question mark.    When you place this pointer over a 
command, a window is displayed giving you information on the selected command.

DHTML Tutorial

The DHTML tutorial allows you to discover and approach new techniques for Web page design in order to make them more 
attractive, interactive and dynamic.    It is intended for all Web page creators. This tutorial must be downloaded.

JavaScript Tutorial

Allows you to start the JavaScript tutorial. This tutorial must be downloaded.

Tip Of The Day

Allows you to access all the Tips of the day.

Visicom on the Web

Allows you to visit our Web site.

About…

Supplies information on the developers of AceExpert.



THE COMMON TOOLBAR

Font

Heading Styles 
 

Align right

Center

Align left

Justify 

Bold

Italic

Underline

Preformatted

Block Quotation

Line Break

Paragraph

Comment

Font Color



FONT <FONT ...>

With this option you can change the characteristics of the font , as well as the type of font, it's size, color and certain other 
attributes.

To modify the font in your document:

1. Select the font that you wish to modify. 

2. In the Common toolbar, select the    Font Color icon.

3. Change the size, the color and type of font and then click on OK. 

To change the font size:

Change the selected value in the option box Size.    The default value is 3.    This option inserts the attribute SIZE in the FONT 
command.

Example:

<FONT SIZE=Value> Text </FONT>

You can also change the font size by selecting the text and click on  button, placed on the right of Font Color icon. A 
submenu will open and you can choose the font size desired.

To modify the font color:

Click on the    Color    icon and select a color.    The color selected will appear on the button.    The default color is black.

Changing the color inserts the attribute COLOR in the FONT command.

Example:

<FONT COLOR=value> Text </FONT>

To select a font type:

The font options available is only supported by     Microsoft Internet Explorer and 

 Netscape 3.0.    In the Available fonts window, you can select a font.    In case the user's operating system does not support 
the font you have chosen, you can choose several fonts to ensure one of them is supported.    You can select several fonts by 
selecting each font and then pressing the Add button (or erase a selected font by pressing the Erase button).    The arrows allow 
you to scroll through the list of fonts you have selected.    Once you are satisfied with your selection, press the OK button.

Example:

<FONT FACE="Arial,Courier New,Fixedsys"> Text </FONT>

Additional font attributes:

Click on the tab    Possible Attributes in the Font window to select additional properties.    These properties only make slight 

changes to the font.    The options with the  icon indicate that they are only Microsoft Internet Explorer extensions, while 
those with the 



 icon indicate they are only Netscape extensions.



COLOR icon 



FONT icon 



HEADING STYLE
<H1> <H2> <H3> <H4> <H5> <H6>

This command is used to assign    H1, H2, H3, H4, H5 or H6 heading styles to text. The first heading (H1) formats text in a larger 
font and/or darker than normal text, while the sixth heading type (H6) is the smallest.    With any of these tags, the titles or 
headings are automatically    placed on a line of their own within the document.

To make text into a title or heading:

1. Select the text in your document that you want to assign a Heading Style.

2. From the Common toolbar, select the Heading Style icon.

3. From the submenu that is displayed, choose Heading Style.

The text selected will appear between the    <H1> and </H1> or <H2> and </H2> or ... <H6> and </H6> tags.



HEADING STYLE icon 



ALIGN RIGHT 

This option    aligns text to the right side of the document.

To align text to the right:

1. Select the text in the document you want to align to the right.

2. On the Common toolbar, click on the Align right icon.

The selected text will be inserted between the tags    <DIV ALIGN="right"> and </DIV>



ALIGN RIGHT icon 



CENTER      <DIV ALIGN="CENTER">
See also

This option centers text in the document.

To center text:

1. Select the text in the document you want to center.

2. On the Common toolbar, click on the    Center icon.

The selected text will be inserted between the tags <DIV ALIGN="center"> and </DIV>



CENTER icon 



ALIGN LEFT 

This option aligns text to the left side of the document.

To align text to the left:

1. Select the text in the document    you want to align to the left.

2. In the Common toolbar, click on the Align left icon.

The selected text will be inserted between the tags    <DIV ALIGN="left"> and </DIV>



ALIGN LEFT icon 



BOLD <B>
See also

This option specifies that the text enclosed in the <B> tags will be displayed in bold.

To make text bold:

1. Select the text in the document you want to display in bold

2. On the Common toolbar, click on the    Bold icon.

The selected text will be inserted between the tags <B> and </B>.



BOLD icon 



See also
Italic

Underlined



ITALIC    <I>
See also

This option specifies the text that will be displayed in italics.

To make text appear in italics:

1. Select the text in the document you want to display in italics

2. On the Common toolbar, click on the Italic icon.

The selected text will be inserted between the tags <I> and </I>.



ITALIC icon 



See also
Bold

Underlined



UNDERLINE <U>
See also

This option specifies the text that will be underlined (if the browser supports this option).

To underline text:

1. Select the text in the document you want underlined

2. On the Common toolbar, click on the Underline icon.

The selected text will be inserted between the tags <U> and </U>.



UNDERLINE icon 



See also
Gras

Italic



BLINKING <BLINK>

This option makes text blink.

To insert text that blinks in your document:

1. Select the text that you want to display blinking.

2. On the Common toolbar, click on the Blinking icon.

The selected text will be inserted between the tags <BLINK> and </BLINK>.



BLINKING icon 



STRIKETHROUGH <STRIKE>

This option specifies the text that will have a line through it or strikethrough.

To insert text with strikethrough in your document:

1. Select the text in the document    you want to display with strikethrough.

2. On the Common toolbar, click on the Strike icon.

The selected text will be inserted between the tags <STRIKE> and </STRIKE>.



STRIKE icon    



PREFORMATTED <PRE>

Displays text in fixed-width type without collapsing spaces.    Spaces, new lines and tabulation are interpreted as in a text editor.    
Avoid using other HTML commands within sections defined by PRE.

To insert preformatted text in your document:

1. Select the text in the document you want preformatted.

2. On the Common toolbar, click on the Preformatted icon.

The selected text will be inserted between the tags <PRE> and </PRE>.

If you click on  button, placed on the right of Preformatted icon, a submenu will open and you can choose the number of 
maximum characters per line.    The default value is 80 columns. If you select a value of 40 or 132, the WIDTH attribute will be 
inserted in the PRE command.

Example:

<PRE WIDTH=40 or 132> text </PRE>



PREFORMATTED icon 



BLOCKQUOTE     <BLOCKQUOTE>

This command is used to set apart quotations in text by inserting indents both on the right and left margins.

To insert a block of quotation in your document:

1. Select the text you want to display as a block of quotation.

2. On the Common toolbar, click on the Block Quotation icon.

The selected text will be inserted between the tags <BLOCKQUOTE> and </BLOCKQUOTE>.



BLOCK QUOTATION icon 



See also
Line Break

Paragraph



LINE BREAK <BR>
See also

This command inserts a line break in your document.

To insert a line break in your document:

1. Place the cursor in the desired position in your document. 

2. On the Common toolbar, click on the    Line break icon.    You can also use a shortcut by simultaneously pressing CTRL-
R (Refer to List of shortcuts).

The program adds the command <BR> to the document.

If you click on  button, placed on the right of Line break icon, a submenu will open and you can choose the type of line break 
desired.

If you select the option Immediately after the image,    the program inserts the    <BR> command in your document.    This is the 
default option.

If you select the option At the next full right margin, the CLEAR attribute is inserted in the <BR> command.    In this case, the 
CLEAR attribute takes the value "RIGHT".    This aligns text to the right of an image.

Example:

<BR CLEAR="right">

If you select the option At the next full    left margin, the CLEAR attribute is inserted in the <BR> command.    In this case, the 
CLEAR attribute takes the value "LEFT".    This aligns text to the left of an image.

Example:

<BR CLEAR="left">

If you select the option At the next full left and right margins, the CLEAR attribute is inserted in the <BR> command.    In this 
case, the CLEAR attribute takes the value "ALL".    This aligns text to the left and right of an image.

Example:

<BR CLEAR="All">

Before you select Turn off line breaking, you must select the set of words you want inserted between the    <NOBR> and 
</NOBR> tags.    Whenever you use this command in your documents, it prevents text enclosed between the tags from wrapping 
to fit the screen, and it is displayed as one long line.

Example:

<NOBR>text that will not wrap to fit the screen </NOBR>



LINE BREAK icon 



See also
Center

Paragraph



PARAGRAPH <P>
See also

This command inserts a paragraph in your document.

To insert a paragraph in your document:

1. Place the cursor in the desired position in your document.

2. On the Common toolbar, click on the Paragraph icon.    You can also use a shortcut by simultaneously pressing CTRL + 
P (Refer to List of shortcuts).

The program adds the command <P> to the document.

If you click on  button, placed on the right of Paragraph icon, a submenu will open and you can choose the type of paragraph 
desired.

If you select the option To the left (default), the program inserts the <P> command in your document.    This is the default option.

If you select the option To the left (forced), the attribute ALIGN will be inserted in the    <P> command.    In this case, ALIGN will 
take the value "LEFT ".    This forces text to be aligned to the left.    This option only works with Netscape.

Example:

<P ALIGN="left">

If you select the option  In the center, the attribute ALIGN will be inserted in the    <P> command.    In this case, ALIGN will take 
the value "CENTER".    This attribute centers text.

Example:

<P ALIGN="center">

If you select the option To the right, the attribute ALIGN will be inserted in the    <P> command.    In this case, ALIGN will take the 
value "RIGHT ".    This aligns text to the right.

Example:

<P ALIGN="right">



PARAGRAPH icon 



See also
Center

Line Break



COMMENT <!--    ... -->

This commands inserts comment tags in your document.    These tags are <!--  and    -->.    Comments are not displayed by the 
browser.

To insert comments in your document:

1. Insert the text in your document that you want to place as a comment.

2. Select the text.

3. On the Common toolbar, click on the Comment icon.

The selected text will be inserted between the tags <!-- and -->.



COMMENT icon 



COLOR ICON

This useful button allows you to insert the hexadecimal value of the color you wish to use.    For example, you can change the color 
of the attributes of the BODY, FONT, BASEFONT, HR or TABLE commands.

To change the color of command attribute in your document:

1. Select the hexadecimal value you want to change.

2. In the Common toolbar, click on the Color icon.

3. Select a color.

4. Click on the OK button.

The program will replace the previous value with the one you selected.

Example:

<FONT COLOR=#FF0000> text </FONT>
Text will be rendered in red. 



COLOR icon 
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IMAGE <IMG>

This command inserts an image in your document.

To insert an    image in your document:

1. Place the cursor in the desired position to insert an image.

2. On the Specialized toolbar, click on the Image icon.

3. In the text box Source, indicate the access path and the name of the image.    The image must be in GIF or JPG format.

You can also look for the image by clicking on the Browse button located to the right of the text box.    This opens the 
window    Open a graphic file .

In this window you can preview the image you have chosen.

4. Click on the OK button.

The following command is inserted in your document:

<IMG SRC="acess path and filename" BORDER=0 WIDTH=Value HEIGHT=Value>

Options of the IMAGE command:

You can add several attributes to the command <IMG SRC=...>

The text box Alternative text:

Used to write a name or description for the image.    This image appears in place of the image if the browser is unable to display 
the image or if the transfer is interrupted. This option inserts the attribute ALT    in the <IMG> command.

The text box Name:

Used to assign a name to the image.    This name is useful when working with JavaScripts. This option inserts the attribute NAME 
in the <IMG> command.

 Image Properties Menu:

Border:

This attribute assigns a border to your image.    The default value is 0.    This option inserts the attribute BORDER in the    <IMG> 
command.

Width:

With this attribute you can change the width of the image in your document.    The value must be expressed in pixels.    This option 
modifies the WIDTH attribute.

Height:

With this attribute you can change the height of the image in your document.    The value must be expressed in pixels.    This option 
modifies the HEIGHT attribute.

Vertical space:



With this attribute you can insert vertical spacing to your image.    The value must be expressed in pixels.    This option inserts the 
attribute VSPACE in the <IMG> command.

Horizontal space:

With this attribute you can insert    horizontal spacing to your image.    The value must be expressed in pixels.    This option inserts 
the attribute HSPACE in the <IMG> command.

Alignment of image option:

 With this icon you can choose how to align your image.

At the bottom,    in the middle, at the top:

Select the alignment of the image according to the line of text by choosing one of the first three options.    You can choose to align 
the image in the middle or at the top.    The default value is at the bottom.    This option inserts the attribute ALIGN="TOP or 
MIDDLE" in the <IMG> command.

To the left, To the right, Text at the top, Abs in the middle, Abs at the bottom, Based on line:

 These alignments are Netscape extensions.

The option To the left aligns the image t the left of your page, while the option To the right aligns it to the right.    These options 
add the attribute    ALIGN="LEFT or RIGHT" in the <IMG> command.

The option Text at the top aligns the image with the text at the top, while Base on line aligns it with the text at the bottom.    These 
options insert the attribute ALIGN="TEXTTOP or BASELINE" in the <IMG> command. 

The options ABSMIDDLE and ABSBOTTOM

With the ABSMIDDLE and ABSBOTTOM options you can modify the alignment of the image according to the center or bottom of a 
line of text.    These options insert the attribute ALIGN="ABSMIDDLE or ABSBOTTOM" in the <IMG> command.

Video and    VRML extensions:

With this option you can insert a video sequence    with the extension    AVI    or a VRML file    with the extension WRL in your 
document.    When you press the icon, the menu Video Extensions and VRML opens on the screen.    This command is a Microsoft 
Internet Explorer 3.0 Extension. 

Erase All icon:

 This icon lets you restart from zero.    It resets the default values.

Image Map: 

This attribute defines an image as a map with coordinates.    This option inserts the attribute ISMAP in the <IMG> command.

JavaScript icon :

You can add a JavaScript event to an image.    This event will call a function written in JavaScript.

When you click on this icon found in the Image window, you are asked to indicate the name of the function you want to use.    You 



also have to indicate the type of possible event handlers with the Image command. 



Video Extensions and VRML

Microsoft Internet Explorer    Extension

To insert a video sequence or a VRML file:

1. On the Specialized toolbar, click on the Image icon, then click on the Video Extensions and VRML icon.

2. Indicate the access path and filename in the text box Source.    The file must be in AVI or WRL format.

3. In the Loop box, indicate the number of times you want it to play.

4. If the Visible Control panel is checked, then a control panel appears below the video sequence or VRML.

5. In the Start Event menu you can indicate whether you want the file to begin playing as soon as the page is loaded or 
when you move the pointer over the image.

6. Click on the OK button. 

The program inserts the following attributes in the <IMG> command:

DYNSRC: 

Indicates the source file.

LOOP:

Indicates the number of times the file will play.

CONTROLS:

Makes the control panel appear below the image.

START=MOUSEOVER:

Indicates the file will begin to play when the user moves the pointer over the video sequence.

Please note that you must indicate an image source for browsers that do not support video or VRML extensions.

If you want to enlarge or reduce the area where the video application will play, you must indicate the size using the WIDTH and 
HEIGHT attributes.



IMAGE icon 



IMAGE MAP <MAP>

This command allows you to make reference to different zones in an image that link each of them to an internal or external 
destination.

To insert an image map in your document:

7. On the Specialized toolbar, click on the Image Map icon.

8. In the text box    Identifier Name of the Image Map    enter a name for the image.

9. If you press the Insert Image icon (to the left of the Preview window), you can look for the image that will serve as the 
Image Map.    You can choose either of two options: Insert image with default attributes or Insert image with 
attributes.    The first option brings up the Open a graphic file    window while the second option brings up the Insert 
image window.    Once you have selected your image, you can view it in the Preview window.    You can enlarge the 
Preview window by dragging the right    border or the lower border of the window with the mouse.

10. Choose the shape you want to use to divide your image into different zones by pressing the Type of shape icon (to the 
left of the Preview window).    Now click on the image once and then adjust the size of the first hotspot zone by indicating 
the coordinates in the boxes: X, Y, Width and Height    (or Area).    You can also indicate these parameters by placing the 
pointer in your image and dragging it to the desired size.

11. Once you have defined the first hotspot zone, click on the Add Zone icon to add a reference to that zone.    You can 
choose between an internal link , an external link    or no link at all.    The last option is useful if you want to define one 
region as a dead zone in your image.

12. Once you have specified a reference for the zone, the coordinates will appear in a box above the Preview window.    The 
first zone you define will appear in red.    Follow the same procedure to define the following references for zones.    If you 
want to erase one of the hotspot    zones you defined, you must select it    from the list box above the Preview window, 
and press the right mouse button.    A    submenu appears with the option Erase zone.

13. Once you have defined all the hotspot zones, click on the OK button.

 This button erases all and allows you to start from scratch.    It resets all values to their default.

If you choose a rectangle as the type of shape for the different zones, the program will insert the following lines of code in your 
document:

<MAP NAME="Name">
  <AREA SHAPE="RECT" COORDS="X,Y,Width, Height" HREF="Document1.html">
  <AREA SHAPE="RECT" COORDS="X,Y,Width,Height " HREF="Document2.html">
</MAP>
<IMG SRC="Image" USEMAP="#Name">

If you choose a circle as the type of shape for the different zones, the program will insert the following lines of code in your 
document:

<MAP NAME="Name ">
  <AREA SHAPE="CIRCLE" COORDS="X,Y, Area" HREF="Document1.HTML">
  <AREA SHAPE="CIRCLE" COORDS="X,Y, Area" HREF="Document2.HTML">
</MAP>
<IMG SRC="Image" USEMAP="#Name">

Insert a JavaScript event:

You can attach a JavaScript event to each zone that you have defined in the image map.    This event will execute a JavaScript 
code when the event occurs.



To attach    a JavaScript event to a zone, you must select its coordinates from the box above the Preview window and then press 
the right mouse button.    A submenu appears from where you can choose JavaScript event.    You will be asked to specify the 
name of the function to be called and to indicate the possible event handlers for the image map. 



TYPE OF SHAPE icon 



ADD ZONE icon 
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HORIZONTAL LINE <HR>

This command inserts a horizontal line in your document.    You can edit the HTML code by pressing the Horizontal Line icon.

To insert a horizontal line in your document:

1. On the Specialized toolbar, click on the Horizontal Line icon.

2. Click on the OK button.

The program inserts the <HR> command in your document.    By default it inserts a line 1 pixel in width, 100% long with a 3-D 
effect and centered in the document.

You can make changes to the horizontal lines by changing the attributes of the <HR> command.

To remove the 3-D effect from the horizontal line:

Remove the checkmark from the    3D Effect box. This inserts the NOSHADE attribute in the HR command.

Example:

<HR NOSHADE>

To modify the width of the horizontal line:

Change the value in the Width the text box.      This value can be entered as a percentage or in pixels.    To enter it as a percentage 
you have to place a checkmark in the "%" box.    If the checkmark is not entered, then the value is understood in pixels.    By 
default this value is 100%.

This option insert the WIDTH attribute to the HR command.

Example:

<HR WIDTH=Value>

To modify the size of the horizontal line:

Change the value in the Size box.    The default value is 1.    This will insert the SIZE attribute to the HR command.

Example:

<HR SIZE=Value>

To change the alignment of the horizontal line:

Select the desired alignment from the Alignment    menu by clicking on one of the radio buttons.    You can align the line to the 
right or left.      This inserts the ALIGN attribute in the HR command.    The default alignment is in the center of the page.

Example:

<HR ALIGN=RIGHT or LEFT>



    To modify the color of the horizontal line:

Click on the    Color    icon and select a color.    The selected color will appear on the color button.    The default color is black.    This 
option only works with the Microsoft Internet Explorer browser.



HORIZONTAL LINE icon    



STYLE SHEETS <STYLE>
List of style sheet properties

Style sheets allow Web site developers to create sophisticated Web pages.    They make indenting paragraphs, changing heading 
styles and spacing between paragraphs easier.    These sheets offer a better tool to control the formatting of Web pages.

Compatible browsers:

· Microsoft Internet Explorer 3.x (partially compatible) and Microsoft Internet Explorer 4.x

· Netscape Navigator 4.x

Types of style sheets:

With AceExpert you can use three types of style sheets:

· Inline style sheets

· Internal style sheets

· External style sheets

With the first type, the styles are used in a similar manner as HTML tags.

With the second type of style sheets, styles are defined in the header (<HEAD>) section of each HTML document. 

Lastly, with the third type of style sheets, styles are defined in a separate file that has the extension .css, which simplifies 
making changes to them.

To define styles using AceExpert:

1. Select the Specialized toolbar.

2. Click on the Style Sheet icon.

Refer to the following sections:

Defining styles

Defining inline styles

Importing a style sheet

Saving a style sheet

Example :

<STYLE>
<!--
  BODY {background: red; color: yellow}
  H1 {font: 14pt Arial}
  P {font: 10pt Arial; text-indent: 0.5in}
-->
</STYLE>



DEFINING STYLES
List of style sheet properties

To modify the style of an existing tag:

1. Select a tag from the Tag selection box.

2. Select the desired property from the Style Sheet Properties list.

3. Click on the Properties button.

4. Indicate the desired values.

5. Click on the OK button.

6. If necessary, repeat steps 2 through 5.

7. Click on the OK button.

To assign more than one style to the same tag:

1. Select a tag from the Tag selection box.

2. Indicate a class name in the Class text box.

3. Select the desired property from the Style Sheet Properties list.

4. Click on the Properties button.

5. Indicate the desired values.

6. Click on the OK button.

7. If necessary, repeat steps 3 through 6.

8. Click on the OK button.

To assign a different style to the same tag, repeat the previous steps by choosing the same tag, but indicating a different Class 
name.    Then follow the same steps to indicate the desired properties.
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EXTERNAL LINK <A HREF=" ... ">
See also

This commands inserts a hyperlink in your document, that is a link to another HTML document or image.    The hyperlink can be 
some text or an image.

To insert an external link in your document:

1. Select the text or image that will act as the hyperlink.

2. On the Specialized toolbar, click on the External Link icon.

3. In the text box Reference to an external link enter the access path and the referred filename or search for the file by 
pressing the Browse button.

(Please note that the filename cannot contain any special characters or spaces.    Certain browsers do not accept these 
options.) 

In the window Link Content you can view the contents of the link you have chosen.

4. Select the type of external link from the following options:

None (direct link) : direct link to another document

HTTP link: link to an HTTP address

FTP link:    link to an FTP address

e-mail: link to an e-mail address

Newsgroup:    link to a newsgroup

5. Click on the OK button.

The following command will be inserted In your document:

<A HREF="access path/filename"> Text or image acting as hyperlink </A>

You can also edit existing External Link tags.

Following is the procedure to edit external link tags:

1. Place the cursor at the beginning of the tag <A HREF="access path/filename">.

2. Click on the right button of the mouse.

3. Press on Edit Tags.

External Destination(s) tab:

This window allows you to reference a target destination in an external link    to an HTML document.

Once you have chosen the HTML document you want to reference, you can view in the lower window the internal destination links 
that already exist in the document .    You can select the internal destination from the lower window.

This option adds the following anchor to the URL address:

Example:

<A HREF="access path and filename#AnchorName" > Text or image acting as hyperlink 



</A>

Target frames tab:

This option is used to specify the type of frame you wish to use.    This attribute is usually used with the Frames option.

This option inserts the attribute TARGET in the HREF command.

Example:

<A HREF="access path and filename" TARGET="TargetFrameName"> Text or image acting as 
hyperlink </A>

Please note that the TARGET attribute is case sensitive with respect to the target name.

How to create a link for displaying frames: 

If you want a hyperlink to open a document    in a window without frames, select the option " _top"    from the menu of    Predefined 
targets.    This option inserts the attribute TARGET="_TOP" in the link.

JavaScript tab:

In the text box    Identifier name of link, indicate the name that references the link.    The name will serve as a reference to the 
JavaScript. This option inserts the attribute NAME in the <A> command.

JavaScript button :

You can add a JavaScript event handler to an external link.    The event handler executes a function written in JavaScript. When 
you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select the type 
of possible events that must take place with the External Link. 



EXTERNAL LINK icon 



See also
Internal Link



INTERNAL LINK <A HREF = "#...">
See also

This command inserts an internal hyperlink in your document, that is, the hyperlink references the current document.

To insert an internal link in your document:

1. Select the text or image that will act as hyperlink. 

2. On the Specialized toolbar, click on the Internal Link icon.

If the destination of the hyperlink has not been identified:

Select the New Destination tab.    In the box Name of new link indicate the name of the link.    In the lower window    Choose the 
destination of the link you can preview the contents of your document.    From this window, select the line where you want to 
place the reference.

If the destination of the hyperlink has already been identified:

Select the Existing Destination(s) tab.    In the lower window Existing Destination(s) choose the destination for the hyperlink.

The following commands are inserted in your document:

<A HREF="#TargetDestination"> Text or image acting as a hyperlink </A>
(Places the hyperlink in your document)

<A NAME="TargetDestination"> Text or image that acts as the destination of your link 
</A>
(Anchors the  destination in your document)

JavaScript tab:

In the text box    Identifier name of link, enter a name to identify the link.    This name will serve to reference JavaScript events. 
This option inserts the attribute NAME in the <A> command.

JavaScript button :

You can add a JavaScript event handler to an internal link.    The event handler executes a function written in JavaScript. When 
you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select the type 
of possible events that must take place with the Internal Link. 



INTERNAL LINK icon    



See also
External Link



OPEN FILE 

The Open command is used to open an HTML, graphic or audio file that has been previously saved to disk.

To open an existing file:

1. Select the file by:

Selecting the drive 

Selecting the directory 

Selecting the type of file

Selecting the name of the file 

2. There are several options that allow you to manage your files within AceExpert itself.    A brief description follows:

The Up One Level button    allows you to move one level up in the file structure.

The Create New Folder button allows you to create a new folder.

 

 

 

    The Large Icons, Small icons, List and Details buttons allow you to view the files in different ways.

The Preview button lets you preview images.

The Files button lets you view the file hierarchy, exactly as you would view them in Window's Explorer.

The box text or property allows you to specify an object you want to search for.    If the object is made up of more than 
one word, enter the words between quotation marks.    For example, you can type HTML AceExpert Editor and conduct 
your search only in those files that contain these words.

The box last modified allows searching for files created in the time frame specified.

The Search button searches for a file that meets the criteria you have specified in the text or property box.    The New 
search button clears the previous search criteria and uses the new default values to conduct the search.

The Icon Library icon, found to the right of the manager, gives you direct access to AceExpert's Icon Library directory 
when you insert an image in    a document.    It does not appear when you open a document, it appears only when you insert a 
graphics file.

3. Click on the Open button.



EXISTING INTERNAL DESTINATION

This    icon,    located in the Specialized toolbar, allows direct access to the Existing Destination tab of the Internal Link window in 
order to insert or modify targets.

When you define a target, the    <A HREF> command will be inserted in your document.



TARGET icon    



SPECIAL CHARACTERS

This command inserts special characters in your document.

To insert a special character in your document:

1. Place the cursor in the desired position in your document.

2. On the Specialized toolbar, click on the Special Characters icon.

3. Double click on the desired character or select the character and then click on the checkmark    at the bottom of the 
window. 

The program will insert the special character code in your document.



SPECIAL CHARACTERS icon 



HTML TAGS SUMMARY

This option makes available the HTML 3.2 commands and the Netscape and Microsoft Internet Explorer extensions.    These 
commands can be inserted directly into your document. 

To have the list of commands available and insert a command:

1. Place the cursor in the desired position to insert the desired command. 

2. On the Specialized toolbar, click on the HTML Tags Summary icon.

3. The HTML Tags Summary window will appear on the screen.    Select the desired command.    In the lower window you 
can view    a description of the command you have selected.    You can insert this command by double clicking on it or by 
pressing the Insert button.



HTML TAGS SUMMARY icon    



DEFINITION OF THE BODY TAG <BODY>

With this command you can modify the attributes of the BODY of your document .    You can insert a an image in the 
BACKGROUND or indicate    BACKGROUND color, and modify the    color of text and links in your Web page.

To modify the <BODY> command in your document:

1. On the Specialized toolbar, click on the Body icon.    It doesn't matter where your cursor is located because the program 
will ask you if you wish to replace the previous <BODY> tag.

2. If you want to insert a background image to your page, you must indicate the access path and the filename in the box 
Background image.    The file must be in GIF or JPG format.    You can also search for the image file by pressing the 
Open icon.

You can view the image you choose in the Preview window.

3. In the Color Options window, select the desired color for the different options available by pressing the Color button.    
The selected color will appear on the button.

Description of the different options for colors: 

BACKGROUND

With this attribute you can modify the background color of your page. 

TEXT

With this attribute you can modify    the color of text in your page. 

LINK

With this attribute you can modify the color of links on your page. 

ACTIVE LINK

With this attribute you can modify the color of active links, that is, the color of a link when you click on it.

VISITED LINK

With this attribute you can modify    the color    of visited links in your page.    The default color is mauve.

Example:

<BODY BGCOLOR=#Color>
<BODY BGCOLOR="#FFFFFF" TEXT="#000000" LINK="#000080" VLINK="#800080" 
ALINK="#FF0000">

The Erase button:

The    Erase button allows you to reset the default values of the BODY command, depending on the browser you use.

Microsoft Internet Explorer Extensions:

With Microsoft Internet Explorer you can insert other attributes in the BODY command.

You can modify the left margin and top margins of your document by specifying a value in pixels in the Left margin and Top 
margin boxes.      These margin settings will be in effect when you open your document.

 

The option Left margin inserts the LEFTMARGIN attribute, while the Top margin inserts the TOPMARGIN attribute in the BODY 
command.



Example:

<BODY LEFTMARGIN="Value" TOPMARGIN="Value">

If you place a checkmark on the Fixed background box, the background appears to be frozen. This option inserts the attribute 
BGPROPERTIES=FIXED in the BODY command.

Example:

<BODY BACKGROUND="image" BGPROPERTIES=FIXED>

JavaScript button : 

You can attach a JavaScript function to the BODY command.    This event will execute a function written in JavaScript.

When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the BODY command. 



DOCUMENT BODY icon 



JAVA APPLICATION <APPLET>
Description of fields

With this command you can insert in your document one of AceExpert's predefined Java applets or an external Java applet.

Using this command you can also edit the    HTML code of a Java applet by selecting the code and then clicking on the Java 
button once more.

You can also add a custom applet.    Custom applets are applets inserted by the user.

To insert one of AceExpert's predefined Java applets in your document:

1. First save your HTML document.

2. Select the Java tab and then click on the Java Applet icon.

3. Select the desired applet from the window on the right. If necessary, refer to the online help on predefined applets.    
Here you will find a description of the applet, the list of parameters and an example of each applet.

4. Click on the Insert button.    AceExpert asks if you wish to save the .class file in the same directory as that of your HTML 
document.

5. If necessary, modify the attributes and/or parameters.

6. Select the Preview tab to preview the selected applet.

7. Click on the OK button.

To insert a Java applet not predefined by AceExpert into your document:

1. First save your HTML document.

2. In the Java toolbar, click on the    Java Applet icon.

3. In the text box Code, insert the name of the file that contains the application you want to place in your document.    The 
address must be a relative address.    It cannot be an absolute address. 

4. In the text box Code Base URL, you can specify the URL that contains the Java Applet.    If this option is left blank, the 
current document's URL will be used.

5. In the text box Alternative Text, you can specify the text that will appear while the application loads or if the browser 
being used is not capable of displaying Java applications.    This attribute is optional. 

6. In the text box Name, you can insert the name of the application.    This name allows communicating with other 
applications on the same page.    This attribute is optional.

7. In the Alignment box, select the desired alignment from the different options for the application.    This option is 
mandatory.    The default alignment is centered.

8. The JavaScript Access checkbox allows accessing the Java from the Javascript.

9. In the boxes    Width and Height you must specify the size in pixels of the area that will display the application.    These 
values are mandatory.

10. In the boxes Vertical space and Horizontal space, you can specify the space in pixels in the top/bottom and to the 
right/left of the application.    These values are optional. 

11. By opening the Parameters tab, you can change the application's    parameters.    To do so, you must indicate a 



parameter name    and a value in the corresponding text boxes, and then press the Add button.    You can also edit 
existing parameters or delete them by pressing the corresponding buttons.

12. Select the Preview tab to preview the selected applet.

13. Click on the OK button.

EXAMPLE:

<APPLET CODEBASE="http://www.asite.com/acode.class" CODE="File" ALT="Text" 
NAME="Name" ALIGN=Alignment WIDTH=Value HEIGHT= Value>
  <PARAM NAME="ApplicationAttribute1" VALUE=Value>
  <PARAM NAME="ApplicationAttribute2" VALUE=Value>
  <PARAM NAME="ApplicationAttribute3" VALUE=Value>
</APPLET>

To add a new parameter:

1. Indicate the name of the parameter in the Name text box.

2. Press the Edit button to enter a value for text, color or a file.

To modify an existing parameter:

1. Select the desired parameter from the list.

2. Press the Edit button. 

3. Select Text editor, Edit color or Open a file.

4. Change the value.

5. Click on the OK button.

To delete a parameter:

1. Select the desired parameter from the list.

2. Click on the Erase button or press the Delete key.

To modify the HTML code of an existing applet:

1. Select the HTML code of the application in the document, located between the tags <APPLET…> and </APPLET>;

2. Select the Java tab, and click on the Java Applet icon.

3. Modify the attributes and/or applet's parameters.

4. Click on the OK button.



To add a custom applet:

· On the Java tab, click on the Insert Java Applet icon;

· Fill out the property fields and the parameters related to the applet.

· Click on the Add button;

· The dialog screen Applet Creation Wizard will ask you to enter the name of the custom applet that will be added to the 
Custom Applets window.

· Press on the Next button;

· Press on the Add files button to select the files associated with the applet.    These files can be .class, HTML or other, 
depending on the type of applet.

· Press the Finish button.

Once the procedure is completed, the files will be copied to    AceExpert’s custom files directory and the applet will be displayed 
in the Custom Applets window that displays a list of all available custom applets.

To remove an existing custom applet:

· On the Java tab, click on the Insert Java Applet icon;

· Select the custom applet that you want to remove;

· Press the Delete button.

To insert a custom applet in a document:

· Select the desired applet from the Custom Applets window;

· Press the Insert button.

The .class files and other related files will be copied to the document’s directory.



JAVA APPLET icon 



Description of the fields of the JAVA APPLET commands

ATTRIBUT
ES

DESCRIPTION

Code Name of .class file of applet

CodeBase (URL) Access path of .class file if it is located in a different directory than that of the HTML document.

Alternative text Text displayed while application is loaded or if it cannot be displayed.

Name Name that identifies applet to make reference to it from JavaScript code.

Alignment Alignment of applet with regard to surrounding text.

Javascript Access Allows Java to access JavaScript from the HTML document.

Width Width of area occupied by the applet

Height Height of area occupied by applet

Horizontal space Horizontal spacing in pixels between the applet and the surrounding text

Vertical space Vertical spacing in pixels between the applet and the surrounding text 



BASEFONT <BASEFONT>

This command is used to define base properties such as the size, color and font .. Once the BASEFONT command is inserted in 
your document, the text will display the attributes specified.

To insert a base font in your document:

1. On the Specialized toolbar, click on the Base font  icon.

2. To change the size of the font, change the value in the Size box.    The default value is 3 pixels.    This option will insert 
the attribute SIZE to the BASEFONT command.

3. To modify the font color, click on the Color button and select a color. The color selected appears on the button.    The 
default color is black.    When you change the color, the attribute COLOR is inserted in    the BASEFONT command.

4. To modify the font type of the base font, select from Font options the type of font desired.    In case the user's operating 
system does not support the font you have chosen, you can choose several fonts to ensure one of them is supported.    
When you change the font options, the attribute FACE is inserted to the BASEFONT command.    You can select several 
fonts by selecting each font and then pressing the Add button (or erase a selected font by pressing the Erase button).    
The arrows allow you to scroll through the list of fonts you have selected.

5. Click on the OK button.

The program inserts the following lines of code in your document:

<BASEFONT SIZE= Value FACE="Font Name" COLOR="Color">



BASEFONT icon 



EMBEDDED MODULE <EMBED>

This command executes Netscape's external programs.    These can be audio, video, VRML and other programs.

To insert and embedded module in your document:

1. On the Specialized toolbar, click on the Embedded Module icon.

2. In the text box Source, specify the access path and filename you want to insert.    Sound files must be in WAV or MID 
format and video files in AVI or WRL format. 

3. From the Alignment options, select the alignment of the program with respect to text found on the same line.    This 
option is mandatory.

4. Click on the OK button.

The program inserts the following command in your document:

<EMBED SRC="Filename" ALIGN="Alignment">

You can select    the following options in the EMBED command:

REPEAT INFINITELY

If you insert a checkmark in this box, the file will play as long as the page is open.    This option inserts the attribute 
LOOP=TRUE.

AUTOMATIC START

If you insert a checkmark in this box,    the file will begin playing when the page is loaded. This option inserts the attribute 
AUTOSTART=TRUE.

HIDE CONTROL PANEL

If you insert a checkmark in this box, the control panel will not display on the page.    This option inserts the attribute 
HIDDEN=TRUE.

REDUCED CONTROL PANEL

If you insert a checkmark in this box,    a smaller control panel will display on the page. This option inserts the attribute 
CONTROLS=SMALLCONSOLE.

BORDER

In this    box you can indicate a border that will be placed around the area where the program will be displayed. This 
option inserts the attribute BORDER=" ".

VOLUME

In this box you can adjust the start volume for a sound file.    The user can adjust it himself later.      This option inserts the 
attribute    VOLUME=value.

WIDTH/HEIGHT

In these boxes you can indicate the width and height of the area where the program will be displayed. This option inserts 
the attributes WIDTH and HEIGHT.



 EMBEDDED MODULE icon 



TABLES, FRAMES AND LISTS TOOLBAR

Insert a table

Insert a Quick Table 

Insert Frames

Ordered List

Unordered List

Definition List



TABLE    <TABLE>
Examples

With this command you can insert a table in your document.

To insert a table in your document: 

1. Position the cursor where you want to insert the table.

2. In the Tables, Frames and List tab,    click on the button Insert a Table.

3. In the window Insert a table, indicate the number of columns and rows in the appropriate boxes.

4. Click on the OK button.

5. In the Preview window at the bottom of the screen, place the cursor before the &nbsp code and enter the 
contents for each cell in the table.

You can modify the width and height of cells and columns.    Place the cursor on the line separating two columns or cells. 
The cursor changes to double arrows that point up or sideways, depending on the selection.    Press the left mouse 
button as you move the cursor up, down, left or right.

To access other optionsion the table, select one or more cells and then click the right mouse button

6. Press the OK button.

You can modify the table by selecting the <TABLE> tag and clicking the Insert a Table icon..

You can also edit embedded tables with AceExpert.    To do so, select the cell that contains the embedded table and then click the 
right mouse button to open the shortcut menu.    Select Edit table.    A second dialog box containing the new table opens in the 
screen.

You can insert HTML tags inside a table.    To do so, position the cursor in the desired position in the table and then click the right 
mouse button to bring up the shortcut menu.    From the menu select Tags and then choose the tag you want to insert.

The following are optional attributes of the <TABLE> command.

WIDTH

You can modify the width of the table by assigning the desired value in the Width box.    This value can be entered as a 
percentage or expressed    in pixels.    To enter a value as a percentage place a checkmark in the "%"  box.    If you enter a value in 
pixels remove the check mark from the box.

Example:

<TABLE WIDTH=50%>…</TABLE>
(The table’s width is 50% of the screen space occupied by the browser.)

HEIGHT

You can modify the height of the table by assigning the desired value in the Height box.    This value can be entered as a 
percentage or expressed    in pixels.    To enter a value as a percentage place a checkmark in the "%"  box.    If you enter a value in 
pixels remove the check mark from the box.

Example:

<TABLE HEIGHT=50%>…</TABLE>
(The table’s height is 50% of the screen space occupied by the browser.)

BACKGROUND



You can enter a background color for the table.    To do so, click on the Color    button and select a color.

BORDER

You can place a border around the table by selecting the desired size in the box Border.    This value is expressed in pixels.    The 
default value is 0.    The higher the number, the larger the border.

Example:

<TABLE BORDER=2>…</TABLE>
(The table border is two pixels in size.)

SPACE IN CELLS

You can adjust the space between the contents of the cell and the table border by assigning a value in the Space in cells box for 
the cell.    This value is expressed in pixels and the default value is 0.    The higher the number, the bigger the space between the 
cell’s contents and the border.

Example:

<TABLE BORDER=2 CELLPADDING=10>…</TABLE>
 (The space between the cell’s contents and the table’s border is 10 pixels in size.)

SPACE BETWEEN CELLS

You can adjust the space between cells by assigning a value to the box Space between cells.    This value is expressed in pixels 
and the default value is 0.    The higher the number, the bigger the space between the cells and the border (if any).

Example:

<TABLE CELLSPACING=10>…</TABLE>
(The space between the table’s cells is 10 pixels in size.)

Horizontal alignment:

You can indicate the horizontal alignment of the table in your Web page: left (default), right or centered.

Example:

<TABLE ALIGN=RIGHT>…</TABLE>
(The table will be aligned to the right of your Web page.)

Menus found on the Edit Table window:

File menu 

Edit menu 

Options menu 

Table menu 

To modify a table in your document :

· Place the cursor    inside the <TABLE>  tag;

· Click on the right mouse button;

· Click on Edit TABLE option.

The Table window opens and you can then make the desired changes.



TABLE MENU OPTIONS

This menu gives you different options to insert, delete, and merge cells and rows.    You can also modify the properties of each of 
the table's cells and columns.    Following are the options in the Table menu:

Insert cells 

Delete cells 

Merge cells 

Split cells 

Insert columns 

Delete columns 

Merge columns 

Insert rows 

Delete rows 

Merge rows 

Cell properties 

Row properties 

Column properties 

Additional table properties 



TABLE FILE MENU OPTIONS

This menu provides the following options :

New table

Create a new table in your HTML document by selecting the New table option in the File menu

Load table

Used to open an existing table in an HTML document.    To do this, select the Load Table option in the File menu and select the 
name of the table that you want to open.

Save table

Allows you to save a table by giving it a name.

Close table

Used to close the Table dialog window of the table on which you are working.



TABLE EDIT MENU OPTIONS

Undo

This command allows you to undo the last edit commands performed on the table.    The first time you select this option, the 
program will undo the last command you performed.    If you select this option again, the program will undo the next to last 
command, and so on and so forth.

Redo

This command allows you to redo the last commands which were undone.    The first time you select this option, the program will 
redo the last action you reversed.    If you select this option again, the program will redo the next to last command which was 
reversed, and so on and so forth.

Cut

This command removes the contents of one table cell and places it on the Clipboard.    Later, the contents can be reinserted in 
another cell by using the Paste option of the Edit menu.

Copy

This command copies the contents of a selected table cell and places it on the Clipboard.    Later, the contents can be reinserted 
in another cell by using the Paste option of the Edit menu.

Paste

This command inserts the contents of the Clipboard in the selected cell.    Since the information remains in the Clipboard, you 
can reinsert it many times in different cells by selecting the Paste option in the Edit menu several times.

Erase row
This command is used to delete a previously selected row.

Erase column

This command is used to delete a previously selected column.

Erase table

This command is used to delete a previously selected table.

Select rows 

This command allows you to select an entire table row by positioning the cursor on the desired row and then pressing on the 
Select row option of the Edit menu.    To deselect, click anywhere on the table..

Select columns
This command allows you to select an entire table column by placing the cursor on the desired column and then pressing the 
Select column option in the Edit menu.    To deselect, click anywhere on the table.

Select table

This command allows you to select a table by placing the cursor anywhere in the Preview window and using the Select row 
option of the Edit menu.    To deselect, click anywhere on the table.



OPTIONS IN THE TABLE OPTIONS MENU

Show NoBreak Space : When this option is checked, it allows you to see the &nbsp code which must be placed to the right of 
each table cell's content in the compose window as well as in the code written in the HTML page.

Generate tags in :

· UPPERCASE : Used to generate tag codes in uppercase in the HTML page.

· lowercase : Used to generate tag codes in lowercase in the HTML page.

· SmartCase : Used to generate the first letter of the tag codes in uppercase and the rest in lowercase.

Generate attributes in :

· UPPERCASE : Used to generate the attributes' code in uppercase in the HTML page.

· lowercase : Used to generate the attributes' code in lowercase in the HTML page.

· SmartCase : Used to generate the first letter of the attributes' code in uppercase and the rest in lowercase.

Example of tags in uppercase and attributes in lowercase:

<TR align="right" valign="top" bgcolor="#FF0000" bordercolor="#FF00FF" 
bordercolorlight="#FFFF00">



MERGE CELLS

You can merge two or more cells in your table.    To do this, select the cells you wish to merge.    These cells must be adjacent.    
Once the cells are selected, press the Merge cells option of the Table menu.

If you merge cells in the same row, the program will add the COLSPAN attribute to the TD command in this row.

Example:

<TD COLSPAN="3">&nbsp;</TD>
(The number 3 means that you have merged three cells from the same row)

If you merge cells that are in the same column, the program will add the ROWSPAN attribute to this column's TD command.

Example:

<TD ROWSPAN="3">&nbsp;</TD>

(The number 3 means that you have merged three cells from the same column)



CELL PROPERTIES

You can modify the properties of a cell by pressing the Cell properties option in the Table menu or with a contextual menu.

To modify the properties of a cell :

· Use the mouse to select the desired cell in the Preview window;

· In the Table menu press the Cell properties option

Or

· Right-click with the mouse and select the Cell properties option.

The Cell properties dialog box will appear in order to let you modify the Table cell properties.



ROW PROPERTIES

You can modify the properties of a row by pressing the Row properties option in the Table menu or with a contextual menu.

To modify the properties of a cell :

· Use the mouse to select the desired row in the Preview window;

· In the Table menu, press the Row properties  option

Or

· Right-click with the mouse and select the Row Properties option.

The Row properties dialog box will appear in order to let you modify the table cell properties.



ADDITIONAL TABLE PROPERTIES

The properties which you indicate will apply to all the table cells.    In this menu there are two tabs: GENERAL and ADVANCED.

The GENERAL tab:

TITLE

You can give a title to your table by writing it in the Title box.    When you pass the mouse over this table, the tile will be displayed 
at the bottom of the table in the Preview window.    In the HTML page, the TITLE=" " The code will be inserted..

BROWSER EXTENSIONS

In this menu you can determine the browser options that you wish to use.    The two browsers used are Netscape and Microsoft 
Internet Explorer. By choosing Netscape Extensions which is checked by default, you choose the options that will be displayed 
in both browsers.    By choosing Microsoft Extensions, you will have other options which will not be displayed other than in the 
Microsoft Internet Explorer browser.    These additional options are options that modify the horizontal alignment of the table.

TABLE VERTICAL ALIGNMENT

In the Vertical alignment menu you can select the desired alignment of the table in relation to your Web page.

TABLE CAPTION

You can provide a caption for your table by entering it in the Table caption text box.    The <CAPTION>UN NOM</CAPTION>  
The code will be inserted in the HTML page.

TABLE SUMMARY

In order to identify the contents of each table in an HTML document, you can write a summary for each table.    To do this, write a 
summary explaining the table contents in the Table summary text box.    The <TABLE SUMMARY="table1 summary"> 
will be inserted in the HTML page. 

The ADVANCED tab:

This commands are specific to the Microsoft Internet Explorer browser.

BACKGROUND IMAGE

You can add a background image for the entire table.    To do this you only have to press the OPEN icon and select the desired 
image.

EXTERNAL BORDERS

You can specify the type of borders that you wish to use with the table.    The available types of external borders are:

All : Your entire table will be framed by external borders, from left to right and from top to bottom.

Top : If you check the Top option only, your table will only have an external border at the top of the table.    The program will 
insert the FRAME="ABOVE" code inside the TABLE tag.

Bottom : If you check the Bottom option only, your table will only have an external border at the bottom of the table.    The 
program will insert the FRAME="BELOW " code inside the TABLE tag.

Left : by checking the Left option only, you cause your table to have an external border to the left of the table.    The program will 
insert the FRAME="LHS" code inside the TABLE tag.

Right : by pressing the Right option only, you cause your table to have an external border to the right of the table.    The program 
will insert the FRAME="RHS" code inside the TABLE tag.

You can also check two options at the same time.    If you check the Top and Bottom options, the program will insert the 
FRAME="HSIDES" code.    Your table will have external horizontal borders at the top and at the bottom of the table.    By 
checking the Left and Right options, the program will insert the FRAME=" VSIDES" code.    Your table will have external vertical 
borders to the left and to the right of the table.

DARK BORDER



You can modify the color of the table border so that the color appears dark.    To do this, you only have to press the Color button 
and select the desired color.

LIGHT BORDER

You can modify the color of the table border so that it appears light.    To do this, you only have to press the Color button and 
select the desired color.

INTERNAL BORDERS

In the Internal borders menu you can select different options for the internal table borders.

You can display the internal table borders by checking the Activate all borders option.    This option is activated by default.    You 
can also deactivate them if you do not want them.

You can also display the horizontal borders between rows or display the vertical borders between columns.    By checking the 
Display borders between groups you will only see the internal borders of the table rows grouped horizontally (if there are any) 
and the internal borders of grouped columns (if there are any).



TABLE icon    



CELL PROPERTIES icon 



EXAMPLES: TABLE

1.

<TABLE BORDER="2" ALIGN="RIGHT">
  <COL SPAN="3">
    <TR>
      <TD>A</TD>
      <TD>B</TD>
      <TD>C</TD>
    </TR>
    <TR>
      <TD>D</TD>
      <TD>E</TD>
      <TD>F</TD>
    </TR>
</TABLE>

Result:

2.

<TABLE WIDTH="40%">
  <COL SPAN="2">
    <TR>
      <TH BGCOLOR="#FF8080" COLSPAN="2">Header cell</TH>
    </TR>
    <TR>
      <TD BGCOLOR="#FFFF80">C1</TD>
      <TD BGCOLOR="#C0C0C0" ALIGN="CENTER">C3</TD>
    </TR>
    <TR>
      <TD BGCOLOR="#FFFF80" ROWSPAN="2">C2</TD>
      <TD BGCOLOR="#C0C0C0" ALIGN="CENTER">C4</TD>
    </TR>
    <TR>
      <TD BGCOLOR="#C0C0C0" ALIGN="CENTER">C5</TD>
    </TR>
</TABLE>

Result:



TABLE CELL PROPERTIES

The properties that you select will be applied to the selected cell.    That is, to the TD or TH command.    In this window there are 
two tabs: GENERAL and ADVANCED.

The GENERAL tab:

HORIZONTAL ALIGNMENT

Select    the horizontal alignment of the text inside the cell.    This alignment can be left (by default), right or center.

VERTICAL ALIGNMENT

Select the vertical alignment of the text inside the cell.    This alignment may be top, center (by default), bottom, or based on the 
line of the cell..

WIDTH

You can adjust the width of the cell by entering the desired value in the Width box.    This value may be expressed as a 
percentage or in pixels.    For it to be a percentage, the "%" box must be checked.    If this box is not checked, the value will be in 
pixels.

Example:

<TD WIDTH="60%" HEIGHT="20%">&nbsp;</TD>

(The cell width will be 60% with respect to the table used.)

HEIGHT

You can adjust the height of the table by entering a value in the Height box.    This value may be expressed as a percentage or in 
pixels.    For it to be a percentage, the "%" box must be checked.    If this box is not checked, the value will be in pixels.

Example:

<TD WIDTH="60%" HEIGHT="20%">&nbsp;</TD>
(The cell height will be 20% with respect to the table used.)

BACKGROUND COLOR

You can modify the background color of the cell.    To do this you only have to press the Color button and select the desired color.

BORDER COLOR

With the Microsoft Internet Explorer browser, you can modify the color of the cell border.    To do this you only have to press the 
Color button and select the desired color.

HEADER CELL/DATA CELL

Determines if the cell is a header cell (TH) or a regular cell (TD).    The header cells are generally used on the first row or on the 
first column.    They are distinguished from regular cells because they are automatically in bold.

NO WRAP

The No wrap option does not allow a text line to be cut inside a cell.    It adds the NOWRAP attribute to the TD or TH commands.

The ADVANCED tab:

BACKGROUND IMAGE

With the Microsoft Internet Explorer browser,    you can add a background image to the cell.    To do this you only have to press 



the OPEN button and select the desired image.

DARK BORDER

With the Microsoft Internet Explorer browser,    you can modify the color of the cell border so that it appears dark.    To do this you 
only have to press the Color button and select the desired color.

LIGHT BORDER

With the Microsoft Internet Explorer browser,    you can modify the color of the cell border so that it appears light.    To do this you 
only have to press on the Color button and select the desired color.

TITLE

You can give a title to the table cell by entering it in the Title box.    When you pass the mouse over the cell, the indicated title will 
be displayed at the bottom of the table in the Preview window.    The TITLE=" " The code will be inserted in the HTML page.

Example :

<TD TITLE="cell1">&nbsp;</TD>



TABLE ROW PROPERTIES

The properties you select will apply to all the cells in the selected row.    That is, to the TR or TBODY command.    This window 
contains the GENERAL tab.

The GENERAL tab

HORIZONTAL ALIGNMENT

You can adjust the alignment of all the cells in the row by selecting the HORIZONTAL ALIGNMENT that you want.    This 
alignment can be left (by default), right, or center, justified.      The <TR    ALIGN> or <TBODY    ALIGN> The code will be inserted 
in the HTML page if the Group option is checked.

Example :

<TR ALIGN="CENTER">
or

<TBODY ALIGN="CENTER">

VERTICAL ALIGNMENT

You can adjust the alignment of all the cells in the row by selecting the VERTICAL ALIGNMENT that you want.    This alignment 
can be top, middle (by default), bottom, or based on line. The <TR    ALIGN> or <TBODY    ALIGN> code will be inserted in the 
HTML page if the Group option is checked.

Example :

<TR VALIGN="TOP">
or

<TBODY VALIGN="TOP">

BACKGROUND COLOR

You can change the color of    all the cells in the row.    To do this you only have to press the Color button and select the desired 
color.

DARK BORDER

With the Microsoft Internet Explorer browser,    you can change the color of the border of all the cells in the row so that the color 
appears dark.    To do this you only have to press the Color button and select the desired color.

LIGHT BORDER

With the Microsoft Internet Explorer browser,    you can change the color of the border of all the cells in the row so that the color 
appears light.    To do this you only have to press the Color button and select the desired color.

TITLE

You can assign a title to your table row by entering it in the Title text box.    When the mouse passes over each cell in the row, the 
indicated title will be displayed in the Preview window. The TITLE=" "code will be inserted in the HTML page.

Example :

<TR TITLE="row1">

GROUP

Is used to group the row and insert the TBODY code.



TABLE COLUMN PROPERTIES

The properties you select will apply to all the cells of the selected column.    That is, to the COL OR COLGROUP commands if 
the Group option is checked.    This window contains the GENERAL tab.

The GENERAL tab

HORIZONTAL ALIGNMENT

You can adjust the alignment of all the cells in the column by selecting the HORIZONTAL ALIGNMENT that you want.    This 
alignment can be left (by default), right, or center justified. The <COL    ALIGN> or <COLGROUP    ALIGN> code will be inserted 
in the HTML page.

Example :

<COL ALIGN="CENTER">
or
<COLGROUP ALIGN="CENTER">

VERTICAL ALIGNMENT

You can adjust the alignment of all the cells in the column by selecting the VERTICAL ALIGNMENT that you want.    This 
alignment can be top, middle (by default) bottom, or based on the line. The <COL    VALIGN> or <COLGROUP    VALIGN> code 
will be inserted in the HTML page.

Example :

<COL VALIGN="BOTTOM">
or
<COLGROUP VALIGN="BOTTOM">

BACKGROUND COLOR

You can change the color of    all the cells in the column.    To do this you only have to press the Color button and select the 
desired color.

WIDTH

You can adjust the width of the table column by entering the desired value in the Width box.    This value can be expressed as a 
percentage or in pixels.    For it to be a percentage, the "%" box must be checked.    If this box is not checked, then the value will 
be in pixels.

Example:

<COL WIDTH="31%">

TITLE

You can assign a title to your table column by entering it in the Title box.    When the mouse passes over each cell in the column, 
the title will be displayed at the bottom of the table in the Preview window.    The TITLE=" "code will be inserted in the HTML 
page.

Example :

<COL WIDTH="40" ALIGN="CENTER" VALIGN="BOTTOM" TITLE="column 2">

GROUP

Is used to group the column and insert the COLGROUP code.



TABLE CAPTION

You can assign a caption to your table by entering it in the Table caption text box.    When you assign a title, indicate whether it 
will be displayed at the top or at the bottom.

The Microsoft Internet Explorer browser allows you to align the title to the left, right or center of the table.

This option will add the <CAPTION> and </CAPTION> markers after the <TABLE> command.



TABLE PROPERTIES

The properties you select will apply to all the cells in the table.    There are three tabs in this menu: GENERAL and OTHER 
PROPERTIES.

The GENERAL tab :

In the Background color and Border color text boxes, you can change the color of all the table cells as well as the color of the 
border.    To do this you only have to press the Color button and select the desired color.

The OTHER PROPERTIES tab :

WALL PAPER

With the Microsoft Internet Explorer browser,    you can add a background image to the cell.    To do this you only have to press 
the OPEN button and select the desired image.

VERTICAL ALIGNMENT

In the VERTICAL ALIGNMENT menu you can select the desired table alignment with respect to your Web page.

BORDERS AND RULERS OPTION

In the Rulers and Border options menus, you can modify the appearance of the table's border.    The border must have a 
minimum value of 1 pixel.



INSERT AND DELETE CELLS

You can insert one or more new cells in your table if you wish.

To insert a cell :

· Select a cell ;

· In the Table menu, press on the Insert cells options.

 The new cell to be inserted can be placed to the left or on top of the selected cell.    If you activate the Shift cells right button, 
the new cell will be inserted to the left, while if you activate the Shift cells bottom button, the new cell will be inserted on top, 
thus creating a new row.

By selecting the Insert whole rows option, a new row will be created just below the selected cell.    If you activate the Insert 
whole columns button, a new column will be created to the right of the selected cell.. 

In the event that you would like to delete a cell from your table, you only have to select the cell that you want to delete in the 
create table window, and then press the Delete cells option in the Table menu. 

There are 4 options available to delete a cell :

Shift cells left : by selecting this option, the other cells in the row can be placed to the left of the cell being deleted, leaving a 
space at the end of the row.

Shift cells top : if you select this option, the other cells in the column will move above the deleted cell, leaving a space at the 
end of the column.

Delete whole rows : if you select this option, the program will delete the entire row.

Delete whole columns : if you select this option, the program will delete the entire column.



SPLIT CELLS

You can split a cell into the number of columns and rows that you want. 

To split a cell :

· Select the cell that you want to split ;

· In the Table menu, press the Split cells option ;

· Determine the number of columns and rows into which you want to divide the cell ;

· Press OK.

If you divide a cell, the program will add the COLSPAN attribute to the row's TD command.

Example:

<TR>
      <TD COLSPAN="2">&nbsp;</TD>
      <TD>&nbsp;</TD>
    </TR>
    <TR>
      <TD>&nbsp;</TD>
      <TD>&nbsp;</TD>
      <TD ROWSPAN="2">&nbsp;</TD>
    </TR>
    <TR>
      <TD>&nbsp;</TD>
      <TD>&nbsp;</TD>
    </TR>

COLSPAN="2" : means that the cell is divided into 2 columns.

ROWSPAN="2" : means that the cell is divided into 2 columns.



INSERT AND DELETE COLUMNS

You can insert one or more columns in your table if you wish.

To Insert a column :

· Select a column ;

· In the Table menu, press the Insert column option and a new column will be inserted to the right of the selected 
column.

You can also delete a column from your table if you no longer want it. 

to do this, select the column that you wish to delete in the Preview window, then press the Delete column option in the Table 
menu.    If you want to delete more than one column from the table at the same time, simply select the columns that you want 
with the mouse and press the Delete columns option. 



MERGE COLUMNS

You can merge two or more columns in your table into a single one. 

To merge the columns :

· Select the columns that you want to merge with the mouse.    The cells must be adjacent. 

· Once the columns have been selected, press on the Merge columns option in the Table menu.



INSERT AND DELETE ROWS

You can insert one or more rows in your tables if you wish.

To Insert a row :

· Place the cursor on the row ;

· In the Table menu, press the Insert rows option.    The new row will be inserted below the row where the cursor is 
placed.

You can also delete a row from your table if you no longer want it.    To do this, select the row that you want to delete in the 
Preview window, then press the Delete rows option in the Table  menu.

If you want to delete more than one row from the table at the same time, you simply have to select the rows that you want with 
the mouse and press the Delete rows option.



MERGE ROWS

You can merge two or more rows in your table into a single one.

To merge rows :

· Select the rows that you want to merge ; 

· Press the Merge rows option in the Table menu.

Notes : You cannot merge all the rows in the table.    If you select the table rows, you will note that the Merge rows option in the 
Table menu is deactivated.



QUICK TABLE

This command allows you to quickly insert a table.

To insert a quick table :

1. In the Tables, Frames, and Lists tab, click on the Insert a Quick Table button.

2. A grid composed of columns and rows will appear.

3. Use the mouse to select the number of columns and rows that you want in your table.

You can also re-edit your table in order to be able to modify the table if necessary by selecting the HTML code and pressing on 
the TABLE button.

Note : By clicking on the Quick tables command, the program will display a grid composed of 4 columns and four rows.    You can 
add the number of columns and rows to this grid during the selection if you keep the left mouse button pressed while you move the 
mouse towards the right or the bottom of the grid.



INSERT A QUICK TABLE icon    



FRAMES <FRAMESET>

Exemple Description of frame properties

Frames allow you to divide a page into several windows, each of them displaying a different HTML document.    The HTML 
document containing the frames does not include the BODY command nor any other HTML commands. If any are present they 
are simply ignored..

To insert frames in your document :

1. In the Table, Frames and Lists tab, click on the Insert Frames button.

2. Divide the window with the help of the Split Frame Vertically and Split Frame Horizontally buttons, these are located to the left 
of the window (you can also use the context menu by clicking on the mouse's right button).

3. You can divide a frame further, simply by repeating Step 2.

4. Repeat steps 2 and 3 until you have the desired number of frames.

5. You can change the size of the frames by dragging the dividing borders between frames.

6. You can erase any of the frames by selecting it and then clicking on the Delete Frame button (You can erase any of the 
frames by selecting it and then clicking on the Delete Frame button) ; you can also erase all the frames by clicking on the 
Delete FrameSet button.

7. To change the general properties of frames, click on the FrameSet Properties button. This will bring up the menu Additional 
Frame Properties.

8. Assign the properties and file sources for each frame by clicking on the Frame Properties button (you can also use the 
context menu by clicking on the mouse's right button). his will bring up the menu Frame Properties. 

9. Click on the OK button.

The program will insert the following tags in your document:

<FRAMESET...>
  <FRAME SRC="aFile1" NAME="aName1">
  <FRAME SRC="aFile2" NAME="aName2">
</FRAMESET>

® Create a single frame 
® Making the contents of a target link appear in a specific frame 

How to create a link to another frame

You must change your external links specifying in which frames you want them to appear.    This is called defining a target 
(TARGET).    Thus, if you want the HTML target of the link (called home.html in the example) to appear in the frame to the right 
(called b in the example), the following HTML code is obtained:

<A HREF="home.html" TARGET="b">Home</A>

How to create a link to exit frames:

If you have a window with many frames and you want that by pressing an external link the document being called appears in a 



window without frames, you must add the TARGET="_top" attribute to your external link.

JavaScript button :

You can add a JavaScript event handler to the FRAMSET command.    The event handler executes a function written in 
JavaScript. When you click on this button you are asked to indicate the name of the function that will be executed.    You also 
have to select the type of possible events that must take place with the FRAMESET command. 

Show HTML Frame Preview

If this option is checked, the program will allow you to view the contents of the frames directly in their respective frames in the 
Insert frames window. 

You can also copy the contents of one frame to another one already defined during the insertion of frames by using a contextual 
menu.    To do this, once you have selected a frame, click the right button on the mouse so that the contextual menu appears.    
Select the Copy option, then select the frame where you want to copy the contents.    Press the right mouse button and select 
the Paste option.    This will not only copy the contents but will also change the FRAME NAME=" " and SRC=" " attributes.



FRAME icon 



FRAME PROPERTIES icon 



ADDITIONAL FRAME PROPERTIES icon 



SPLIT FRAME VERTICALLY icon 



SPLIT FRAME HORIZONTALLY icon 



DELETE FRAME icon 



DELETE FRAMESET    icon 



EXAMPLE: FRAME

In this example, there are two columns where the first one is the smaller one and the second one is the larger one.    In the first 
column, there is a single row, while the in the second column there are two rows.    In the    NOFRAME section you can also write 
the contents of your document. 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 TRANSITIONAL//EN">
<!-- CREATION DATE: 09-12-98 -->
<HTML>
<HEAD>
<TITLE></TITLE>
<META NAME="Description" CONTENT="">
<META NAME="Keywords" CONTENT="">
<META NAME="Author" CONTENT="Visicom">
<META NAME="Generator" CONTENT="AceExpert">
</HEAD>
<FRAMESET COLS="33%,*">
  <FRAME SRC="Test1.html" NAME="test1">
  <FRAMESET ROWS="33%,*">

 <FRAME SRC="Test2.html" NAME="test2" SCROLLING="no">
 <FRAME SRC="Test3.html" NAME="test3" SCROLLING="yes">

  </FRAMESET>
<NOFRAMES>
<BODY>

Contents of your document for users browsing without frames.

</BODY>
</NOFRAMES>
</FRAMESET>
</HTML>

</BODY>
</HTML>



FRAME PROPERTIES

This window contains two tabs:: GENERAL and OTHER PROPERTIES.

The GENERAL tab:

With the menu on this tab you can assign properties and indicate the HTML source file for the frame

SOURCE FILE

In the Source file text box, write the path and the name of the reference HTML file for the selected frame.    You can also 
find it by pressing the OPEN button.

FRAME NAME

In the Frame name text box, you must give a name to your frame.    This option will add the NAME attribute to the 
<FRAME SRC="..."> command.    The NAME attribute is useful when you use the TARGET attribute in a hypertext link.    
If you want a hypertext link to reference a particular frame, you must add the TARGET="FrameName" attribute to your 
hypertext link.    This attribute is also useful when you work with JavaScripts.

ALWAYS SUGGEST A NAME TO THE FRAME

If this option is checked, the program will suggest a name for the frame.    The suggested name corresponds to the name 
of the HTML file which you have referenced as the source document without the .html extension.

Example: 

Lets assume that you have specified link.html in the Source file text box as the name of the file to be referenced for the 
selected frame; the name suggested by the program will simply be link.

SCROLLING

You can also include or forbid scrollbars in your frame.    The automatic option will display the bars if the content of the 
frame is wider or longer than the space provided.    This option is activated by default.    By selecting the Yes option, the 
scrollbars will be added to the frame.    This option will add the SCROLLING="YES" attribute to the <FRAME> command. 
By selecting the No option, the scrollbars will be forbidden even if the content of the frame is wider or longer than the 
space provided.    This option will add the    SCROLLING="NO" attribute to the <FRAME> command.

MARGINS

In the Margins menu you can modify the height and the width of the document which appears inside the frame.    To do 
this, you must enter the values in pixels in the corresponding boxes.    The smallest accepted value is 1 pixel.    This 
option will add the MARGINHEIGHT and MARGINWIDTH attributes to the <FRAME> command.

NO RESIZE

If you check the No resize box, the frame cannot be resized by the user.    This option will add the NORESIZE attribute 
to the <FRAME> command.    NORESIZE is optional, and all frames can be resized by default.

The OTHER PROPERTIES tab:

BORDER COLOR

The Netscape 3.0 browser allows you to add a color to the borders of the frame.    To add a color to the border of a 
frame, you only have to select the desired color by pressing the Color button. The default color is gray.    This option will 
add the BORDERCOLOR attribute to the <FRAME> command.

FRAME SIZE IN PIXELS

This option allows you to indicate the exact height and width of a frame in pixels.

BORDER AROUND THE FRAME

This option determines whether your frame will have a border around it or not.    If you leave the check mark in the box, 
there will be a border around the frame.    If you remove the check mark, there won't be a border around the frame and 
the FRAMEBORDER=²NO² attribute will be added to the <FRAME> command.



ADDITIONAL FRAME PROPERTIES

The GENERAL tab:

 SPACE BETWEEN FRAMES

These two options allow you adjust the width of the borders around the frames.    However, the Microsoft Internet 
Explorer and Netscape browsers do not use the same attributes.    The Microsoft Internet Explorer browser adds the 
FRAMESPACING attribute to the <FRAMESET> command, while the Netscape browser adds the BORDER attribute to 
the same command.    Both attributes have exactly the same effect.    The values are expressed in pixels.

BORDER COLOR

The Netscape 3.0 browser allows you to add a color to the frame's borders.    To add a color to the border of the frames, 

you only have to select the desired color by pressing the color button .    The default color is gray.    This option adds 
the BORDERCOLOR attribute to the <FRAMESET> command.

BORDER AROUND THE FRAMES

This option allows you to decide whether your frames will have a border or not.    If you leave the check mark inside the 
box, there will be a border around the frame.    If you remove the check mark from the box, there won't be a border and 
the FRAMEBORDER="0" attribute will be added to the <FRAMESET> command.



DESCRIPTION OF FRAME PROPERTIES

Property name Description HTML tags

General Frame Properties

Source file document that will appear inside the frame SRC="Filename.html"

Frame name name that identifies frame NAME="frame name"

Scrolling · automatic:    the browser will display scroll bars if 

necessary

· yes:    scroll bars are displayed

· no: no scroll bars are displayed

The default is "automatic"

SCROLLING="Yes|No"

Margins indicates in pixels the margin from top and left sides of the 

selected frame

MARGINWIDTH=number

MARGINHEIGHT=number

No resize if the box has a check mark, the user cannot resize the 

frame using his browser

allows resizing by default

NORESIZE (no resizing possible)

Additional Frame Properties

Color options indicates the color of the frame's border (with Netscape 

only)

BORDERCOLOR="# hexadecimal code "

Frame size in pixels indicates a fixed frame's height and width in pixels COLS="no. of    pixels|%, no. of pixels|%"

ROWS="no. of    pixels|%, no. of    pixels|%"

Frame border
indicates whether the frame has a border around it or not FRAMEBORDER="Yes|No"

FrameSet Properties

Space between frames indicates the space in pixels between frames FRAMESPACING=number (Netscape)

BORDER=number (Explorer)

Color options indicates the color of the border (Netscape only) BORDERCOLOR="# hexadecimal code "

Frame border
indicates whether frames have a border around them or not FRAMEBORDER="Yes|No"

Properties of a Single Frame (Explorer only)

Alignment indicates the alignment of a single frame ALIGN="top|bottom|left|right|middle"

Vertical space vertical spacing between frames and surrounding text VSPACE=number

Horizontal space horizontal spacing between frames and surrounding text HSPACE=number



# $ K + INSERT A SINGLE FRAME <IFRAME>

Single frames can only be used with Microsoft Internet Explorer.    Follow the steps below to create a single frame:

1. Click on the Tables, frames, and lists tab and then on the Insert frames button;

2. Indicate the properties and source file for the frame by clicking on the Frame properties button (you can also use the 

context menu by clicking on the mouse's right button); 

3. Indicate the source HTML file in the box called Source file, select the source file with the help of the File icon to the right;

4. Enter the identifier name for the frame;

5. Specify scrolling : automatic, yes or no;

6. Indicate the top and left margins inside the frame.

You can indicate additional frame properties by doing the following:

1. Click on the Other properties tab.

2. Specify the frame alignment.

3. Indicate a fixed size for the frame by entering the height and width in pixels or entering the size as a percentage.

4. Check the Frame border box to specify if the frame has a border or not..



# $ MAKING THE CONTENTS OF A TARGET LINK APPEAR IN A SPECIFIC 
FRAME

When you create an external link, you can specify the specific frame where the destination HTML document must appear.    
When you create the link (refer to the External link section if necessary) you can specify a target in the External Link dialog box 
in the following manner:

1. Click on the Target frame tab on the External link window;

2. In the Target or frame name text box, insert the name that identifies the target frame.    If necessary check the frame 

names – with the help of the NAME attribute – in the HTML document containing the frame code;

3. If you wish, you can specify a predefined target instead of a frame name.    In order for a linked HTML document to appear 

in a window without frames, choose the    _top target.



ORDERED LIST  <OL>
See also

The OL command is used to create a an ordered list in which the numbering increases automatically. 

With AceExpert it is also possible to modify an already existing list.    To do so, select the list code and then press the Ordered List 
icon.

To insert an ordered list in your document:

1. Place the cursor in the desired position to insert the list.

2. In the Tables, Frames ad Lists toolbar, click on the    Ordered List icon.

3. In the menu Type of    List    select the type of list.

4. Indicate the number of items in the list in the Items box. You will see in the window below    List content the same 
number of fields as you indicated in the Items box so that you can enter each item.

5. In an ordered list as this one, you can indicate in the box Start at the starting number for your list, that is, if you indicate 
3 as the starting number, the list will start with the number 3, the letter c or the Roman number iii, depending on the type 
of list you selected.

6. Now you can type directly in the window List content, the contents for each item of your list.

7. Click on the OK button.

The program will add the lines of code corresponding to the type of list you selected:

Example #1:

Number of items:1

Start at: 1

Type of list: 1,2,3… 

<OL>
  <LI>
</OL>

Example #2:

Number of items: 3

Start at:: 5

Type of list: a,b,c… 

<OL TYPE=a START=5>
  <LI>
  <LI>
  <LI>
</OL>



ORDERED LIST icon 



See also
Unordered list

Definition List



UNORDERED LIST  <UL>
See also

The UL command inserts an unordered list with bulleted items.

With AceExpert it is also possible to modify an already existing list.    To do so, select the list code and then press the Unordered 
List icon.

To insert an unordered list (bulleted list) in your document:

1. Place the cursor in the desired position to insert the list.

2. In the Tables, Frames ad Lists toolbar, click on the    Unordered List icon. 

3. In the menu Type of    List    select the type of list.

4. Indicate the number of items in the list in the Items box.    You will see in the window below    List content the same 
number of fields as you indicated in the Items box so that you can enter each item. 

5. Now you can type directly in the window List content, the contents for each item of your list.

6. Click on the OK button.

The option Compact form compresses the space occupied by the list.    If you checkmark this box, the attribute COMPACT is 

inserted in the <UL> command.    This option is only possible with Netscape .

Example:

<UL COMPACT>
  …
</UL>

Following are some examples of using the Unordered List command:

Example #1:

Type or list: 

Number of items: 3

<UL>
  <LI>
  <LI>
  <LI>
</UL>

Example #2:

Type of list: 

Number of items: 2

<UL TYPE=SQUARE>
  <LI>
  <LI>
</UL>



UNORDERED LIST icon 



See also
Ordered List

Definition List



DEFINITION LIST <DL>
See also

With the DL command you can have a list of terms with its definitions, that is, a list where each term is followed by a definition. 

With AceExpert it is also possible to modify an already existing list.    To do so, select the list code and then press the Definition List 
icon.

To insert a definition list in your document:

1. Place the cursor in the desired position to insert the list.

2. In the Tables, Frames ad Lists toolbar, click on the    Definition List icon.

3. Indicate the number of items in the list in the Items box.    You will see in the window below    List content the same 
number of fields as you indicated in the Items box so that you can enter each item.

4. Now you can type directly in the window List content, the contents for each item of your list.    On the right side field you 
type the name of the term, and on the left, the definition of the term.

5. Click on the OK button.

The option Compact form compressed the space occupied by the list.    If you checkmark this box, the attribute COMPACT is 
inserted in the <UL> command..

Example:

<DL COMPACT>
  …
</DL>

In the code that is added to your document, DT represents the term, and DD represents the definition of the term. 

Example:

<DL>
<DT>Term #1
<DD>Definition of term #1...
<DT>Term #2
<DD>Definition of term #2...
<DT>Term #3
<DD>Definition of term #3...

</DL>

Result:

Heading of list

Term #1 

          Definition of term #1... 

Term #2 

          Definition of term #2... 

Term #3

          Definition of term #3... 



DEFINITION LIST icon    
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FORM DEFINITION <FORM>
See also

The FORM command allows the user to send information to a server.    It’s a graphic interface and uses push buttons, text boxes, 
list boxes, etc.    Inside the tags    <FORM> and </FORM> you can use the following commands: INPUT, SELECT or TEXTAREA.

To insert a form in your document:

1. In the Forms toolbar, click on the form icon.

2. Select the method of submitting the form to the http server.    There are two methods, GET and POST.    The GET 
method directs information to go through a variable QUERY_STRING to interpret the data.    This method must be used 
when the purpose of the query is to obtain information from the server.    On the other hand, the POST method is used to 
add or change information on the server.    This last method submits complete messages to the server.

3. In the window Type of protocol indicate a URL address.    Select the desired address type from the following options:

HTTP link: link to an http address

FTP link: link to an FTP address

Email address: link to an e-mail address

Newsgroup: link to a newsgroup

This address will be the recipient of the information entered in the form.    If the ACTION field is not entered, 
then the URL used will be that of the active document. 

4. In the text box Action, type the name of the virtual address of the site.    The arrow to the right of the text box indicates 
the last URL addresses you have entered.

5. Under the Target frame tab. indicate the name of the target if the data in the form makes reference to a particular 
location in the file.    Under the JavaScript tab, you can assign a name to your form so that you can identify it later in a 
JavaScript reference.

6. Click on the OK button.

The program inserts the following command in your document:

<FORM ACTION="URL"  METHOD="POST or GET">
 …
</FORM>

Type of URL address:

http: Hypertext Transfer Protocol

ftp: File Transfer Protocol

file: Local files (in your system)

newsrc Newsgroup

nntp: Net News Transfer Protocol

gopher: Gopher Protocol

mailto: mail address

news: Usenet news

telnet: Telnet Protocol

wais: Wide Area Information Server Protocol



Target frame tab:

The Target frame option allows you to specify the Frame where the information will be sent with the submit button.

This option inserts the attribute TARGET in the <FORM> command.

Example:

<FORM ACTION="URL" METHOD=POST or GET TARGET="target"> 
  …
</FORM>

Please note that the attribute TARGET is case sensitive with respect to the target name.

JavaScript tab:

In the text box Form identifier name, you can enter a name for your form so that you can refer to it later when you use 
JavaScript.

JavaScript button :

You can add a JavaScript event handler to the FORM command.    The event handler executes a function written in JavaScript.

When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the FORM command. 
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CHECKBOX <INPUT TYPE="CHECKBOX">
See also

This command inserts checkmark boxes in a form sheet.

To insert a checkbox in your document:

1. In the Forms toolbar, click on the Checkbox icon.

2. In the text box Identifier name, enter a name.    This name identifies the checkmark    boxes.

3. If you don't want to have a new line inserted after every checkmark box, remove the checkmark from the box Insert a 
carriage return after every value". 

4. In the text box    Element value(s), type the description for the first checkmark box and then press on the Add button.    
In the preview window below the menu, you can view the checkboxes you are adding.    You can keep inserting different 
checkmark boxes by inserting them with the Add button.

5. If you want one of the checkmark boxes to have a default checkmark, then you must insert a checkmark in the box 
Checked by default    or simply insert a checkmark in the appropriate box in the preview window. 

6. You can modify a checkmark box by selecting it in the preview window and clicking on the Edit button. 

7. You can also erase a checkmark box by selecting it in the preview window and clicking on the Erase button.. 

8. If you want to move a checkmark box up or down, select it and then use the arrows on the right side of the preview 
window to move it in any direction.

9. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE="CHECKBOX" NAME="Name" VALUE="Value" CHECKED="Value">

The CHECKED attribute indicates that the referred checkmark box will be checkmarked.    The CHECKED attribute can be 
inserted in one checkmark box or several checkmark boxes.

If you have not previously specified the type of form in which you want to insert the checkmark boxes,    the program will ask you if 
you want to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the INPUT command..    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the INPUT command. 



CHECKBOX icon    
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RADIO BUTTON  <INPUT TYPE="radio">
See also

Inserts radio buttons in a form sheet.

To insert a radio button in your document:

1. In the Forms toolbar, click on the Radio button icon.

2. In the text box Identifier name, enter a name. This name identifies the radio buttons. 

3. If you don't want to have a new line inserted after every radio button, remove the checkmark from the box Insert a 
carriage return after every value.

4. In the text box    Element value(s), type the description for the first radio button and then press on the Add button.    In 
the preview window below the menu, you can view the radio buttons you are adding.    You can keep inserting different 
radio buttons by inserting them with the Add button.

5. If you want one of the radio buttons to have a default checkmark, then you must insert a checkmark in the box Checked 
by default    or simply insert a checkmark in the    appropriate box in the preview window.

6. You can modify a radio button by selecting it in the preview window and clicking on the Edit button. 

7. You can also erase a radio button by selecting it in the preview window and clicking on the Erase button.

8. If you want to move a radio button    up or down, select it and then use the arrows on the right side of the preview 
window to move it in any direction.

9. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE="RADIO" NAME="Name" VALUE="Value" CHECKED>

The CHECKED attribute indicates that the referred radio button    will be checkmarked.    The CHECKED attribute can be inserted 
only in one radio button. 

If you have not previously specified the type of form in which you want to insert the radio buttons, the program will ask you if you 
want to insert the    form    command in your document.

JavaScript button :

You can add a JavaScript event handler to the INPUT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the INPUT command. 
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LIST BOX  <SELECT>
See also

This command allows creating a list of available items in a menu.

To insert a list box in your document:

1. In the Forms toolbar, click on the List box icon.

2. In the text box Identifier name, type a name.      This name identifies the list box. 

3. In the Lines displayed box you can specify the number of items that will be displayed in the box.

4. In the text box    Element value(s), type the value for the first item and then press on the Add button.    In the preview 
window below the menu, you can view the items you are adding.    You can keep inserting different values by inserting 
them with the Add button.    However, you can only add as many items as those indicated in the Lines displayed box.

5. You can modify an item by selecting it in the preview window and clicking on the Edit button. 

6. You can also erase an item by selecting it in the preview window and clicking on the Erase button. 

7. If you want to move an item up or down, select it and then use the arrows on the right side of the preview window to 
move it in any direction.

8. If you want the user to be able to select several items in the menu, insert a checkmark in the Multiple selection 
checkbox.

9. Click on the OK button.

The program inserts the following command in your document:

<SELECT NAME="Name" VALUE="Value" SIZE=Value MULTIPLE>
  <OPTION> option #1
  <OPTION> option #2
  <OPTION> option #3
</SELECT>

If you have not previously specified the type of form in which you want to insert your list box, the program will ask you if you want 
to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the SELECT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the SELECT command.
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COMBOBOX  <SELECT>
See also

Used to present the list of possible choices as a drop-down list box.    Drop-down list boxes are used to allow the user to choose 
only one item from the menu (list).

To insert a comboBox in your document:

1. In the Forms toolbar, click on the ComboBox icon.

2. In the text box Identifier name, enter a name.    This name identifies the ComboBox. 

3. In the text box    Element value(s), type the description for the first option in the ComboBox and then press on the Add 
button.    In the preview window below the menu, you can view the comboBox.    You can keep inserting different options 
by inserting them with the Add button.

4. To modify an option, you must insert a checkmark in the checkbox Display as a list,    select the option you want to 
modify    and then press the Edit button . 

5. To erase an option, you must insert a checkmark in the checkbox Display as a list, select the option and then press the 
button Erase. 

6. If you want to move an option up or down, select it and then use the arrows on the right side of the preview window to 
move it in any direction.

7. Click on the OK button.

The program inserts the following command in your document:

<SELECT NAME="Name">
  <OPTION> option #1
  <OPTION> option #2
  <OPTION> option #3
</SELECT>

If you have not previously specified the type of form in which you want to insert the comboBox, the program will ask you if you 
want to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the SELECT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the SELECT command. 
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TEXT BOX  <INPUT TYPE="TEXT">
See also

This command allows the user to enter a line of text in a form dialog box.

To insert a text box in your document:

1. In the Forms toolbar, click on the Text icon.

2. In the text box Identifier name, insert a name.    This name identifies the text box. 

3. In the Properties menu, you can modify the size of the text box and modify the size of the text box by inserting a 
number in the Maximum length displayed box. 

You can also limit the size of the text that will be submitted with the form by inserting a number in the Maximum 
authorized length box. 

4. In the Element value(s) box you can enter a message that will be displayed in the text box and acts as a default value.

5. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE="Text" NAME="Name" SIZE=40 MAXLENGTH=30>

If you have not previously specified the type of form in which you want to insert your text box, the program will ask you if you want 
to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the INPUT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the INPUT command. 
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PASSWORD <INPUT TYPE="PASSWORD">
See also

This command allows entering a password in a line of text and the characters will be hidden and displayed as asterisks.

To insert a password box in your document:

1. In the Forms toolbar, click on the Password icon.

2. In the menu Properties insert a name in the Name box.    This name identifies the password box . 

3. In the same menu you can specify the size of the password box    by indicating a value in the    maximum length 
displayed box. 

You can also limit the size of text submitted with the form by indicating a value in the maximum authorized length box.

4. In the Element value box you can enter a message that will appear in the password box and will act as the default 
value.

5. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE="PASSWORD" NAME=a Name SIZE=Value VALUE=Value>

If you have not previously specified the type of form in which you want to insert your password box, the program will ask you if you 
want to insert the form command in your document.
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TEXT AREA  BOX  <TEXTAREA>
See also

With this command you can create a rectangular area for the user to enter text.

To insert a rectangular area for entering text in your document:

1. In the Forms toolbar, click on the TextArea icon.

2. In the text box Identifier name, insert a name.    This name identifies the text area box.

3. In the same menu you can modify the size of the box, by entering values in the column and row boxes. 

4. In the menu Line cut off there are three options:    Deactivated that turns word wrapping off, Virtual    that displays 
scroll bars only in case the text is too long to show in the window, and Physical which automatically displays scroll bars. 

5. In the Preview window you can enter a message that will appear in the text area box and will act as the default value.

6. Click on the OK button.

The program inserts the following command in your document:

<TEXTAREA NAME="Name" ROWS=Value COLS=Value>
  …
</TEXTAREA>

If you have not previously specified the type of form in which you want to insert your text area box, the program will ask you if you 
want to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the TEXTAREA command.    The event handler executes a function written in 
JavaScript. When you click on this button you are asked to indicate the name of the function that will be executed.    You also have 
to select the type of possible events that must take place with the TEXTAREA command. 
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FORM BUTTON  <INPUT TYPE="button">
See also

Inserts a simple push button that is used with JavaScript.

To insert a button in your document:

1. In the Forms toolbar, click on the Button icon.

2. In the text box Text displayed on the button,    you can type the text that    will appear on the button.

You can view the button in the Preview window.

3. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE="button" VALUE="text">

If you have not previously specified the type of form in which you want to insert your button, the program will ask you if you want to 
insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the INPUT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the INPUT command. 
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SUBMIT BUTTON <INPUT TYPE="SUBMIT">
See also

This button allows submitting information on a form.    The VALUE attribute assigns a name to the button.

To insert a submit button:

1. In the Forms toolbar, click on the Submit Button icon.

2. In the text box Text displayed on the button,    you can type the text that    will appear on the submit button. 

You can view the button in the Preview window.

3. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE=SUBMIT>

The value Submit Form will appear on the button

Or

<INPUT TYPE=SUBMIT VALUE=Name >

The Name    value will appear on the button.

If you have not previously specified the type of form in which you want to insert your submit button, the program will ask you if you 
want to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the INPUT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the INPUT command. 
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RESET BUTTON  <INPUT TYPE="RESET">
See also

This button allows the user to reset the form's fields to their initial values. 

To insert a reset button in your document:

1. In the Forms toolbar, click on the Reset Button icon.

2. In the text box Text displayed on the button,    you can type the text that    will appear on the button. 

You can view the button in the Preview window.

3. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE=RESET>
The value Reset will appear on the button

Or

<INPUT TYPE=RESET VALUE=Start Again>
The value "Start Again» will appear on the button.

If you have not previously specified the type of form in which you want to insert your reset button, the program will ask you if you 
want to insert the form command in your document.

JavaScript button :

You can add a JavaScript event handler to the INPUT command.    The event handler executes a function written in JavaScript. 
When you click on this button you are asked to indicate the name of the function that will be executed.    You also have to select 
the type of possible events that must take place with the INPUT command. 
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HIDDEN ENTRY <INPUT TYPE="HIDDEN">
See also

A hidden entry contains a value sent with the submitted form that is not displayed to the user.

To insert a hidden entry in your document:

1. In the Forms toolbar, click on the Hidden entry icon.

2. In the text box Name, insert a name.    This name identifies the hidden entry.

3. In the text box Value,    insert a value that represents the hidden entry.

4. Click on the OK button.

The program inserts the following command in your document:

<INPUT TYPE=HIDDEN NAME="Name" VALUE="Value">

If you have not previously specified the type of form in which you want to insert your hidden entry, the program will ask you if you 
want to insert the form command in your document.
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FORM IMAGE <INPUT TYPE="IMAGE»>
See also

The Form Image command allows submitting the form contents in exactly the same way as the Submit button.    When the user 
presses the image, the form is submitted.

To insert a Form Image  in your document:

1. In the Forms toolbar, click on the Form Image icon.

2. Proceed the same way as when inserting    an Image.

The program inserts the following command in your document:

<INPUT TYPE=IMAGE SRC="URL of the image">

If you have not previously specified the type of form in which you want to insert your Form Image, the program will ask you if you 
want to insert the form command in your document.
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DOCUMENT META PROPERTIES

With this menu you can add a title and a description to your document and also indicate the author.    The title is the text that 
appears in the    title bar of the browser. The description is useful to identify the document with search engines.    By default with 
AceExpert the name of the author is the registration name.    All these commands are optional.

To specify or modify the document meta properties of your document:

1. In the Specialized toolbar, click on the Document meta Properties icon.

2. In the text box Title,    insert a title for the document

3. In the text box Description,    type a description of the document.

4. In the text box Author, indicate the author of the document.

5. Click on the OK button.

The program will insert in the header section of your document the following lines of code:

<TITLE> Title </TITLE>
<META NAME="Description" CONTENT=" A description of the document ">
<META NAME="Keywords" CONTENT="">
<META NAME="Author" CONTENT="Registration name">
<META NAME="Generator" CONTENT="AceExpert">
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DOCUMENT HEADER PROPERTIES

When you click on this command, the Document Header Properties window opens.    This window contains 3 tabs:    Meta, 
Relation Link and Base.

The META command provides information in the Header about your HTML document    that will be read by the http server.    This 
information could serve to identify a name, the name of the author, the content and an HTTP-EQUIV instruction.    The META    tags 
are inserted    in the document's    Header section.

To insert the META command in your document:

1. Click on the tab Meta.

2. In the text box Meta Information, enter or select the Meta information that you want to include in the header.

3. In the text bot Contents    enter the content of the Meta Information.

4. Click on the Add button in case you want to insert other Meta information and repeat steps 2 and 3.

5. Click on the OK button.

The program inserts the following command in your document:

Example : 

<META NAME="Author" CONTENT="Visicom Media">

RELATION LINK

The link command creates a relation with another object.    LINK may have two attributes:    REL specifies the relation between the 
document and the link while REV species an inverse relation.    LINK is entered in the header <HEAD> section of the document.

To insert a RELATION LINK in your document:

1. Click on the tab Relation Link.

2. In the text box Link, enter the name of the HTML file that will serve as a link.

3. In the text box Relation, enter the type of relation.

4. In the text box Inverse Relation, indicate the type of inverse relation.

5. In the checkbox Indicate an external style sheet,  enter a checkmark if you want the file to reference an external style 
sheet.

6. Click on the OK button.

The program inserts the following code in your document:

<LINK REL="stylesheet" TYPE="text/css" HREF="StyleSheet1.css">

BASE

The BASE command allows registering the current URL address.    In this way, when a document is read out of context and the 
reader wants to refer to the original, the document is searched at the address: relative base address. The BASE command can 
have the attribute HREF that identifies the URL.    The BASE command is inserted in the Header section of the document.



To insert the BASE command in your document:

1. Click on the tab Base.

2. In the text box URL, enter the base address.

3. In the text box Target (frame name), you can indicate a target found in your document or the name of a frame.

4. Click on the OK button.

The program inserts the following command in your document:

<BASE HREF="http://www.visic.com">
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ACTIVE X <OBJECT>

With this command you can insert objects in an HTML document.    These objects may be ActiveX controls or other types of media, 
such as an image, a video sequence or a Java application.

To insert an ActiveX control in your document:

1. In the Extensions tab, click on the ActiveX icon.

2. Indicate the ID class in the ID text box.

3. Indicate as necessary the remaining properties.    For further information, refer to the Description of fields of the    Active 
X command.

4. Click on the Parameters tab and insert them accordingly.

5. Click on the OK button.

Example :

<OBJECT 
       CLASSID="clsid:99B42120-6EC7-11CF-A6C7-00AA00A47DD2"
       WIDTH=100 
       HEIGHT=50> ...

</OBJECT>

To add a parameter:

1. Indicate the parameter name in the Name text box.

2. Indicate a value in the Value text box.

3. Click on the Add button.

To modify an existing parameter:

1. Select the parameter from the list.

2. Click on the Edit button.

3. Indicate a new value in the text box.

4. Click on the OK button.

To delete a parameter:

1. Select the parameter you want to delete from the list.

2. Click on the Erase button or press the Delete key.



To modify HTML code of an existing ActiveX control:

1. Select the HTML code of the application in the document, located between the tags <OBJECT…> and </OBJECT>.

2. Select the Extensions tab.

3. Click on the ActiveX icon.

4. Modify the attributes and/or the control parameters.

5. Click on the OK button.
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# $ DESCRIPTION OF FIELDS OF THE ACTIVEX COMMAND

FIELD DESCRIPTION

CodeBase (URL) Access path to the object, if not located in the same directory as the HTML document.

Code type Media type for code

Media type MIME type for the corresponding script programs

Class ID Identification of the object class

Standby Standby message while the object is loaded

Alignment Sets alignment for text surrounding the object

Name Sets a name for the object to be able to reference it from JavaScript or VBScript code.

Data Access path to object's data

Width Width of space occupied by the ActiveX object

Height Height of space occupied by the ActiveX object

Horizontal space Distance in pixels of the horizontal spacing (right and left) between the object and the 

surrounding text

Vertical space Distance in pixels of the vertical spacing (top and bottom) between the object and the 

surrounding text 

Border Width of the object border

Tab index Sets the position of the object in the tabbing order.

No tab Excludes the object from the tabbing order.

Declare object Indicates if the object is used as a parameter in another control.



MARQUEE <MARQUEE …>

With this command you can make text scroll from left to right or right to left in a scroll box.

To insert a marquee in your document:

1. Select the text in your document    that you want inserted in the scroll box.

2. In the Extensions toolbar, click on the Marquee icon.

3. Click on the OK button.

The program inserts the following command in your document:

<MARQUEE> text </MARQUEE>

You can add attributes to the command MARQUEE in order to customize it.

To specify the scroll speed of text inside the scroll box:

In the Scrolling menu, you can specify the scrolling speed of text.    There are two ways to indicate the speed.

By specifying a value between 1 and a 100 in the box Scroll amount, you can indicate the scrolling speed in pixels of the text on 
the box.

This option inserts the attribute SCROLLAMOUNT in the MARQUEE command.

Example:

<MARQUEE SCROLLAMOUNT=Value> text </MARQUEE>

By specifying a value between 1 and a 100 in the box Scroll delay, you determine the delay in thousands of seconds of the text 
scrolling in the box.

This option inserts the attribute SCROLLDELAY in the MARQUEE command.

Example:

<MARQUEE SCROLLDELAY=Value> text </MARQUEE>

To specify the text color and background color of the scroll box:

In the menu Color Options you can specify the color of the text displayed in the scroll box.    To do so, click on the Text color    
button and choose a color.    The chosen color will appear on the Color button.    You can view the result in the Preview window.

This option inserts the <FONT COLOR> command in your document.

Example:

<FONT COLOR="#Color"><MARQUEE BGCOLOR="#80FF00"> text </MARQUEE></FONT>

In the menu Color Options you can specify the background color of the scroll box.    To do so, click on the Background color    
button and choose a color.    The chosen color will appear on the Color button.    You can view the result in the Preview window.

This option inserts the attribute BGCOLOR in the MARQUEE command.



Example:

<MARQUEE BGCOLOR="#Color"> text </MARQUEE> 

The Properties menu:

Loop

You can specify the number of times that text scrolls in the box by indicating a number in the Loop box.

This option inserts the attribute LOOP in the MARQUEE command.

Example:

<MARQUEE LOOP=Value> text </MARQUEE>
If LOOP="INFINITE", then text scrolls on the box as long as the page is open.

WIDTH

You can specify the width of the scroll box by indicating a number in the Width box.    This value can be entered in pixels or as a 
percentage.    If the value is a percentage you have to place a checkmark in the "%" box.    If this box is empty, then the value is 
interpreted in pixels.    The default value is a percentage.

This option inserts the attribute WIDTH in the MARQUEE command.

Example:

<MARQUEE WIDTH=Value> text </MARQUEE>

HEIGHT

You can specify the height of the scroll box by indicating a number in the Height box.    This value can be entered in pixels or as a 
percentage.    If the value is a percentage you have to place a checkmark in the "%" box.    If this box is empty, then the value is 
interpreted in pixels.    The default value is a percentage.

This option inserts the attribute HEIGHT in the MARQUEE command.

Example:

<MARQUEE HEIGHT=Value> text </MARQUEE>

VERTICAL SPACE

You can specify margins on the top and bottom of the scroll box by entering a value in the Vertical space box.    The value must 
be entered in pixels.

This option inserts the attribute VSPACE in the MARQUEE command.

Example:

<MARQUEE VSPACE=Value> text </MARQUEE>

HORIZONTAL SPACE

You can specify margins on the left and right of the scroll box by entering a value in the Horizontal space box.    The value must 
be entered in pixels.

This option inserts the attribute HSPACE in the MARQUEE command.

Example:

<MARQUEE HSPACE=Value> text </MARQUEE>

To indicate the behavior of the scroll box:



In the menu Behavior you can indicate the way the text will scroll.    The default behavior is Scroll, that is, text scrolls from right to 
left.    If you select the Slide option, text will scroll the length of the scroll box and stop when it touches the right margin.    If you 
select the Alternate option, text will scroll the length of the scroll box until the text touches one of the margins, and then scrolls in 
the opposite direction.

This option inserts the attribute BEHAVIOR in the MARQUEE command.

Example:

<MARQUEE BEHAVIOR="scrolling method"> text </MARQUEE>
BEHAVIOR takes one of the following three values: SCROLL, SLIDE or ALTERNATE.

To specify the direction    text scrolls inside the box:

In the menu Direction you can specify in which direction text scrolls by selecting one of two options: right or left.

This option inserts the attribute DIRECTION in the MARQUEE command.

Example:

<MARQUEE DIRECTION=" LEFT or RIGHT "> text </MARQUEE>

To specify text alignment inside the scroll box:

In the menu Alignment, you can specify the alignment of text in the scroll box by choosing from five options: To the left, To the 
right, At the top, At the bottom, and To the center.

This option inserts the attribute ALIGN in the MARQUEE command.

Example:

<MARQUEE ALIGN=" TOP, BOTTOM or MIDDLE "> text </MARQUEE>
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BACKGROUND SOUND  <BGSOUND …>

This commands allows playing music or sounds in the background.

To insert a background sound in your document:

1. In the Extensions toolbar, click on the Background Sound icon.

2. In the text box Source, indicate the access path and the name of the file to play.    You can also search for the file by 
pressing the Open. icon.    The file must be in    WAV, AU or MID format.

3. Indicate the number of times the file will be played by indicating a value in the Loop    box.    The default value is 1.    If 
you indicate a value of    -1, the file will play repeatedly as long as the page is open.

4. Click on the OK button.

The program inserts the following command in your document:

<BGSOUND SRC="Filename" LOOP=Value>

You can test the sound file by pressing the Test button.

The Stop button interrupts playing the sound file.
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SINGLE FRAME      <IFRAME>

With this command you can enter a single frame in your document.    The single frame makes reference to another HTML 
document which can be viewed inside the frame.    The IFRAME command must be inserted in the body section of the document., 
that is between the <BODY> and </BODY> tags.    The IFRAME can only be displayed with Microsoft Internet Explorer.

To insert a single frame in your document:

1. Place the cursor in the desired position in your document. 

2. In the tab Tables, frames and lists, click on the button Insert Frames

3. In the text box File name, enter the path and name of the referred HTML document.    You can also press the button 
Open to search for the file.

5. In the text box Frame name, enter a name that identifies the frame.

6. Click on the OK button.

The program inserts the following command in your document:

<IFRAME NAME="FrameName" SRC="Filename"></IFRAME>

The following are different options found in the Single Frame command:

SCROLLING

You can add choose to place or not place scroll bars on your frame.    Normally scroll bars are added automatically if the 
frame’s contents are longer than the space provided.    This is the default value.    If you select Yes, scroll bars are 
always placed in the frame.    This option will add the attribute SCROLLING=»YES» to the <IFRAME> command.    If you 
select No, the scroll bars are not placed in the frame, even if the contents are longer than the space provided.    This 
option adds the attribute SCROLLING=»NO» to the <IFRAME> command.

MARGINS

In the Margins window, you can modify    the height and width of the document’s margins displayed in the frame.    To do 
so, enter the value in pixels in the corresponding boxes.    The lowest value must be 1 pixel.    This option adds the 
attributes MARGIN HEIGHT and MARGIN WIDTH to the <IFRAME> command.

In the tab Other Properties, you can make further adjustments to the frame.    These are the options:

FRAME BORDER

This option inserts a border around the frame.    If you remove the checkmark from the box, the frame will not have a 
border.    The attribute FRAMEBORDER=»0» is added to the <IFRAME> command..

ADDITIONAL PROPERTIES

In this menu you can determine the width and height of the frame as a percentage or in pixels.    This adds the attributes 
WIDTH="Value %" and HEIGHT="Value %" to the <IFRAME> command.    By default, the values are set as a 
percentage.    If you remove the checkmark from the box "%" the value is interpreted as pixels.    In the boxes Vertical 
space and Horizontal space, you can determine the position of the frame in your HTML document.    The values are 
entered in pixels.    This adds the attributes VSPACE="value" and HSPACE="value" to the <IFRAME> command.

FRAME ALIGNMENT

In this menu you can determine the alignment of the text contained in your document with respect to the frame.    This 
option adds the attribute ALIGN="Value " to the <IFRAME> command.    The possible values are:



Towards the top: ALIGN="TOP"

The text is aligned at the top of the frame.

Towards the middle: ALIGN="MIDDLE"

The text is aligned in the middle of the frame

Towards the bottom: ALIGN="BOTTOM"

The text is aligned at the bottom of the frame

To the left: ALIGN="LEFT"

The frame is automatically aligned to the left of your document

To the right: ALIGN="RIGHT"

The frame is automatically aligned to the right of your document.



SPACER <SPACER>

With this command you can enter empty space in your document.    This command is useful to format the page contents of your 
HTML document.    SPACER is an extension of Netscape 3.0.

To insert empty space in your document:

1. Place the cursor in the desired position to insert the empty space.

2. In the Extensions toolbar, click on the Spacer icon.

3. In the text box Width, specify the horizontal empty space.    The value must be entered in pixels.

4. In the text box Height, specify the vertical empty space.    The value must be entered in pixels.

5. In the text box Alignment, select the alignment of text inside the block of space.

6. You can view the results in the Preview window.

7 Click on the OK button.
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JAVASCRIPT TOOLBAR

Define a Script

Javascript Commands Summary

Banner

Time/Date 

Scrolling List of URL  ’  s  

Text gradations

Select Images

 Alternative Link Images

Rotating Images

Explanation Window

News Box

Screen Flash

Password 

Window Script 



DHTML AND JAVASCRIPT TUTORIALS

2 tutorials explains how to use the DHTML & Javascripts supplied with AceExpert 3 and supplies general guidelines on DHTML 
& Javascripts as a whole.

While examining the tutorial, you can click the Right and Left arrows on the internal viewer to return to a previous section or to 
go to the next section.

If you do not have Explorer installed, AceExpert will run the other external browser, Netscape.    However, the tutorial is best 
viewed with Explorer 4.0 or more.



WINDOW SCRIPT

This script inserts a new window on the browser screen.

To insert a new a new window in the browser:

1. Open the HTML document in which you want to insert    instructions to open a new window in the browser
.

2. In the tab Javascript, click on the button Window script .

3. In the text box File Name, select the file that you want to display in the new window.

4. In the box Width, indicate the window’s width in pixels.

5. In the box Height, indicate the window height in pixels.

6. In the box Window title, indicate a title for the window.

7. Click on the OK button.



WINDOW (SCRIPT) icon 



DEFINITION OF A JAVASCRIPT FUNCTION

With this command you can define a JavaScript function.    This is the first step to define a JavaScript function.

To insert a definition of a JavaScript function in your document:

1. In the JavaScript toolbar, click on the Define a Script icon.

2. In the text box Function name, type the name of the JavaScript function.

3. Click on the OK button.

The program will insert the following lines of code in the HEADER section of your document:

<SCRIPT LANGUAGE=JavaScript>
<!-- begin script
function Name() {

}
// end script -->

</SCRIPT>

Once you have indicated the JavaScript function, you can insert the function contents with the help of the menu  JavaScript 
Commands Summary .    The checkbox Insert a new function in the document header has a checkmark by default.    For more 
information on each of the JavaScript commands, please refer to the JavaScript reference in AceExpert's "Help" menu.



DEFINE A SCRIPT icon 



JAVASCRIPT COMMANDS SUMMARY

This option inserts the JavaScript language, with its existing objects, properties, methods and corresponding events.

To insert JavaScript in your document:

1. Place the cursor in the desired position in your document    to insert the script.

2. In the JavaScript toolbar, click on the    JavaScript Commands Summary icon.

3. Select the desired object.    On the window to the right, the methods corresponding to the selected object are displayed. 
If you double click on an object, a list of the sub-objects and their corresponding properties will be displayed in the 
window.    To see the available event handlers for a given object, select an object and click on the Events button located 
on the upper part of the right window.

4. Finally, to insert the selected JavaScript in your document, click on the Insert button located on the upper part of the 
right window.

For more information on each of the JavaScript commands, please refer to the JavaScript reference in AceExpert's Help menu.



JAVASCRIPTS COMMANDS SUMMARY icon 



JAVASCRIPT BANNER

This option allows inserting a banner in your document wherein text scrolls from right to left inside a scroll box.

To insert a JavaScript    banner in your document:

1. In the JavaScript toolbar, click on the Banner icon.

2. In the Enter your text box, type the text you want to appear on the scroll box.

3. In the    Width box, specify the width in pixels of the scroll box.

4. In the Delay box, indicate the delay in thousands of seconds to determine the speed of text scrolling in the box.    The 
smaller the number, the greater the speed.

In the Preview window below the menu you can see what the banner will look like in your HTML document.

5. In the window Visual display, Indicate if you want the banner to be displayed In a text box, or in the Status bar.    If 
you choose In a text box then the text will appear on a box located directly in your HTML page.    If you choose Status 
bar it will appear on the browser's status bar.

6. In the    window Behavior indicate if you want the text to Scroll, to Drag letters or display them as if using a Typewriter.

7. Click on the OK button.

The program will insert the JavaScript lines of code in the HEADER section of your document.    It will also insert the following 
attribute to the BODY command:

… onLoad="banniere()" onUnload="clearTimeout(ban)">
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TIME/DATE

This JavaScript inserts a dialog box that displays the time or date.

To insert a dialog box that displays the time or date:

1. Place the cursor in the document where you want to insert a dialog box.

2. In the JavaScript toolbar, click on the Time/Date icon.

3. Specify if you want to display the time or date. 

4. In the    menu Appearance, select the display style.    In the Preview window you can see the result of the style you 
selected.

5. Click on the OK button.

The program will insert the following lines of code at the point where you place the cursor.

<FORM NAME="Temps">
  <INPUT TYPE="text" NAME="Time" SIZE="Value"><BR>
</FORM>

The program will insert the JavaScript lines of code in the HEADER section of your document.    It will also insert the following 
attribute to the BODY command:

… onLoad="debute()" onUnload="clearTimeout(dd)">



TIME/DATE icon 



SCROLLING LIST OF URL’s

This JavaScript inserts in your document a Scrolling List    where each item refers to an URL.    When the user clicks on one of the 
items in the scrolling list, he has a choice of addresses.    All the user has to do is click on the desired address and the browser 
opens the URL.

To insert a scrolling list of URL’s in your document:

1. Position the cursor in the place you want to insert the scrolling list of URL’s.

2. In the JavaScript toolbar, click on the Scrolling List of URL  ’  s   .

3. In the text box URL destination, type the first URL address.

4. In the text box Text displayed in the menu, indicate the item you want listed in the menu.

5. In the Target frame text box, you can indicate the name of a frame if you want the linked item to appear in a specific 
frame.

6. Press the Add to insert this item in the list. 

7. In the Preview window you can view the scrolling list.

8. Repeat steps 4, 5 and 6 until your scrolling list is complete.

9. With the Copy, Modify and Erase buttons you can make changes to the scrolling list.

10. In the text box Title of menu when it appears,    indicate the title you want inserted in the first line of the menu.

11. Click on the OK button.

The program will insert the following lines of code at the point where you place the cursor.

<FORM>
<SELECT NAME="dest" SIZE=1>
  <OPTION SELECTED VALUE="">-------- TITLE GOES HERE --------
  <OPTION VALUE="http://URL#1">Item#1
  <OPTION VALUE="http://URL#2">Item#2
  <OPTION VALUE="http://URL#3">Item#3
  <OPTION VALUE="http://URL#4">Item#4
</SELECT>
<BR><BR>
<INPUT TYPE="button" VALUE="Scrolling List " onClick="if (form.dest.selectedIndex != 
0) location = form.dest.options[form.dest.selectedIndex].value;">
</FORM>



SCROLLING LIST OF URL’S icon 



TEXT GRADATION

This JavaScript inserts in your document a line of text with graded colors.    You can select one of three as the starting color: red, 
green or blue.    The text will have the initial color you chose and then it will turn lighter until it turns white at    the end of the line.

To insert text with graded color in your document:

1. Place the cursor in the position where you want to insert    the text with graded color.

2. In the JavaScript toolbar, click on the    Text Gradation icon.

3. In the menu Color Gradation, select a color.

4. In the text box Font type, select the font for your text with color degradation.

5. In the text box Font size,    select the font size for your text with color degradation.    The default value is 3.

6. In the text box Enter your text, you can enter the text that will be displayed with color degradation.

7. Click on the OK button.



TEXT GRADATION icon 



SELECT IMAGES

This JavaScript inserts in your document a box list or scrolling list, and each option of the menu is associated with an image that    
is displayed when the user clicks on one of the items.

This command refers to JavaScript 1.1.    Therefore, only Web surfers using Netscape 3.0 or Explorer 4.0 or higher can view the 
different images called by this JavaScript.    Other users will only see the first image.

To insert a selection of images in your document:

1. Place the cursor in the position where you want to insert    your selection of images.

2. In the JavaScript toolbar, click on the    Select Images icon.

3. In the text box to the right of the Add button, insert the text you want to display as the first item in the list box and then 
press the Add button.    This button will open the menu Open a graphic file.    Once you have selected the image, you 
can view it in the Preview window.    The item will be added to your list box.    Repeat these steps for every item you want 
to insert in the list box.

4. To modify an item, place a checkmark in the box View as a list and then select the option you wish to modify and press 
the Edit button. 

5. To erase an item, place a checkmark in the box View as a list and then select the item and press the Erase button. 

6. The arrows to the right of the list box allow you to scroll the list upwards and downwards.

7. The boxes W (for width) and H (for height) are used to change the display size of the images.    These dimensions are 
the same for all the images.

8. Click on the OK button.



SELECT IMAGES icon    



ALTERNATIVE LINK IMAGES

This JavaScript allows inserting in your document    an image that acts a hyperlink to a second image which will appear in place of 
the first one when the user moves the mouse pointer over the hyperlinked image.

This command refers to JavaScript 1.1.    Therefore, only Web surfers using Netscape 3.0    or Explorer 4.0 or higher can view the 
different images called by this JavaScript.    Other users will only see the first image.

To insert alternative link images in your document:

1. Place the cursor in the position where you want to insert    the image.

2. In the JavaScript toolbar, click on the    Alternative Link Images icon.

3. Press on the Pointer out of image button to select your first image.    This will open the window Open a graphic image. 
You can view the selected image on the Preview window. 

4. Press on the Pointer over image button to select your second image.    This will open the window Open a graphic 
image. It is important    to note that this image will have the same size as the first image selected. 

5. Press on the Link button to indicate the type of hyperlink between the images.    You can choose an external link or an 
internal link.

6. In the Target (frame name) , you can indicate a target or a name for your frame.

7. Click on the OK button.
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ROTATING IMAGES

This JavaScript inserts in your document images that appear one after the other.    These are usually used in publicity themes.

This command refers to JavaScript 1.1.    Therefore, only Web surfers using Netscape 3.0 or Explorer 4.0 or higher can view the 
different images called by this JavaScript.    Other users will only see the first image.

To insert rotating images in your document:

1. Place your cursor where you want to insert the rotating images.

2. In the JavaScript toolbar, click on the Rotating Images icon.

3. To insert the first image, click on the Open a graphic image button, and select the image.    Then click on the second 
button URL destination, and choose the corresponding URL destination and then press the    Add button.

Once you have selected the first image, you will see it displayed in the Preview window when you select it from the List 
of images box.

4. Repeat the previous step to add other images.

5. To remove an image, select the desired image from the box List of images and then press the Erase button. 

6. To make changes to the rotating images, select the desired image and press the Copy button.    Make the desired 
changes and then press the Modify button to add the image again to the rotating links.

7. In the Delay box, you can specify the time in seconds the image is displayed.

8. In the W and H boxes you can indicate the width and height in pixels of the images.    By default, the values assigned 
are those of the first image selected.    The dimensions are the same for all the images. 

9. Click on the OK button.

The program inserts the following attributes in the BODY command:

<BODY onLoad="if (VersionNavigateur(3.0,4.0)) {pubs=new 
CreerArray('image1','image2','image3'); AfficherPub(pubs,10000);}" 
onUnload="clearTimeout(pubT)">

The program also inserts the following line of code where you initially placed the cursor:

<IMG NAME="pubImg" SRC="Image" WIDTH="500" HEIGHT="75" BORDER="0">
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EXPLANATION WINDOW

This JavaScript inserts a hyperlink in your document.    When the user clicks on the link, an explanation window is displayed.    You 
can indicate the text you want to display, together with the type, size and color of the font.

To insert an explanation window in your document:

1. Select the text in your document that will act as a hyperlink. 

2. In the JavaScript toolbar, click on the Explanation Window icon.

3. In the window Text displayed in the explanation window enter the text you want displayed.

4. In the Font Type box, select    the font of the text that will be displayed in the explanation window.

5. In the    Font size box, select the font size that will be displayed in the explanation window.

6. In the Background image box you can select a background image for your explanation window.    To do so, press the 
Open button and    select an image.
 

7. In the Text color button you can select the color of the text that will be displayed in the explanation window. 

8. the Background color button you can select the background color for the explanation window.

9. Click on the OK button.
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NEWS BOX

This JavaScript inserts a textarea box in your document    where you can insert one or several information messages.    The news 
box is useful for displaying messages off-line.

This command refers to JavaScript 1.1.    Therefore, only Web surfers using Netscape 3.0 or Explorer 4.0 or higher can view the 
different images called by this JavaScript.    Other users will only see the first image.

To insert a news box in your document:

1. In the JavaScript toolbar, click on the News Box icon.

2. In the text area box,    type the message that will be displayed in the news box.

3. In the Column and Rows box specify the size of the news box.

4. Click on the OK button.

The program inserts the following attributes in the BODY command:

<BODY onLoad="MsgN='Message'; TextMultiligne(100);" onUnload="clearTimeout(Fin2)">

The program will also insert the following lines of code at the position where you placed the cursor:

<FORM NAME="formnouv">
  <TEXTAREA NAME="multi1" WRAP=PHYSICAL COLS="26"" ROWS="7"></TEXTAREA>
</FORM>
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SCREEN FLASH

This JavaScript inserts a flashing screen when the document opens.    You can indicate the initial color, the final color and the 
number of gradations between the first and last color.

To insert a flash screen in your document:

1. In the JavaScript toolbar, click on the Screen Flash icon.

2. Select the Start Color button and indicate the initial color of the flash screen.    The default color is black.

3. Select the End color button and indicate the final color of the flash screen.    The default color is white.

4. In the Number of gradations box, indicate the number of color gradations between the first and last colors selected.    
The higher the number of gradations, the longer the flash screen will take to complete its display.

5. Click on the OK button.



FLASH SCREEN icon    



CUSTOM BUTTONS

Custom buttons are helpful in situations where you want to insert a series of HTML commands or JavaScript code with a single 
click of the mouse.    For example, you might want to insert tags that make a piece of text both bold and italic at the same time.    
By assigning a custom button to such an option you could then simply click on the button to achieve the desired effect.

To add a custom button:

1. On the Custom tab, click on the Configure Custom Buttons icon.

2. Press the Add button.

3. Type the name for the custom button in the text box Button title.

4. You can replace the suggested shortcut key by placing the cursor inside the Shortcut box and then pressing CTRL plus 
another key. 

5. Choose the appropriate icon from the    Icon selection box.

6. Type the desired HTML commands or JavaScript code in the Contents box or import the file with the commands by 
pressing the Import button. 

7. Click the OK button.

To modify the properties of a custom button:

1. On the Custom tab, click on the Configure Custom Buttons icon.

2. Select the button you want to modify from the list.

3. Click on the Properties button.

4. Make changes to the desired properties.

5. Click on the OK button.

To delete a custom button:

1. On the Custom tab, click on the Configure Custom Buttons icon.

2. Select the button you want to erase from the list.

3. Click on the Erase button or press the Delete (Del) key on your keyboard.

4. Click on the OK button.



CONFIGURE CUSTOM BUTTONS icon 



TUTORIALS AND TOOLS ON THE INTERNET

The following are a few    Web sites that Web developers are sure to find useful:

Visicom Resources Page

http://www.visic.com/aceexpert/resources.html

This page contains the bank of icons, DHTML and JavaScript tutorials and other stuffs for AceExpert.

GraphSearch

http://www.graphsearch.com

With this graphic engine, it's the best way to find graphics and icons quickly on the net.

W3 Consortium

http://www.w3.org/ 

This site is the reference for all past and new guidelines on the web.

Gamelan.com

http://www.gamelan.com

For those who want to find Java Applets.

ActiveX.com

http://www.activex.com/

This site offers good directory of ActiveX controls. 



JUSTIFY <DIV STYLE =»TEXT-ALIGN:JUSTIFY»>

This option aligns text at the left and right paragraph indent.

To justify text:

1. Select the text in the document you want to    justify.

2. On the Common toolbar, click on the Justify icon.

The selected text will be inserted between the tags    <DIV STYLE= "text-align:justify;"> and </DIV>
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SPECIAL CHARACTERS BAR

This bar displays the available special characters.    To insert a special character in your document, place the cursor in the 
desired position and then double click on the special character required or select the character and press on the checkmark 
button.



MARGINS BAR

These are two vertical bars that create margins on both the right and left side of the edit window.    The left bar is fixed and can 
be adjusted selecting the Options tab in the Editor Preferences menu, by inserting a value.    The right bar can be adjusted by 
placing the    mouse pointer over the bar and while keeping the left mouse button pressed , moving the mouse to the desired 
position.



SPECIAL CHARACTERS CHECKBOX
With this option checked you can display the special characters bar. The special characters bar is located on top of the edit 
window.



CLEAR TAGS
Menus

This command is used to automatically deletes the tags found around selected text.

To    clear tags:

 

1. Select the text.
 

2. In the Edit menu, select Clear Tags. 

If you haven’t select any text and you select the option Clear Tags from the Edit menu, the following message is displayed: Do 
you want to clear    the tags in the whole document (otherwise, select the text)? 

To cancel the Clear Tags command, simply press Cancel from the Edit menu.



ATTACH FILE

With this command the user can attach one or several files to the form.

To attach a file to a form:

1. On the Form tab, click on the button File attach .

2. On the text box Name, enter a name.    This name identifies the attached file.

3. In the text box File Attached, enter the name of the file you want to attach.

4. Click on the OK button. 

Note:    Please make sure you already have the CGI program installed on your server so this command can be executed.
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PASSWORD (SCRIPT)

This command allows you to insert a password (minimum security)    in your HTML document. The password corresponds to the 
document destination without the file extension.    The referred file must be found in the same directory where the file that refers 
to it is found, otherwise the password will include the path as well as the name of the file.

Example: The two files are found in the same directory in your FTP site.

 home.html        (File in which you want to insert the password)

 secret.html      (The password document)

The resulting password in the document home.html will be secret without the extension .html.

Following is the procedure to insert a password in your document:

1. Place the cursor where you want to insert the password.

2. In the JavaScript toolbar, click on Password icon.

3. In the text box Document Name (the password), enter the password.

4. Click on OK button.
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IMAGE BROWSE
Menus

This command displays all the bmp, gif and jpg format images found in any directory in your hard disk.    This command is very 
useful in order to verify if the images you are using in your Web pages are placed on the correct directory in your had disk.

To display images found in a directory:

1. In the Standard toolbar, click on the button Image Browse 

Or

From the File menu, select the option Browse Images.

2. Select the directory containing the images you want to view.

3. The window is split into two windows.    On the left side you can see your disk’s the directory tree while the right window 
displays the bmp, gig and jpg images.

4. From the left window, select the directory that contains the images you want to view.

5. The right window displays all the images found on the selected directory.

When you move the mouse over an image, the size of the file is displayed.

When you click on the image, the following information is displayed on the status bar: the size in pixels, the size in kilobytes, the 
date it was last modified and the directory where it’s found.

You can also insert the image with the corresponding code in your HTML document.    To do so, simply double click on the 
desired image and the code will be inserted where the cursor is positioned in your document.
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EXTENDED REPLACE
See also Menus

With this command you can search for a string of text and replace it with another string in different files.

The search and replacement can be done on several files found in the same directory or that are part of the same project.

You can enter a word or a string of words in the Text to Find and the program will indicate it found the first occurrence of the string 
and the name of the document containing it.    You can then replace the string with another string of words.

To replace a string of text using extended replace:

1. From the Edit menu select the option Replace by… 

Or

From the Standard toolbar, click on the button Extended Replace .

2. Enter the string to search for in the text box Text to Find.

3. Enter the text that will replace the text searched for in the text box Text to replace.

4. Press the Add button if you chose the option Specified files and select the files where you want to run the extended 
replacement,

or 

Press the Browse button if you chose the Search in directories    and select the directory(s).

5. Click the Start button to start the replacement.

The following options are found in the    Extended Replacement window:

CASE SENSITIVE

If this option is selected, the search will find only those occurrences with the exact combination of uppercase and lowercase letters 
specified in the Text to find box.    For example, if you search for the word Good, you will find the word Good but not the word 
good.

SPECIFIED FILES

If selected, this option allows you to replace the text indicated in Text to find: with the text indicated in Text to replace: in all files 
found in the directory selected for the search.

SEARCH ALL FILES IN PROJECT

If selected, this option allows you to replace the text indicated in Text to find: with the text indicated in Text to replace: in all the 
files contained in the project.

SEARCH IN DIRECTORY

If selected, this option allows you to replace the text indicated in Text to find: with the text indicated in Text to replace: in all the 
files found in the directory selected for the search.

DIRECTORY TO SEARCH

Select the directory where you want to conduct the extended replacement.

FILE MASKS

When you select the type or types of files that you want to search, a filter is created to ignore all other files and the search is 
conducted only in the selected file types.

INCLUDE SUBDIRECTORIES



If selected, this option allows you to replace the text indicated in Text to find:    with the text indicated in Text to replace: in all the 
files found in all the subdirectories of the directory selected for the search.
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CONFIGURE TABS TOOLBARS
Menus

With this command you can configure the buttons on the tabs bar.    If you find it convenient to move a button found in one tag to 
another tag, you can do so by means of one of two methods: Use the shortcut menu or use the Options menu.

To configure the buttons on the tabs: 

1. In the Options menu select the option Configure Tab Bars or

Select    any tab and click the right mouse button and select Configure buttons from the shortcut menu displayed.

2. The Tabs Buttons Configuration dialog window opens.

3. In the list box Tab, select the tab that contains the button you want to move.

4. Select    the button that you want to move from the box Buttons on the Current Tab.

5. Click on the left arrow..

6. The command button selected is transferred to the box Available buttons.

7. Select the tag where you want to place the button from the list box Tab.

8. Select the button you previously transferred..

9. Click on the right arrow.

10. The command button is transferred to the selected tab.

11. Click on the Close button.

If you are not satisfied with the new configuration you chose or you simply want to revert to the default configuration defined by 
AceExpert, click on the Reset button in the Tabs Buttons Configuration.

You can also change the order the buttons are placed    on the tab bar by using the up arrow or down arrow.

To change the position of buttons:

1. In the box Buttons on current tab, select the button you want to move.

2. Press the mouse left button and move it to the desired position or 

Press the up arrow or the down arrow.



EDITOR PREFERENCES
Menus

The Editor Preferences window has four tabs.    The first tab, Options, is used to indicate the default edit options as well as the 
printing options for HTML documents.    The second tab, Highlighting, allows you to modify the attributes of different elements 
found in HTML documents.    The third tab, Auto Correct, automatically traps and corrects frequent mistakes, and the fourth tab, 
Code Templates, allows you to customize code templates that contain a series of instructions with the simple use of a hotkey.

The Options tab:

General Options:

Allows you to make changes to the way the HTML document is displayed in the edit window.

Auto Indent

If selected, the text inserted after pressing the Tab key will be indented automatically to the right.    The indent consists in 
aligning the text of lines to the right at the location where the tab is set.

Mark wrapped lines

If this option is checked, wrapped lines are identified by bullets displayed in the right margin.    The bullets in the margin 
are not visible if the option Word wrap is not checked.

Word Select

If this option is selected, you can select a word by double-clicking on it.

Syntax highlight

If selected,    HTML document elements, such as comments, tags, etc. are displayed in colors. The colors displayed 
correspond to those selected in the Highlighting    tab of the Editor Preferences.    If you remove the checkmark, all the 
document’s elements will be displayed in black.

Cursor beyond EOL

If selected,    the cursor can be set beyond the end of line.

Word wrap column

Indicates the column where long lines will be wrapped.    This option is activated only if the checkbox Word wrap is 
checked.

Line numbers in gutter

If selected,    the line numbers will be visible in the gutter.

Print Options:

You can set the printing attributes of the HTML document before printing it.

Wrap long lines

If selected, long lines are wrapped in the printed copy of the HTML document.

Line numbers

If selected, all lines of the printed copy of the HTML document are numbered.

 

Title in header

If selected, the printed copy will contain on the upper right corner of the HTML document,    the name of the file as well 
as the directory where it’s found. 

Date in header



If selected, the printed copy will contain on the upper right corner the date and time.

Page numbers

If selected, all pages of the printed copy of the HTML document are numbered.

Other options:

Visible right margin (gutter)

If checked, a margin is displayed to the right of the HTML document.    If you remove the checkmark, the right margin will 
disappear. 

In the box    Gutter Width you can indicate the margin size.    This value is expressed in pixels.

Block indent step size

Indicate in this box the step size.

Tab stop

Enter in this text box the number of spaces inserted between the line of text and the document’s right margin when the 
TAB key is pressed.

Tab columns

Specify the column or columns where the TAB key will stop.    For example, the values 4 15 20 indicate three column 
stops for the TAB key.

The Highlighting tab:

With the different options found in this tab you can modify the size, font as well as the color used to identify different 
elements used in the edit window.    You can view the changes you make to these elements on the window shown on the 
top window that    shows the elements found on the HTML document..

Color Options:

You can modify the color of different elements shown in you edit window such as the color of text, tags, hyperlinks, 
comments, etc.    To do so, select the element you want to change from the Elements box and hen select the 
background an/or foreground colors from the color panel to the right of the Element box.

You can view the change you have made to elements on the top window.    You can also assign the underline, italics or 
bold attributes to the elements by inserting a checkmark in the appropriate box.

Font:

You can change the font and size of text of your edit window.    To do so, select    the desired font and size.    The default 
value is Courier New size 9.

The Auto Correct tab:

In this window you can create a dictionary of personal preferences to automatically correct a word or abbreviation the 
minute it is written.

REPLACE 

Enter the word or abbreviation that will be    automatically replaced with the correct text. 

For example, if your always type document instead of document, enter the incorrect word.



WITH

Enter the text that is to replace automatically the incorrect text.    Following the previous example, you would enter the 
correct spelling for the word document, that is, enter document.

Click on the OK button to insert the word or abbreviation in the AceExpert’s dictionary of personal preferences.    To delete 
an entry from the dictionary, select it and then press the button Delete.

The Code Templates tab:

In this menu you can customize a code template.    This is an useful feature if you want to insert a series of instructions 
with the aid of a shortcut.

For example, you could insert your signature by simply using the shortcut CTRL+J.    To use a shortcut for this purpose, 
you first have to customize a code template.

Code Template:

In this text box,    enter the series of instructions for which you want to create a custom code template.

Name:

In this text box    enter a name for your code template.

 

Description

In this text box, enter a description for your code template.

Add

Click this button the custom code template to the list of templates.

Delete

Click this button to erase an existing code template from the template list.

To insert    a code template in your document, place the cursor at the desired position and then press CTRL+J and the template list 
window will open.    Double click on the desire code template.



THE JAVA TOOLBAR

Insert Java Applet 

Java Banners 

Java Tools 

Java Effects 

Java Menus 



JAVA BANNERS icon 



JAVA TOOLS icon 



JAVA EFFECTS icon 



JAVA MENUS icon 



FORM IMAGE icon 



STARTING THE SPELL CHECKER

This command allows you to check the spelling in your HTML document.    By starting the spell checker, you can correct spelling 
and grammar errors found in your work document.

In order to use the spelling checker with AceExpert, the English dictionary must be installed in your system.    There are versions 
of Office 97 with different dictionaries (multilingual).    If this is installed in your system, you will have a choice of languages to 
select for the spelling checker. 

To check and correct spelling errors :

1. Make sure you have selected a language in the Spelling  tab of the General Preferences option of the Options menu. 

2. In the Standard toolbar, click the Start the Spell Checker icon.

The program will detect the spelling errors found in your work document.    Press the Change button if you wish to replace the 
word found with the one the program suggests or press the Ignore button if you wish to keep the original word and continue 
checking.

You can also add a word to the dictionary by pressing the Add button.

To change a word everywhere in the working document, press the Change All button..

To ignore a word everywhere in the working document, press the Ignore All button..



START THE SPELL CHECKER icon 



STARTING THE HTML SYNTAX CHECKING 

This command allows you to check the HTML syntax of the current document (selected).    When you start the syntax checking, 
you will find the number of errors (if    any), the total number of lines as well as the warnings (if any) in the Syntax checking 
dialog box. 

Below the edit sheet a window opens listing the errors and warnings found during the check and indicating the name of the 
document, the line number and a description of the error or of the warning.

You can double click on an error or warning line in order to go directly to the line where the error is pointed out in the document.

To close the error message window, click on the X located on the left.



DHTML

Style Effects 

Special Effects 

Menu 

Text Transition 

Image Transition 



STYLE EFFECTS (SCRIPT)

This DHTML script is used to create style effects on simple text or on a link on your Web page when the mouse passes over the 
text line.    Style effects in this script are displayed only on the Microsoft Internet Explorer browser. These effects are not visible 
with Netscape, you will only see the text.

To create style effects on simple text :

1. Place the cursor at the spot where you want to insert the text.

2. In the DHTML tab, click on the Style effects (script) button.

3. In the Text text box of the    Inactive styles menu, enter the text that will appear on the page when the mouse is not 
passing over it.

4. If necessary, modify the character color and/or size.

5. In the Text text box of the Active styles menu, enter the text that will appear on the page when the mouse passes over it.

6. If necessary, modify the character color and/or size..

7. Click on the Link checkbox in order to remove the check mark.

8. Click on the Preview tab to see a preview of the text

9. Press the OK button.

To change the text size :

Change the value in the Size option box.    This value is 10 by default. 

To change the text color :

Click on the Color button and select the color you want.

To create style effects on a link :

1. Place the cursor at the spot where you want to insert the text.

2. In the DHTML tab, click on the Style effects (script) button.

3. In the Text text box of the Inactive styles menu, enter the text that will appear on the page when the mouse is not passing 
over it.

4. If necessary, modify the character color and/or size..

5. In the Text text box of the Active styles menu, enter the text that will appear on the page when the mouse passes over it..

6. If necessary, modify the character color and/or size..

7. In the Link text box, enter the file name and path. You can also search for the file by pressing the Open button.

8. Click on the Preview tab to see a preview of the text.



9. Press the OK button.



STYLE EFFECTS icon 



MENU (SCRIPT)

This DHTML script is used to display a dynamic menu horizontally at the top of a Web page.

To display a dynamic menu on your Web page :

1. In the DHTML tab, click on the Menu (script) button

2. In the URL destination text box, enter the first URL address.

3. In the Text displayed in the menu text box, enter the text that will appear in the menu.

4. Press the Add button to add this item in the Items in the menu list box.

5. Click the Preview tab to see a preview of the results of your menu.

6. Repeat steps 2, 3, 4 and 5 until your menu is complete.

7. The Copy, Modify et Delete buttons allow you to modify your menu.

8. Press the OK button.



MENU (SCRIPT) icon 



IMAGE TRANSITION (SCRIPT)

This DHTML script is used to create a special transition effect when loading an image.

To insert an imagewith a special transition effect :

1. Place the cursor at the spot where you want to insert the image.

2. In the DHTML tab, click on the Image transition (script) button .

3. In the Image text box, enter the file name and path of the image.    The file must be in GIF or JPG format.

You can also search for the image file with the OPEN button located to the right of the text box.

4. In the Effect option box, select the transition effect that you want to use with your image.

5. In the Delay text box, specify the time that the special effect will last when loading the image.

6. Click on the Preview tab to see a preview of the special effect on the image in question.

7. Press the OK button.



IMAGE TRANSITION icon 



SPECIAL EFFECTS (SCRIPT)

This DHTML script is used to move text in different directions (up, down, left, right). 

To move text in your Web page :

1. Place the cursor at the spot where you want to insert the text.

2. In the DHTML tab, click on the Special effects (script) button.

3. In the Enter your text text box, enter the text that will appear on the page.

4. In the Direction menu, determine the text movement position.

5. In the Parameters menu, specify the starting position, the final position, and the text movemet speed.. 

6. In the Text properties menu, change – if necessary – the character font, size, and colour of the text.

7. Click on the Preview tab to see a preview of the moving text.

8. Press the OK button.

You can change the font selected by default by selecting the font you want in the Font type option box of the Text properties 
menu.    If you want to change the size of the characters, change the value selected in the Size option box.    This value is 10 by 
default. 

To change the text color :

Click on the Color button and select the color you want.



SPECIAL EFFECTS (SCRIPT) icon 



TEXT TRANSITION (SCRIPT)

This DHTML script is used to create a text special transition effect when the HTML page is loaded.

To insert text with a special transition effect on a Web page :

1. Place the cursor at the spot where you want to insert the text.

2. In the DHTML tab, click on the Text transition (script) button.

3. In the Enter your Text text box, enter the text that will appear on the page.

4. In the Effect option box, select the transition effect that you want the text to have.

5. In the Effect delay text box, specify the time that the special effect will last when the page is loaded.

6. In the Transition effect properties menu, change – if necessary – the character font, size, and color.

7. Click on the Preview tab to see a preview of the text special effect.

8. Press the OK button.



TEXT TRANSITION (SCRIPT) icon 



LEFT INDENT 

With this command you can move a line of text or HTML code to the left.    This move can only be made on a line of text or HTML 
code already indented to the right, that is, it erases the tab or tabs to the right and moves the text or code to the left again.    The 
result of this indentation is displayed in AceExpert’s edit window, but it has now effect on how the page will be displayed in 
browsers on the Internet.

To indent a line or lines of text or HTML code to the left:

1. Select the line or lines of text that you want to move to the left.

2. On the Standard toolbar, click on the button Indent left .

Or

From the Edit menu, select Indent left.



LEFT INDENT icon 



RIGHT INDENT

With this command you can move a line of text or HTML code to the right.    Adding indents makes it easier to view lines of text 
and tags of HTML documents in the edit window. The result of this indentation is displayed in AceExpert’s edit window, but it has 
now effect on how the page will be displayed in browsers on the Internet.

To indent a line or lines of text or HTML code to the right:

1. Select the line or lines of text that you want to move to the right.

2. On the Standard toolbar, click on the button Indent right 

Or

From the Edit menu, select Indent left.



RIGHT INDENT icon 



JAVA BANNERS

With this command you can insert    in your HTML document one of AceExpert’s predefined Java Applets from the Java Banners 
category.

With this command you can also re-edit the HTML code of the Java Applet by selecting it and clicking the Java button once again.

To insert one of AceExpert’s    PREDEFINED Java Applets found in the BANNERS category:

1. First you must save your HTML document.
 

2. From the Java tab,    click on the button Java Banners .

3. Select the desired predefined applet from the window on the right; if    necessary,    refer to the online help by clicking on 
the Help menu and selecting the item Predefined Applets Help.    This online help supplies a description, a list of 
parameters and an example for each applet.
 

4. Click on the Insert button.    AceExpert will ask you if you want to save the .class file in the same directory as that of your 
HTML document.

5. Change the desired attributes and or/parameters.

6. Click on the button Show Preview to view the applet.

7. Click on the OK button.



JAVA TOOLS

With this command you can insert    in your HTML document one of AceExpert’s predefined Java Applets from the Java Tools 
category.

With this command you can also re-edit the HTML code of the Java Applet by selecting it and clicking the Java button once again.

To insert one of AceExpert’s    PREDEFINED Java Applets found in the TOOLS category:

1. First you must save your HTML document.
 

2. From the Java tab,    click on the button Java Tools .

3. Select the desired predefined applet from the window on the right; if    necessary,    refer to the online help by clicking on the 
Help menu and selecting the item Predefined Applets Help.    This online help supplies a description, a list of parameters and an 
example for each applet.
 

4. Click on the Insert button.    AceExpert will ask you if you want to save the .class file in the same directory as that of your 
HTML document.

5. Change the desired attributes and or/parameters.

6. Click on the button Show Preview to view the applet.

7. Click on the OK button.



JAVA EFFECTS

With this command you can insert    in your HTML document one of AceExpert’s predefined Java Applets from the Java Effects 
category.

With this command you can also re-edit the HTML code of the Java Applet by selecting it and clicking the Java button once again.

To insert one of AceExpert’s    PREDEFINED Java Applets found in the EFFECTS category:

1. First you must save your HTML document.
 

2. From the Java tab,    click on the button Java Effects .

3. Select the desired predefined applet from the window on the right; if    necessary,    refer to the online help by clicking on the 
Help menu and selecting the item Predefined Applets Help.    This online help supplies a description, a list of parameters and an 
example for each applet.
 

4. Click on the Insert button.    AceExpert will ask you if you want to save the .class file in the same directory as that of your 
HTML document.

5. Change the desired attributes and or/parameters.

6. Click on the button Show Preview to view the applet.

7. Click on the OK button.



JAVA MENUS

With this command you can insert    in your HTML document one of AceExpert’s predefined Java Applets from the Java Menus 
category.

With this command you can also re-edit the HTML code of the Java Applet by selecting it and clicking the Java button once again.

To insert one of AceExpert’s    PREDEFINED Java Applets found in the MENUS category:

1. First you must save your HTML document.
 

2. From the Java tab,    click on the button Java Menus .

3. Select the desired predefined applet from the window on the right; if    necessary,    refer to the online help by clicking on the 
Help menu and selecting the item Predefined Applets Help.    This online help supplies a description, a list of parameters and an 
example for each applet.
 

4. Click on the Insert button.    AceExpert will ask you if you want to save the .class file in the same directory as that of your 
HTML document.

5. Change the desired attributes and or/parameters.

6. Click on the button Show Preview to view the applet.

7. Click on the OK button.



SAVE TO FTP…
See also Menus

This command allows you to save your HTML documents directly on your favorite FTP sites.    This option is available if you have 
installed in your computer AceFTP version 1.11 or higher.

To save your document directly on your FTP site:

· Make sure you are connected to the Internet before you begin your transfer;

· From the File menu, select Save to FTP… and then select    the option Save,

Or

· From the Standard toolbar, click on the icon FTP Manager and then select Save;

· Fill out the fields: Host address, User ID, and Password;

Or

If you already listed your sites    in    the FTP sites box , select the desired site; 

· In the text box Port, enter the connection port you use.    By default this is Port 21;

· In the text box Host Folder indicate the server’s directory where you want to save the file;

· Click on the Save button.

If you want to save the current document under    a different name    in your FTP site, use the command Save as… 

To save all the open document in your FTP site, use the command Save All .

To save only selected files in your FTP site, use the command    Save selected files . 



SAVE TO FTP AS…
See also Menus

This command allows you to save your HTML documents directly on your favorite FTP sites under a different name.    This option 
is available if you have installed in your computer AceFTP version 1.11 or higher.

To save your document directly on your FTP site under a different name:

· Make sure you are connected to the Internet before you begin your transfer;

· From the File menu, select Save to FTP… and then select    the option Save as…,

Or

· From the Standard toolbar, click on the icon FTP Manager and then select Save;

· Fill out the fields: Host address, User ID, and Password;

Or

If you already listed your sites    in    the FTP sites box , select the desired site; 

· In the text box Port, enter the connection port you use.    By default this is Port 21;

· In the text box Host Folder indicate the server’s directory where you want to save the file;

· Click on the Save button.



SAVE TO FTP SITE ALL OPEN FILES
See also Menus

This command allows you to save all the open HTML documents directly on your favorite FTP sites.    This option is available if you 
have installed in your computer AceFTP version 1.11 or higher.

To save all open document directly on your FTP site:

· Make sure you are connected to the Internet before you begin your transfer;

· From the File menu, select Save to FTP… and then select    the option Save All,

Or

· From the Standard toolbar, click on the icon FTP Manager and then select Save;

· Fill out the fields: Host address, User ID, and Password;

Or

If you already listed your sites    in    the FTP sites box , select the desired site; 

· In the text box Port, enter the connection port you use.    By default this is Port 21;

· In the text box Host Folder indicate the server’s directory where you want to save the file;

· Click on the Save button.



START ACEFTP 

With this command you can start AceFTP, a program to transfer files between your computer and the server, without having to 
exit AceExpert.    AceFTP is perfectly integrated with the AceExpert HTML editor so that you can easily create and transfer your 
files with the two programs.

To start AceFTP without    closing AceExpert:

1. Make sure you have AceFTP version 1.11 or higher already installed in your computer.

2. Make sure you are connected to the Internet.

3. From the Standard toolbar, click on the icon FTP Manager and then on the option Start AceFTP.

Or

From the Options menu, select Start AceFTP.

If you don’t have AceFTP installed, you can download a trial version from the following address:

http://www.visic.com/aceftp/



START FTP MANAGER icon 



GO TO LINE NUMBER

To move around quickly in you HTML document    without having to constantly use the arrow keys on your keyboard, you can use 
the option Go to line number... found in the Edit menu to go to a specific line in the document.    You can also use the shortcut 
key CTRL+L (press both keys simultaneously).    Refer to the Shortcuts list.



PREDEFINED CGI PROGRAMS

The CGI (Common Gateway Interface) is a standard interface between an external    Gateway application and the information on 
servers, such as a Web server.    In general terms, a CGI program allows handling, obtaining and generating information based 
on data entered by the user.    In other words, the CGI program interprets information entered by the user and submitted to the 
Web server.

AceExpert 3 comes with two CGI programs: the CGI mailto to handle the contents of a form sheet, and the CGI Hit Counter 
that inserts a counter in your Web page.

To learn more about these two programs, from    AceExpert’s Help menu select Predefined CGI Help.



SYNTAX MENU

Edit Tags 

Syntax Checking Preferences 

Check Document 

Check Project 

Evaluate Document 

Evaluate Project 

Check all Open Documents 

Evaluate all Open Documents 



EDIT TAGS

This command allows you to start the HTML Syntax editor.    With this editor you not only have the possibility of editing the HTML 
properties of the tags, but you also have the possibility of erasing the tags as well as the rules that govern them.

To start the HTML Syntax editor :

· In the Syntax menu, select the Edit Tag option.    The HTML Syntax editor dialog box will appear.

Definition of menus in the HTML Syntax Editor dialog window

File Menu 

Tag Menu 

Rules Menu 



SYNTAX CHECKING PREFERENCES

This command offers you different options associated with HTML Syntax Checking. 

Warning message options :

Maximum number of warning 
messages

Used to determine the maximum number of warning 
messages in the messages window during HTML checking.    
Once this number is reached, checking will stop.

Attributes integrity Specifies that the required attribute(s) determined by the 
HTML Syntax Editor    are respected.    This option is checked 
by default.

Optional end tag without start tag A warning message will appear in the message window if, 
during HTML checking , the program detects that one end tag 
is used without the start tag being present.    For example: a 
paragraph end tag </P>found without a paragraph start tag 
<P>. This option is checked by default.

Unknown start tag A warning message will appear in the message window if, 
during HTML checking, the program detects a start tag missing 
from the HTML reference file specified in the syntax editor.    
This option is checked by default.

Optional end tag not found If you use a tag without an end tag and this is not required, a 
warning message will appear.    For example: If this box is 
checked and you use a <P> tag without a </P> end tag, a 
warning message will appear.    This option is not checked by 
default.

Dead links If you use a link in a document and the link's address is non-
existent, a warning message will appear.    This option is 
checked by default.

Unknown end tag If you use an end tag which is not found in the HTML reference 
file of the syntax editor, a warning message will appear.    This 
option is checked by default.

Warning message options :

Maximum number of error messages Determines the maximum number of error messages during 
HTML checking.    If this number is reached, HTML checking 
will stop.

Tag not allowed A tag that is not allowed is a tag that does not respect the rules 
defined in the HTML Syntax Editor.    For example, a <META> 
tag found outside the <HEAD> tag.    This option is checked by 
default.

Required attribute absent If a required tag attribute is missing, an error message will 
appear.    For example: if the <HREF> attribute for a link is 
missing.    This option is checked by default.

End tag without start tag If the program detects that an end tag is used without a start 
tag, a message error will appear.    This option is checked by 
default.

Required end tag not found If you forget to use a required end tag, a message error will 



appear.    This option is checked by default.

Illegal symbol within tag If you use an illegal symbol such as "&" within a tag, an error 
message will appear because this symbol is considered 
unacceptable inside a tag.    This option is checked by default.

Tag bracket not found A tag is always found between the < and > brackets.    If one of 
the brackets is missing, an error message will appear.    This 
option is checked by default.

Attributes in end tag are not allowed Usually, there are no attributes in the end tag.    If you place an 
attribute in the end tag, an error message will appear.    This 
option is checked by default.

Duplicate internal link If you use 2 internal links with the same name, an error 
message will appear.    This option is checked by default.



CHECK DOCUMENT

This command allows you to check the HTML syntax of an HTML document.

To perform a syntax check of an open document :

· Open the document that you wish to check ;

· In the Syntax menu, select the Check Document option. 

The Syntax checking dialogue window appears, displaying the number of the current line, the total number of warnings, the 
total number of lines of the document as well as the total number of errors.

Below the edit window, a window will appear where the errors and warnings found during the check will appear indicating the 
name of the document, the line number and a description of the error or of the warning.

You can double click the error or warning line in order to go directly to the line where the error is highlighted in the document.

To close the error and warning message window, click on the X located on the left. 



CHECK PROJECT

This command allows you to check the HTML syntax of all the HTML documents which make up a project.

To check the syntax in a project :

· Open the project you wish to check ;

· In the Syntax menu, select the Check Project option.

The Syntax checking dialog window appears, indicating the number of the current line, the total number of warnings, the total 
number of lines in the project documents as well as the total number of errors.

below the edit window, a window will appear listing the errors and warnings found during the check indicating the name(s) of the 
document(s), the line number and the description of the error or warning.

You can double click the error or warning line in order to go directly to the line where the error is highlighted in the specific 
document of the project.

To close the error and warning message window, click on the X located on the left.



CHECK ALL OPEN DOCUMENTS

This command allows you to check the HTML syntax of the documents opened during an AceExpert session. 

To check the syntax of all open documents :

· Open the documents that you wish to check ;

· In the Syntax menu, select the Check All Open Documents option..

The Syntax checking dialog box will appear, displaying the number of the current line, the total number of warnings, the total 
number of lines of all the documents as well as the total number of errors.

Below the edit window, a window will appear listing the errors and warnings found during the check and indicating the name(s) of 
the document(s), the line number and the description of the error or warning.

You can double click on the error or warning line in order to go directly to the line where the error is highlighted in the specified 
document.

To close the error and warning message window, click on the X located on the left. 



EVALUATE ALL OPEN DOCUMENTS

This command allows you to evaluate the syntax of all the open HTML documents during an AceExpert session.

To evaluate the open files :

· In the Syntax menu, select the Evaluate All Open Files Option.

The Evaluating Files dialog window lists the total number of open files, the total size of the documents, the number of resolved 
and unresolved links.



EVALUATE DOCUMENT

This command allows you to make the syntax evaluation of the HTML document currently in use.

To evaluate a file :

· Select a file;

· In the Syntax menu, select the Evaluate Document option..

The Evaluating Files dialogue lists the total number of open files, the total size of the documents, the number of resolved and 
unresolved links.



EVALUATE DOCUMENTS IN PROJECT

This command allows you to evaluate the syntax of the project currently in use.

To evaluate a project :

· Open a project ;

· In the Syntax menu, select the Evaluate Project option..

The Evaluating Files dialog window lists the total number of files of the project, the total size of the documents, the total number 
of resolved and unresolved links.



WEB PAGE GRAPHICS

In order to facilitate the task of users even more, AceExpert provides 2500 graphics which you can include in your Web pages.    
You will find animated GIFs, icons, background images, etc.

You can download these 2500 graphics from our site at the following address:

http://www.visic.com/aceexpert/iconbank.html



DOCUMENTS MENU

This menu lists the HTML documents that are open and indicates their names as well as their corresponding folders where they 
are found.



WEB SITE TEMPLATES

AceExpert offers Web page creators 20 templates of predefined Web sites.    In the shareware version, you will find 6 Web site 
templates with two templates per category.    Once the software is registered, all 20 Web site templates become available.

These predefined Web site templates are distributed in three categories :

· General : these templates are used to create personal Web sites.

· Business – Frames : to create company Web sites using frames.

· Business : to create company Web sites without frames.

To integrate a predefined Web site template :

1. In the Standard toolbar, click on the New File    icon.

Or

In the File menu, select the New option.

2. The New project dialog window will appear.

3. Click on the General, Business – Frames or Business tab.

4. On the left of the New Project dialog window, the available Web site template icons will appear according to the chosen 
category.

5. Click on one of the Web site template icons in the left window to view the site’s home page which is displayed in the 
right side of the New Project dialog window.

6. Choose the site template.

7. Press OK

8. The New Project Assistant dialog window will appear.

If you have selected the Business – Frames category, the New Project Assistant dialog window will be split in two 
windows in order to allow you to choose the items that you want to have in your menu.    In the left window, you have the 
list of available items that you can integrate in your menu.    In the right window, you have the list of items found in the 
template's menu. 

To integrate a new item in the menu, in the Available Items list box, select the item that you want to insert in the menu, 
then press the right arrow,    The item will be placed in the Items in the Menu list box.

To delete an item from the menu, in the Items in the Menu list box select the item that you want to delete and press the 
left arrow.    The item will be placed in the Available Items list box.

Press on the Next button to go to the next step, or press the Previous button in case you wish to return to the previous 
step.

9. Select the folder where you want to copy the site template by clicking the Open Folder on the right of the Project 
Folder text box.

10. Press the Finish button to integrate the site template.    If you wish to return to the previous step, press the Previous 
button.



PREVIEW icon 



IMPROVED TAG HIGHLIGHTING

AceExpert allows you to have a more organized edit window that makes it easy to distinguish the different elements of your 
HTML documents.    To change the appearance of highlighted elements, you can modify the colors and other items from the 
Options menu and choosing the Editor Preferences item.    From the Editor Options window, select the Highlighting tab.



OPEN FILE FROM FTP… 

With AceExpert you can open an HTML directly from your favorite site. This option is available if you have installed in your 
computer AceFTP version 1.11 or higher.

To open an HTML document from an FTP address:

· Make sure you are connected to the Internet before you begin your transfer;

· From the File menu select the option Open File from FTP… and then select the option FTP address.

Or

· From the Standard toolbar, click on the icon FTP Manager and then select    Open…;

· Fill out the fields: Host address, User ID, and Password;

Or

From the text box FTP Sites  select the site that contains the document    you previously saved; 

· In the text box Port, enter the connection port you use.    By default this is Port 21;

· In the text box Host Folder indicate the server’s directory where you the file is located;

· If you want to download the file, then on the text box Download in, indicate the directory on your hard disk where 
you want to save the file;

You can also search for the directory by pressing the Open    button located to the right of the text box;

· Click on the Open button. 

The Import button allows you to import FTP sites found on the list.

To open an HTML document from a Web Address:

· Make sure you are connected to the Internet before you begin your transfer;

· From the File menu, select Open from FTP… and then select    the option Web Address,

· In the text box URL, enter the URL address you wish to connect to;

· Indicate the type of connection you want to use: FTP, anonymous FTP or HTTP.

· Fill out the fields: Host address, User name, and Password , Port, Folder;

Or

If you already listed your sites    in    the FTP sites box , select the desired site; 

· In the text box Port, enter the connection port you use.    By default this is Port 21;

· In the text box Folder, indicate the name of the server’s folder (directory) where the file is located;



In the text box File, enter the name of the file you want to open.

· Click on the Open button. 



HTML SYNTAX EDITOR FILE MENU

These are the options in the file menu :

Open
This option allows you to open a reference file (.ref).

Save
The save option allows you to save the open reference file where the modifications have been made..

Save as
Allows saving a reference file under another name.

Exit
This option allows you to exit the HTML Syntax Editor.



HTML SYNTAX EDITOR TAGS MENU

This menu has three options :

Add Tag 

Delete Tag 

Edit Tag



ADD TAG

This command allows you to add a tag in the HTML reference file.

To add a tag :

· In the Syntax menu, select the Edit Tag option;

· Click on the Add tag icon

Or

In the HTML Syntax Editor's Tags menu, select the Add tag option …;

· In the Tag name text box, enter the name of the new tag;

· In the End tag menu, determine if one is required, optional or forbidden;

· Check the corresponding box(es).    Tags opened within the tag must be closed within the tag, Do not interpret text 
within the tag, Optional start tag if you want the tag to have these properties;

· Press the OK button.



DELETE TAG

This command allows you to delete an existing tag in the HTML reference file.

To delete a tag :

· In the Syntax menu, select the Edit tag option;

· Select the tag that you want to delete;

· Click on the Delete tag icon

Or

In the HTML Syntax Editor's Tags menu, select the Delete tag option.



EDIT TAG

This command allows you to edit the properties of an existing tag in the HTML reference file.

To edit a tag :

· In the Syntax menu, select the Edit tag option;

· Select the tag that you want to edit;

· Click on the Edit tag icon

Or

In the HTML Syntax editor's Tags menu, select the Edit tag option …

The different properties of the selected tag will be displayed in the dialog window.



ADD TAG icon 



DELETE TAG icon 



EDIT TAG icon 



HTML SYNTAX EDITOR RULES MENU

This menu has 3 options : 

Add rule 

Delete rule 

Edit rule



ADD RULE

This command allows you to add a tag's rules and attributes to the HTML reference file.

To add a rule to a tag:

· In the Syntax menu, select the Edit tag option;

· Click on the Add rule  icon

Or

In the HTML Syntax Editor's Rules menu, select the Add rule option...;

· In the List of tags option box, select the tag to which you want to add the rule;;

· Select the Tag allowed within selected tag or Tag can include the tags which are allowed within selected tag;

· Click on the Attributes rule tab;

· In the Attribute name text box, enter a name;

· Select one of the following options: Attribute is mandatory, URL attribute, URL base attribute, Anchor attribute; , 

· Click on the OK button.



DELETE RULE

This command allows you to delete rules and attributes of an existing tag in the HTML reference file.

To delete a rule :

· In the Syntax  menu, select the Edit tag option;

· Select the rule of the tag that you want to delete;

· Click on the Delete rule icon

Or

In the HTML Syntax Editor's Rules menu, select the Delete rule option...



EDIT RULE

This command allows you to edit the rules and attributes of an existing tag in the HTML reference file.

To edit a tag rule :

· In the Syntax menu, select the Edit tag option;

· Select the tag rule that you want to edit;

· Click on the Edit rule icon

Or

In the HTML Syntax Editor's Rules menu, select the Edit rule option.

The rule and the attribute of the selected tag will be displayed in the Edit HTML rule dialog window.



ADD RULE icon 



DELETE RULE icon 



EDIT RULE icon 



SAVE SELECTED FILES ON FTP

With this command you can save all the selected documents on your FTP site.    This command is useful when you are working on 
several documents and you only want to save a few of them.

To save selected documents on your FTP site:

1. From the File menu, select Save selected files.

2. Select the file you want to save.
 

3. Click on the Add button to add the file in the list of files to be saved.

4. Repeat steps 2 and 3 until you have added all the files you want to save.

5. Press the OK button.

If you want to remove a file from the list of selected files to be saved, select it and then press the Erase button.

The Erase All button erases all the filenames entered in the list of files to be saved.



FTP MANAGER

This menu contains different options for managing FTP sites:

Open a file from an FTP site 

Save a file directly on your site 

Save a file on your FTP site under a different name 

Save all open files on your FTP site 

Save selected files 

Start AceFTP 



NEW AN EASIER INTERFACE 

AceExpert has a very user-friendly interface.    With the many graphic tools bars the user can create his Web pages in no time.    
The many different tags that organize the toolbars makes it easy to find different tools quickly and efficiently.



CUSTOM APPLETS

Custom applets are applets inserted by the user.

To add a custom applet:

· On the Java tab, click on the Insert Java Applet icon;

· Fill out the property fields and the parameters related to the applet.

· Click on the Add button;

· The dialog screen Applet Creation Wizard will ask you to enter the name of the custom applet that will be added to the 
Custom Applets window.

· Press on the Next button;

· Press on the Add files button to select the files associated with the applet.    These files can be .class, HTML or other, 
depending on the type of applet.

· Press the Finish button.

Once the procedure is completed, the files will be copied to    AceExpert’s custom files directory and the applet will be displayed 
in the Custom Applets window that displays a list of all available custom applets.

To remove an existing custom applet:

· On the Java tab, click on the Insert Java Applet icon;

· Select the custom applet that you want to remove;

· Press the Delete button.

To insert a custom applet in a document:

· Select the desired applet from the Custom Applets window;

· Press the Insert button.

The .class files and other related files will be copied to the document’s directory.



INSERT A JAVA APPLET icon 



CODE EXPLORER

This window opens to the left of the edit window.    It displays as a tree, the links, source of image files and other files, the Java 
code and other Javascript and VBScript functions contained in the current HTML document as nodes.

If you double click on a node, you will go directly at the position of    the reference in the document. When there are more than 1 
reference with the same name, the number of repetitive references will appear between brackets after the node.

e.g.
 + Links
 - Sources
     flower.jpg
     new.jpg (3)

flower.jpg has only 1 reference in the document but New.jpg has 3 references. To access to the second and third reference of 
this last graphic in your document, double click a second and third time on the node.

It's possible to rename the nodes in this window by right clicking on the mouse button and selecting the rename item in the 
menu. Renaming the node will automatically rename the corresponding reference(s) in the document.



EDIT HTML TAG PROPERTIES

With the HTML Syntax Editor, not only can you edit the HTML tag properties, you can also add and delete tags as well as the 
rules that govern them..

To add a tab in the HTML reference file:

· In the Syntax menu, select the Edit tags  option;

· Click on the Add tag icon

Or

In the Tag menu of the HTML Syntax Editor, select the Add tag option...

· In the Tag name text box, enter the name of the new tag;

· In the End tag menu, determine whether it is required, optional, or forbidden;

· Check the respective box(es) : Tags opened within the tag must be closed within the tag, Don't interpret text 
within the tag, Optional start tag if you want the tag that you are adding to have these properties;

· Press the OK button.

To delete a tag from the HTML reference file:

· In the Syntax menu, select the Edit tags option;

· Select the tag that you wish to delete;

· Click on the Delete tag icon

Or 

In the Tags menu of the HTML Syntax Editor, select the Delete tag option.

To edit a tag :

· In the Syntax menu, select the Edit tags option;

· Select the tag that you want to edit;

· Click on the Edit tag button

Or

In the Tags menu of the HTML Syntax Editor select the Edit tag option ...

The different properties of the selected tag will be displayed in the Edit tag properties dialog box.



EDIT HTML RULE

The HTML Syntax Editor allows you to add, delete, and edit tag rules and attributes.

To add a rule to a tag :

· In the Syntax menu, select the option Edit tags;

· Click on the Add rules button

Or

In the Rules menu of the HTML Syntax Editor select the Add rule option ...;

· In the Tag list option box, select the tag to which you want to add the rule;

· Select the option : Tag allowed within selected tag or Tag can include the tags which are allowed within selected 
tag;

· Click on the Attribute rules tab;

· In the Attribute name text box, enter a name;

· Select one of the options : Attribute is mandatory, URL attribute, URL base attribute, Anchor attribute; 

· Press the OK button.

To delete a rule :

· In the Syntax menu, select the Edit tags option;

· Select the tag rule that you want to delete;

· Click on the Delete rule button

Or

In the Rules menu of the HTML Syntax Editor select the Delete rule option …

To edit a tag rule :

· In the Syntax menu, select the Edit tags option;

· Select the tag rule that you want to edit;

· Click on the Edit rule button

Or

In the Rules menu of the HTML Syntax Editor select the Edit rule option.

The rule and the attribute of the selected tag will be displayed in the Edit HTML rule dialog box..



CONFIGURE STANDARD TOOLBAR
The menus

This command allows you to configure the AceExpert toolbar.

To configure the toolbar : 

1. In the Options menu, click on the Configure Standard Toolbar option or select any tab and press on the right 
mouse button and click on the Configure Standard Toolbar option of the contextual menu.

2. The Standard Toolbar Configuration dialog window will appear.

3. The command buttons found on the toolbar are displayed in the Buttons on the Toolbar box,.

4. In the Buttons on the Toolbar  box, select a command button (if you wish to remove one of the predefined 
command buttons in AceExpert).

5. Press the    left arrow.

6. The selected command button will be transferred to the Available Buttons box.

7. In the Available Buttons box, select the command button that you want to place on the toolbar..

8. Press the right arrow.

9. The selected command button will be transferred to the toolbar.

10. Press the Close button.

If for any reason you are not satisfied with the command button configuration that you just made, or if you simply want to return 
to the predefined configuration in AceExpert, press the Restore button in the Standard Toolbar Configuration dialog box..

You can also change the order of the command buttons on the toolbar by using arrow up or arrow down. 

To change the order of the command buttons on the toolbar :

1. In the Buttons on the Toolbar box, select the command button that you want to move.

2. Press the left mouse button and drag it to the desired position 

or

Press arrow up or arrow down.



DEFINING INLINE STYLES
List of style sheet properties

To define an inline style:

1. Select the desired text.

2. Select the Specialized toolbar.

3. Click on the Style Sheet icon.

4. Checkmark the Inline Style Sheet box.

5. Define the desired styles.



IMPORTING A STYLE SHEET
List of style sheet properties

To use an external style sheet:

1. Select the Specialized toolbar.

2. Click on the Style Sheet icon.

3. Click on the External style sheet tab.

4. Import the external style sheet by clicking on the file or indicating the name of the file in the File source text box.

5. Click on the OK button.

Note : You can define styles (internal style sheets) and also import external style sheets.    However, the styles 
defined in the internal style sheet have precedence over those in the external style sheet.



SAVING A STYLE SHEET
List of style sheet properties

To save a style sheet:

1. Select the Specialized toolbar.

2. Click on the Style Sheet icon.

3. Create the desired styles.

4. Click on the Save button.

5. Save your file.

Note : A style sheet saved this way is subsequently considered an external style sheet.



INSERT A SINGLE FRAME <IFRAME>

Single frames can only be used with Microsoft Internet Explorer.    Follow the steps below to create a single frame:

1. Click on the Tables, frames, and lists tab and then on the Insert frames button;

2. Indicate the properties and source file for the frame by clicking on the Frame properties button (you can also use the 

context menu by clicking on the mouse's right button); 

3. Indicate the source HTML file in the box called Source file, select the source file with the help of the File icon to the right;

4. Enter the identifier name for the frame;

5. Specify scrolling : automatic, yes or no;

6. Indicate the top and left margins inside the frame.

You can indicate additional frame properties by doing the following:

1. Click on the Other properties tab.

2. Specify the frame alignment.

3. Indicate a fixed size for the frame by entering the height and width in pixels or entering the size as a percentage.

4.      Check the Frame border box to specify if the frame has a border or not.



MAKING THE CONTENTS OF A TARGET LINK APPEAR IN A SPECIFIC FRAME

When you create an external link, you can specify the specific frame where the destination HTML document must appear.    
When you create the link (refer to the External link section if necessary) you can specify a target in the External Link dialog box 
in the following manner:

4. Click on the Target frame tab on the External link window;

5. In the Target or frame name text box, insert the name that identifies the target frame.    If necessary check the frame 

names – with the help of the NAME attribute – in the HTML document containing the frame code;

If you wish, you can specify a predefined target instead of a frame name.    In order for a linked HTML document to appear in a 
window without frames, choose the    _top target.



DESCRIPTION OF FIELDS OF THE ACTIVE X COMMAND

FIELD DESCRIPTION

CodeBase (URL) Access path to the object, if not located in the same directory as the HTML document.

Code type Media type for code

Media type MIME type for the corresponding script programs

Class ID Identification of the object class

Standby Standby message while the object is loaded

Alignment Sets alignment for text surrounding the object

Name Sets a name for the object to be able to reference it from JavaScript or VBScript code.

Data Access path to object's data

Width Width of space occupied by the ActiveX object

Height Height of space occupied by the ActiveX object

Horizontal space Distance in pixels of the horizontal spacing (right and left) between the object and the 

surrounding text

Vertical space Distance in pixels of the vertical spacing (top and bottom) between the object and the 

surrounding text 

Border Width of the object border

Tab index Sets the position of the object in the tabbing order.

No tab Excludes the object from the tabbing order.

Declare object Indicates if the object is used as a parameter in another control.



LIST OF STYLE SHEET PROPERTIES

Properties Attributes Possible 
Values

Example Applicable 
Elements

Inherite
d

Browsers

Block-level

Top Margin margin-top length | 
percentage | 
auto

{margin-top:5px;} Block-level 
elements

no E,N

Bottom Margin margin-bottom length | 
percentage | 
auto

{margin-bottom:5px;} Block-level 
elements

no E,N

Left Margin margin-left length | 
percentage | 
auto

{margin-left:1em;} Block-level 
elements

no E,N

Right Margin margin-right length | 
percentage | 
auto

{margin-right:5pt;} Block-level 
elements

no E,N

Top Padding padding-top length | 
percentage

{padding-top:10%;} Block-level 
elements

no E,N

Bottom Padding padding-bottom length | 
percentage

{padding-
bottom:padding-
bottom:1.2em;}

Block-level 
elements

no E,N

Left Padding padding-left length | 
percentage

{padding-left:10pt;} Block-level 
elements

no E,N

Right Padding padding-right length | 
percentage

{padding-right:15px;} Block-level 
elements

no E,N

Height Height length | 
percentage

{height:10pc;} Block-level 
elements

no E,N

Width Width length | 
percentage

{width:20in;} Block-level 
elements

no E,N

Float Float none | left | 
right | both

{float:both;} Block-level 
elements

no E,N

Clear Clear none | left | 
right | both

{clear:left;} Block-level 
elements

no E,N

Borders

Top Border border-top border-width | 
border-style | 
border-color

{border-top:medium 
outset red;}

Block-level 
elements

no E,N

Bottom Border border-bottom border-width | 
border-style | 
border-color

{border-bottom:10 ridge 
gray;}

Block-level 
elements

no E,N

Left Border border-left border-width | 
border-style | 
border-color

{border-left:1 dotted red;} Block-level 
elements

no E,N

Right Border border-right border-width | 
border-style | 
border-color

{border-right:thick inset 
maroon;}

Block-level 
elements

no E,N

Top Border Width border-top-width thin | medium 
| thick | length

{border-top-width:thin;} Block-level 
elements

no E,N

Bottom Border Width border-bottom-
width

thin | medium 
| thick | length

{border-bottom-
width:thick;}

Block-level 
elements

no E,N

Left Border Width border-left-width thin | medium 
| thick | length

{border-left-width:15;} Block-level 
elements

no E,N

Right Border Width border-right-width thin | medium 
| thick | length

{border-right-
width:medium;}

Block-level 
elements

no E,N

Border Style border-style none | dotted 
| dashed | 
solid | double 

{border-style:ridge;} Block-level 
elements

no E,N



| groove | 
ridge | inset | 
outset

Border Color border-color color{1.4} {border-color:black;} Block-level 
elements

no E,N

Color & Background

Background Image Background-image url | none {background-
image:url(image.jpg);}

all no E,N

Background Repeat Background-repeat repeat | 
repeat-x | 
repeat-y | no-
repeat

{background-repeat:no-
repeat;}

all no E

Background Attachment Background-
attachment

scroll | fixed {background-
attachment:fixed;}

all no E

Background Position Background-
position

[position | 
length] | {1,2} 
| [top | center 
| bottom] || 
[left | center | 
right]

{background-position: 
top center;}

Block-level 
element

no E

Color Color color {color:salmon;} all yes E,N

Background Color Background-color color| 
transparent

{background-
color:crimson;}

all yes E,N

Font

Font Family font-family [[family-name 
| generic-
family ],]* 
[family-name| 
generic-
family]

{font-family :verdana, "m
s sans serif";}

all yes E,N

Font Style font-style normal | italic {font-style:italic;} all yes E,N

Font Variant font-variant normal | 
small-caps

{font-variant:small-caps;} all yes E

Font Weight font-weight normal | bold 
| bolder | 
lighter | 
weights

{font-weight:bold;} all yes E,N

Font Size font-size [xx-large | x-
large | large | 
small | x-
small | xx-
small] | 
[larger | 
smaller] | 
percentage | 
length

{font-size:12 pt;} all yes E,N

Text

Text Decoration text-decoration none | 
underline | 
overline | 
line-through

{text-decoration :underlin
e;}

all no E,N

Text Transformation text-transform capitalize | 
uppercase | 
lowercase | 
none

{text-
transform:lowercase;}

all yes E,N

Vertical Alignment vertical-align sub | super | 
top | middle | 
bottom | text-

{vertical-align :sub;} inline no E



top | text-
bottom | 
baseline

Text Alignment text-align left | right | 
center | 
justify

{text-align :center;} block-level 
elements

yes E,N

Text Indentation text-indent length | 
percentage

{text-indent :20px;} all yes E,N

Letter Spacing letter-spacing normal | 
length

{letter-spacing :2pt;} all yes E

Line Height line-height normal | 
nombre | 
length | 
percentage

{line-height :5pt;} all yes E,N

Classification

Display Display none | block | 
inline | list-
item

{display:none;} list of elements no E,N

White space white-space normal | pre {white-space:pre;} list of elements yes N

List style type list-style-type disc | circle | 
square | 
decimal | 
lower-roman | 
upper-roman 
| lower alpha 
| none

{list-style-
type:upperalpha;}

list of elements yes E

List style image list-style-image url | none {list-style-
image:url(image.gif);}

list of elements yes E

List Style Position list-style-position inside | 
outside

{list-style-
position:inside;}

list of elements yes E

Positioning

Clip Clip figure | auto {clip:rect(0 200 200 0);} all no E

Position Position absolute | 
relative | 
static

{position:absolute;} all no E

Visibility Visibility visible | 
hidden | 
inherit

{visibility:visible;} all no E

Overflow Overflow none | clip | 
scroll

{overflow:scroll;} all no E

Top Top length | 
percentage | 
auto

{top:0;} absolute or 
relative 
positioning of 
elements

no E

Left Left length | 
percentage | 
auto

{left:0} absolute or 
relative 
positioning of 
elements

no E

Z-Index z-index Auto | entier {z-index:-1;} absolute or 
relative 
positioning of 
elements

no E

Other

Cursor type Cursor auto | 
crosshair | 
default | hand 

{cursor:hand;} All yes E



| move | e-
relength | n-
relength | se-
relength | sw-
relength | s-
relength | w-
relength | text 
| wait | help 




